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Welcome to PlanetPress Connect 1.8

Note

Since we are always looking for new ways to make your life easier, we welcome your
questions and comments about our products and documentation. Use the feedback tool
at the bottom of the page or shoot us an email at doc@ca.objectiflune.com.

PlanetPress Connect is a series of tools designed to optimize and automate customer
communications management. They work together to improve the creation, distribution,
interaction and maintenance of your communications.

The PlanetPress Connect Datamapper and Designer are designed to create output for print,
email and the web within a single template and from any data type, including formatted print
streams. Output presets applied outside the design phase make templates printing device
independent.

The Designer has an easy-to-use interface that makes it possible for almost anyone to create
multi-channel output. More advanced users may use native HTML, CSS and JavaScript.

PlanetPress Connect also includes a process automation server, called Workflow. It is capable
of servicing response form web pages and email to provide interactive business
communications.

PlanetPress Connect can create documents for tablets and mobile devices that run a free
CaptureOnTheGo App. Users with a CaptureOnTheGo subscription can then download
documents to their own devices, interact with them and send the captured data back to

PlanetPress for conversion into additional documents or workflows.

This online documentation covers PlanetPress Connect version 1.8.
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Setup And Configuration

This chapter describes the PlanetPress Connect installation and the different considerations
that are important in regards to the installation and use of PlanetPress Connect.

» "System and Hardware Considerations" below
« "Installation and Activation" on page 28
« "Known Issues" on page 79

« "Server Configuration Settings" on page 84

« Uninstalling

System and Hardware Considerations

There are a variety of considerations to be aware of. These are documented in the following
pages:

« "Antivirus Exclusions" below

« "Database Considerations" on page 17

« "Environment Considerations" on page 22

« "Language and Encoding Considerations" on page 24
« "Network Considerations" on page 24

« "Performance Considerations" on page 25

» "System Requirements" on page 27

Antivirus Exclusions

The information on this page is designed to assist IT managers and IT professionals decide
what anti-virus strategy to follow with consideration to PlanetPress Connect and their internal
requirements and needs. This page describes the mode of operation and the files and folders
used by PlanetPress Connect as well as the files, folders and executables that are
recommended to be ignored for best possible performance and to avoid issues caused by
antivirus file locks.
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IT managers and IT professionals then may decide the anti-virus strategy to follow for their
internal requirements and needs depending on the statements outlined herein.

Directories and folders

Main installation folder

All Connect applications are installed under an arbitrarily selectable main folder. We will speak
of the "Installation Target" in the following. This installation target will hold the executables and
required files and folders for the operation of the whole product suite. All these files and folders
are static after their installation. It depends on the company virus protection strategy, if such
files and folders will be monitored or not. A virus protection on these files and folders should,
however, not have a big — if even any — impact on the performance of the Connect suite.

Working folders

Working folders for Connect are created and used on a per-user-basis under the respective
user's profile folder, accessible on Windows with the standardized system variable
%USERPROFILE% in the subfolder "Connect". Working folders are:

« %USERPROFILE%\Connectifilestore: This folder will hold non-intermediate files for the
operation of Connect. Files in this folder will be used frequently, but not with a high
frequency. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.

« %USERPROFILE%\Connect\logs: As the name implies, log files are created and
updated here. These log files are plain text files. Virus protection may have an impact on
the speed of the whole Connect suite.

» %USERPROFILE%\Connect\temp: Storage folder for temporary data, usually
intermittent files in multiple folders. Virus protection on this folder and its subfolders may
have a serious impact on the performance of Connect.

« %USERPROFILE%\Connect\workspace: Usually containing settings and helper files
and folders. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.

Database 1

Depending on the components installed, a database instance is created in the system temp
folder of Windows. This folder is accessible via the standardized system variable %TMP%.
Usually, folders holding such temporary files and folders should be excluded from a virus
protection, because this influences the overall performance of the whole system at all. However
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the responsible person for the computer protection has to decide about the monitoring of such
temporary folders following the company guidelines.

Database 2

Another database instance for Connect will be hold and used under the folder, which is
intended to hold data, accessible by and for all users. The path to this folder is stored in the
standardized system variable %PROGRAMDATA%. The Connect database instance is located
in the subfolder "Connect\MySQL".

As this database will be in extremely strong usage, virus protection on this folder and its
subfolders may have a serious impact on the performance of Connect.

Database Considerations

This page describes the different considerations and pre-requisites for the database back-end
used by PlanetPress Connect, whether using the MySQL instance provided by the installer, or
pre-existing (external) instance.

Using the MySQL Instance from the Installer

The MySQL Instance provided in the Installation Wizard is already pre-configured with options
to provide the most stable back-end setup.

These are the specific options that have been changed in our version of "my.ini":

« max_connections =200 : PlanetPress Connect uses a /ot of database connections. This
number ensures that even in high volume environments, enough connections will be
available.

« max_allowed_packet = 500M : In some implementations, especially when using Capture
OnTheGo, large packet sizes are required to allow transferring binary files. This
substantial packet size maximum setting ensures that the data received by PlanetPress
Connect will be able to be stored within the database.

« character-set-server = utf8 , collation-server = utf8_unicode_ci, default-character-
set=utf8 : These indicate database support for UTF-8/Unicode.

Installing / Updating Connect Using an existing local MySQL instance

If MySQL Server is already present and you wish to use it, the following should be taken into
consideration:
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« The MySQL account must have access to all permissions using the GRANT Command,
including creating databases.

« The database configuration must include the options detailed in the "Using the MySQL
Instance from the Installer" on the previous page topic above.

« The SQL instance must be open to access from other computers. This means the bind-
address option should not be setto 127.0.0.1 or localhost.

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a pre-
existing (External) database then you yourself must ensure that the External database is
accessible to Connect.

Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.

Options available within the installer:

« The Configuration page for the local MySQL is displayed.

o MySQL settings are pre-filled with default values if no existing MySQL db configuration is
found.

« MySQL settings are pre-filled with existing db configuration settings, if they pointto a
MySQL db type.

Installing Connect using an existing Microsoft SQL Server instance

If Microsoft SQL Server is already present and you wish to use it, the following should be taken
into consideration:

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a pre-
existing (External) database then you yourself must ensure that the External database is
accessible to Connect.
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Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.

Note

Since PlanetPress Connect version 1.6 the minimum required version of the MS SQL
Serveris SQL Server 2012.

« When MS SQL is selected, the default values for root user are sa and 1433 for the port.

« If db settings from a previous installation are found, the pre-exising settings will be
displayed for the matching db type (for MS SQL settings, this will only work if they were
created with Server Config Tool 1.5.0 or later, or the Connectinstaller 1.6.0 or later). If the
db type is changed in the configuration page, the default values for this db type will be
displayed. If the pre-existing db settings are set to Hsqldb, the default db type selection
will be MySQL.

« Selected db settings are stored in the preferences as usual (C:\ProgramData\Objectif
Lune\Ol

Connect\.settings\ConnectHostScope\com.objectiflune.repository.eclipselink.generic.pref

s)
Updating With No Local MySQL Product

o When updating a Connect installation from 1.5.0 which contains a Server Product but no
local MySQL Product, the DB Configuration Page will detect which db type was set
before (especially if the db configuration was switched from MySQL to MS SQL using the
Server Configuration Tool), and default to those settings.

« On Update from 1.4.2 or earlier, the DB Configuration Page will always default to MySQL
connection settings, and if the installation was manually tweaked to connect to MS SQL
Server, the user has to switch to "Microsoft SQL Server" type and enter connection details
again.

When modifying Connect

« Iflocal MySQL is removed from an installation, the DB Configuration page will offer
additionally the Microsoft SQL Server db type with respective default values.
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« Iflocal MySQL is added to an installation, the usual MySQL Configuration page with
default values will be displayed.

If the user has installed the Installer Supplied MySQL and then switches to an external
Microsoft SQL by using the Server Configuration Tool, the supplied MySQL cannot be switched
off. By design the installer adds a service dependency between Connect Server and the
supplied MySQL service.

Note

The Microsoft SQL selection capability will be available only with 1.6 version and upwards.

To remove this dependency the user needs to do the following

1. Have a foreign Microsoft SQL running, ready for use with Connect Server.

2. Use the Server Configuration Tool "Database Connection preferences" on page 700 to
switch the database to Microsoft SQL.

3. Re-start the Connect Server Service, so that the modifications become active.

4. Counter check that everything is working properly with Microsoft SQL.

5. Open a command-line prompt with full administration rights.

6. Enterthe command sc config OLConnect Server depend= /. This removes the

dependency.

Please be aware: The key word depend must be followed immediately by the equal sign,
but between the equal sign and the forward slash there must be a space.

Additional information can be found here: http://serverfault.com/questions/24821/how-
to-add-dependency-on-a-windows-service-after-the-service-is-installed#228326.

7. After the dependency has been removed, it is possible to stop the supplied MySQL
service (OLConnect_MySQL).

Warning

If a Connect 1.5 user wants to use Microsoft SQL instead of MySQL for the Connect Server, there
are several points to be taken care of:
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« IF there should possibly be available some foreign MySQL instance, which could
be used intermediately, then this should be selected during the setup. This ensures,
that no stuff gets installed. Otherwise the supplied MySQL needs to be installed and
the switch to Microsoft SQL needs to be done as outlined above.

« ltis not possible to uninstall the supplied MySQL in this case via a Connect 1.5
modify.

Important

If a Server Product and a MySQL Product were selected to be installed on Connect 1.5.0, and
then the Server Configuration Tool is used to switch the database used by the Server to an
external Microsoft SQL, then the Update to 1.6 requires an extra step. The procedure is as
follows:

1. Run the Update to Connect 1.6. This will assume the local MySQL database needs to
be updated and configured, so the user has to enter a root password on the MySQL
Configuration Page (can be any password matching Connect security rules).

2. After the update, the Connect 1.6 Setup needs to be run once more to modify Connect.
3. On the Product Selection page, now the MySQL product can be unselected.

4. When stepping forward in the Wizard, the DB Configuration page will be displayed which
allows to configure the Microsoft SQL Server with appropriate settings.

After this modification, the local MySQL is removed, and also the service dependency from
Server to MySQL is removed.

Note

If Connect was initially installed not containing the local MySQL product (i.e. on 1.5 installation an
external MySQL was configured as database), then the Update to 1.6 will allow to select either
external MySQL or external Microsoft SQL on the DB Configuration Page.
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Environment Considerations

Virtual Machine Support

PlanetPress Connect supports VMWare Workstation, VMWare Server, VMWare Player,
VMWare ESX (including VMotion), Microsoft Hyper-V and Microsoft Hyper-V/Azure
infrastructure environments as software installed on the Guest operating system.

Warning

Copying (duplicating) a Virtual Machine with Connect installed and using both images
simultaneously constitutes an infringement of our End-User License Agreement.

Note

While some virtual machine environments (from VMWare and Microsoft) are supported,
other virtual environments (such as Parallels, Xen and others) are not supported at this
time.

Terminal Server/Service

PlanetPress Connect does not support Terminal Server (or Terminal Service) environment as
possible under Windows 2000, 2003 and 2008. This is to say, if Terminal Service is installed
on the server where PlanetPress Connect is located, unexpected behaviours may occur and
will not be supported by Objectif Lune Inc.. Furthermore, using PlanetPress Connectin a
Terminal Service environment is an infringement of our End-User License Agreement.

Remote Desktop

Tests have demonstrated that PlanetPress Connect can be used through Remote Desktop. Itis
however possible that certain combination of OS could cause issues. If problems are
encountered, please contact OL Support and we will investigate.

PlanetPress Connect 1.3 and later have been certified under Remote Desktop.

64-bit Operating Systems

PlanetPress Connect is a 64-bit software and can only be installed on 64-bit operating systems.
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Antivirus Considerations

« Antivirus software may slow down processing or cause issues if they are scanning in
temporary folders or those used by PlanetPress Connect. Please see KB-002: Antivirus
Exclusions for more information.

« Antivirus software might interfere with installation scripts, notably a vbs script to install
fonts. McAfee, in particular, should be disabled temporarily during installation in order for
MICR fonts to install and the installation to complete successfully.

Windows Search Indexing Service

Tests have concluded that the Windows Search service, used to provide indexing for Windows
Search, can interfere with Connect when installing on a virtual machine. If the installation
hangs during the last steps, it is necessary to completely disable this service during installation.

o Click on Start, Run.

Type in services.msc and click OK.

Locate the Windows Search service and double-click onit.

Change the Startup Type to Disable, and click Stop to stop the service.

Try the installation again.

Once completely, you may re-enable the service and start it.

Commandline switches and .ini entries

PlanetPress Connect is intended to work stably and reliably, based on Java and the Eclipse
framework. To ensure this reliability and robustness, many Java and Eclipse parameters have
been tested and tuned, which is reflected in the respective .ini entries and the used command
line switches. A collection of valuable settings has been elaborated and found its entry in
PlanetPress Connect “good switches list’ (called the “whitelist”).

The protection of the end user’s system is one of our main goals and therefore we have
implemented a very strict verification mechanism, which ensures, that only these whitelisted ini
entries and command-line switches are accepted, when one of Connect components is started
and run. Please be therefore advised, that any non-whitelisted ini entry or command-line switch
will be accepted and will - if tried to be used - lead to the respective application’s “sudden
death”. If you should encounter such a behaviour then please double-check your Connect log

file/s for respective entries.
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Language and Encoding Considerations

Please note the following considerations:

» Language:

« PlanetPress Connectis currently offered in several languages. These languages
can be switch between via the Preferences dialog. The current languages include:

« English

« French

« German

e Spanish

« ltalian

« Korean

« Portuguese

o Chinese (Simplified)
« Chinese (Traditional)
« Japanese.

The defaultlanguage is English.
The PlanetPress Connect help system (this document) is currently only available in
English.

« Encoding:

« Issues can sometimes be encountered in menus and templates when running
PlanetPress Connect on a non-English operating system. These are due to
encoding issues and will be addressed in a later release.

Network Considerations

The following should be taken into consideration in regards to network settings and
communications

« Ifalocal proxy is configured (in the Internet Explorer Optionsdialog, the option Bypass

proxy server for local addresses must be checked, or some features depending on
local communication will not work.
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Firewall/Port considerations

For Firewall/Port considerations, please see this article in the Knowledge Base: Connect
Firewall/Port Configuration

Performance Considerations

This page is a comprehensive guide to getting the most performance out of PlanetPress
Connect as well as a rough guideline to indicate when it's best to upgrade.

Performance Analysis Details

In order to get the most out of PlanetPress Connect, it is important to determine how best to
maximize performance. The following guidelines will be helpful in extracting the best
performance from PlanetPress Connect before looking into hardware upgrades or extra
PlanetPress Connect performance packs.

« Job Sizes and Speed: In terms of pure output speed, it's important to first determine what
job size is expected, and adjust "Scheduling Preferences" on page 85 accordingly. The
basic rules are:

« If processing a small number of very large records (when each individual record is
composed of a large number of pages), more instances with an equal amount of
speed units is better. For hardware, RAM and Hard Drive speeds are most
important, since the smallest divisible part (the record) cannot be split on multiple
machines or even cores.

« If creating a very large number of small records (hundreds of thousands of 2-3 page
individual records, for instance), a smaller number of instances with a large number
of speed units would be better. As for hardware, then the number of cores becomes
critical, whereas RAM and hard drive are secondary. Performance Packs, as well as
the MySQL instance being separate, would be helpful if your most powerful
machine starts struggling.

« Mix and match. For example, one instance prioritized for large jobs and the rest for
smaller, quicker jobs. Or the contrary. Or, whatever you want, really.

« RAM Configuration: By default, each instance of the Merge Engine and Weaver Engine
is set to use 640MB of RAM. This means that regardless of speed units, if not enough
memory is available, output speed might not be as expected. Assuming that the machine
itself is not running any other software, the rule of thumb is the following: The total number
of used memory in the machine should be pretty much the maximum available (around
95%).
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For each engine, it's necessary to modify the .ini file that controls its JAVA arguments.
Edit as follows:

« Forthe Merge Engine: see C:\Program Files\Objectif Lune\OL
Connect\MergeEngine\Mergeengine.ini

« Forthe Weaver Engine: see C:\Program Files\Objectif Lune\OL
Connect\weaverengine\Weaverengine.ini

« The parameters are -Xms640m for the minimum RAM size, -Xmx640m for the
maximum RAM size. Explaining Java arguments is beyond the scope of this
document. Please read references here, here and here for more details (fair
warning: these can get pretty technical!).

« Template and data mapping optimization: Some functionality offered by the
DataMapper and Designer modules is very useful, but can cause the generation of
records and of contents items to slow down due to their nature. Here are some of them:

» Preprocessor and Postprocessor scripts: Manipulating data using a script may
cause delays before and after the data mapping action has actually taken place,
especially file conversion and data enrichment from other sources.

« Loading external and network resources: In Designer, using images, javascript
or css resources located on a slow network or on a slow internet connection will
obviously lead to a loss of speed. While we do our best for caching, a document
with 100,000 records which queries a page that takes 1 second to return a different
image each time will, naturally, slow output generation down by up to 27 hours.

« External JavaScript libraries: While loading a single JavaScript library from the
web is generally very fast (and only done once for the record set), actually running a
script on each generated page can take some time. Because yes, JavaScript will
run for each record, and often take the same time for each record.

« Inefficient selectors: Using very precise ID selectors in script wizards can be much
faster than using a text selector, especially on very large documents. See also: "Use
an ID as selector" on page 636.

« Complex scripts: Custom scripts with large, complex or non-optimized loops can
lead to slowing down content creation. While it is sometimes difficult to troubleshoot,
there are many resources online to help learn about JavaScript performance and
coding mistakes. Here, here, and here are a few. Note that most resources on the
web are about JavaScript in the browser, but the greatest majority of the tips do,
indeed, apply to scripts in general, wherever they are used.
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High-performance hardware

The following is suggested when processing speed is important. Before looking into
Performance Packs to enhance performance, ensure that the below requirements are met.

« MySQL Database on a separate machine. MySQL's main possible bottleneck is file 1/O,
and as such a high-performance setup will require this server to be on a separate
machine, ideally with a high-performance, low-latency hard drive. A Solid State Drive
(SSD) would be recommended.

« High-Quality 16+ GB Ram. This is especially true when working with many server
instances ("speed units") running in parallel. The more parallel processing, the more
RAM is recommended.

« 4 or 8 physical cores. We're not talking Hyper-Threading here, but physical cores.
Hyper-Threading is great with small applications, but the overhead of "switching"
between the virtual cores, and the fact that, well, they're virtual, means the performance is
much lesser on high-power applications such as OL Connect. In short, a dual-core
processor with Hyper-Threading enabled is not equivalent to a quad-core processor.

« Preferably use a physical, non-virtualized server. VMWare servers are great for
reducing the numbers of physical machines in your IT space, but they must share the
hardware between each other. While you can create a virtual machine that seems as
powerful as a physical, it will still be sharing hardware with any other virtual machines,
and this will adversely affect performance.

System Requirements

These are the system requirements for PlanetPress Connect 1.8
Operating System (64-bit only)

« Microsoft Windows 2008/2008 R2 Server
« Microsoft Windows 2012/2012 R2 Server
« Microsoft Windows Vista

« Microsoft Windows 7

« Microsoft Windows 8.1

o Microsoft Windows 10 (Pro and Enterprise versions only)
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Note

Windows 8.0, Windows XP, Windows 2003 and older versions of Windows are not
supported by PlanetPress Connect.

Minimum Hardware Requirements

NTFS Filesystem (FAT32 is not supported)

CPU Intel Core i7-4770 Haswell (4 Core)

8GB RAM (16GB Recommended)

Disk Space: At least 10GB (20GB recommended)

Note

For tips and tricks on performance, see "Performance Considerations" on page 25.

Installation and Activation

This topic provides detailed information about the installation and activation of PlanetPress
Connect 1.8.

Note

A PDF version of this guide is available for use in offline installations. Click here to
download it.

PlanetPress Connect 1.8 is comprised of 2 different installers: one for the PlanetPress Connect
software and one for PlanetPress Workflow 8.

Where to obtain the installers

The installers for PlanetPress Connect 1.8 and PlanetPress Workflow 8 can be obtained on
DVD or downloaded as follows:

Page 28

PlanetPress.
Connect



« If you are a Customer, the installers can be downloaded from the Objectif Lune Web
Activations page: http://www.objectiflune.com/activations

« Ifyou are a Reseller, the installers can be downloaded from the Objectif Lune Partner
Portal: http://extranet.objectiflune.com/

Installation - important information

For important information about the Installation, including requirements and best practices,
please see the following topics:

Installation Prerequisites

User accounts and security

The importance of User Credentials when installing and running Connect

Migrating to a new computer

Installation - "How to" guides

For information on how to conduct the installation itself, chose from the following topics:

o Installation

« Silent Installation

« Installation on machines without Internet access

Activation

For information on licensing, please see Activating your license.

Installation Prerequisites

« Make sure your system meets the System requirements.

o PlanetPress Version 1.8 can be installed under a regular user account with Administrator
privileges.
e PlanetPress must be installed on an NTFS file system.

« PlanetPress requires Microsoft .NET Framework 3.5 already be installed on the target
system.
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« In order to use the automation features in Version 1.8, PlanetPress Workflow 8 will
need to be installed.
This can be installed on the same machine as an existing PlanetPress® Suite 7.6
installation or on a new computer.
For more information, please see Information about PlanetPress Workflow 8.

« As with any JAVA application, the more RAM available, the faster PlanetPress will
execute!

Users of Connect 1.1

In order for users of PlanetPress Connect 1.1 to upgrade to any later version through the
Update Manager it is necessary to install a later version (1.1.8 or later) of the Objectif Lune
Update Client.

If you do not have such a version installed already, the next time you run your Update Client it
will show that there is an update available of itself to Version 1.1.8 (or later).

Simply click on the download button in the dialog to install the new version of the Update
Client. Note that it is no problem to run the update while the Clientis open. It will automatically
update itself.

Once you have done this, PlanetPress Connect 1.8 will become available for download.

Note

From PlanetPress Connect Version 1.2 onwards, the new version (1.1.8) of the Update
Clientis included by default with all setups.

Users of Connect 1.0

Users of this Connect version 1.0 cannot upgrade directly to Version 1.8. This is because
Connect Version 1.0 is a 32 bit version of Connect.
Users must first upgrade to Version 1.1 and from there upgrade to Version 1.8

If you are updating manually you must first upgrade to Version 1.1 before installing 1.8. If you
attempt go directly from Version 1.0 to Version 1.8 the installation will fail.

Also see "Users of Connect 1.1" above for extra information about updating from that version.
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User accounts and security

Permissions for PlanetPress Connect Designer

PlanetPress Connect Designer does not require any special permissions to run besides a
regular program. It does not require administrative rights and only needs permission to
read/write in any folder where Templates or Data Mapping Configurations are located.

If generating Print output, PlanetPress Connect Designer requires permission on the printer or
printer queue to send files.

Permissions for PlanetPress Connect Server

The PlanetPress Connect Server module, used by the Automation module, requires some
special permissions to run. These permissions are set during installation, in the Engine
Configuration portion of the Installation Wizard, but it can also be configured later by modifying
permissions for the service. To do this:

« In Windows, open the Control Panel, Administrative Tools, then Services (this may
depend on your operating system).

« Locate the service called Serverengine _UUID , where UUID is a series of characters that
depend on the machine where the software is installed.

» Right-click on the service and select Properties.

« In the Connection tab, define the account name and password that the service should
use. This can be a local account on the computer or an account on a Windows Domain.
The account must have administrative access on the machine. It should also correspond
to the user account set up in PlanetPress Worfklow.

The Importance of User Credentials on Installing and
Running PlanetPress Connect

OL Connect and required credentials depends heavily on the Connect component and
respective tasks and what sort of user credentials are needed.

First of all, it is important to distinguish between installation and run-time
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Installation

The Connectinstaller puts all required files, folders, registry entries and much more to their
correct places and locations. As many of these locations are protected against malicious
accesses, that very user under whose context the Connect installation is started and running,
needs very extensive rights on the respective computer. This user must belong to the Local
Administrators group on that machine. Here are some required capabilities, this user:

« Must be able to write into the "Programs" folder.

« Must be allowed to check for existing certificates and must also be allowed to install new
ones into the global certificate store on that machine.

« Must be able to write into HKLM and any subtree of it in the registry.

o Mustbe able to INSTALL, START and RUN services and also to MODIFY service
settings.

« Must be known in the network the machine belongs to and must also need to be able to
use shared network resources like shared drives and/or printers etc.

This list may not be complete, but it gives the extent of the requirements. Generally, the local
administrator of the machine will have all these credentials, but there may exist network
restrictions and policies, which will block one or more of these capabilities. In such cases, the
respective network administrator should provide a valid user account for the installation.

User Account

The user account shall be used to later RUN one of the Connect Server flavors (Server or
Server Extension). This dedicated user account has to be entered on the respective installer
dialog page and must be allowed to START, STOP and RUN services on this machine. This is
different from the credentials of the installation user account, which additionally requires the
rightto INSTALL services. Please be aware of this fact!

Additionally, the Server user must be able to access any network resources that are required for
OL Connect to function properly. This includes e.g. additional drives, printers, scanners, other
computers and, where appropriate, internet resources, URLs, mail servers, FTP servers,
database servers and everything else planned to be used for the intended operation of
Connect. The Server user is the run-time user.

Connect Components

Usually, a standard end user will only be facing Connect Designer and maybe the License
Activation Tool. Designer this does not require administrator rights. Either everything required
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to create documents or also to run some tasks will be already available (installed by the
installer) or be accessible in a way, where no specific credentials are required. However some
tasks like starting an email campaign will possibly require a respective account at a mail server.
But this has generally nothing to do with the credentials of the Designer user.

Activation Tool

To run the Software Activation Tool, administrator rights are required because this tool needs to
write the license file in one of the protected folders of Windows. The tool will however allow to
restart it with respective credentials if required.

MySQL

MySQL database service is installed by the install user (thus again the requirement of
installing, starting, running and modifying services). Once running it will just work.

Merge and Weaver Engines

These components do run under the Designer (if only Designer is installed) or the Server/
Extension service(s) and inherit the rights of their parent application.

Server (Extension) Configuration Tool

This component needs to access the settings of the Server. As these are stored and read by the
Server, it should be clear that the user used to run the Configuration tool should be the same as
the Server Service user as explained above.

Installing PlanetPress Connect on Machines without
Internet Access

Installing PlanetPress Connect1.8 in offline mode requires some exira steps. These are listed
below.

GoDaddy Root Certificate Authority needs to be installed.

In order to install PlanetPress Connectit is necessary for the GoDaddy Root Certificate
Authority to be installed (G2 Certificate) on the host machine and for this to be verified online.
When a machine hosting the installation does not have access to the Internet, the installation
will fail because the verification cannot be performed. To solve this problem one must first
ensure that all Windows updates have been installed on the host machine. Once the Windows
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updates are confirmed as being up to date, then complete the following steps:

1. Go to https://certs.godaddy.com/repository and download the following two certificates to
copy to the offline machine:

« GoDaddy Class 2 Certification Authority Root Certificate - G2 - the file is gdroot-
g2.crt

« GoDaddy Secure Server Certificate (Intermediate Certificate) - G2 - the file is
gdig2.crt

2. Install the certificates: Right mouse click -> Install Certificate, and follow the steps through
the subsequent wizard.

3. Now copy the PlanetPress Connect installer to the offline machine and start the
installation as normal

Windows certificate validation - Certificate Revocation List retrieval should be switched
off

For your security Objectif Lune digitally signs all relevant files with our own name and
certificate. The integrity of these files is checked at various times by different, context related,
methods. One of these checks, done during the installation process, uses the Windows
certificate validation check. .

The Windows certificate validation process not only checks the integrity of a file against its
signature, but also usually checks if the certificate itself is still valid. That check is done against
the current Certificate Revocation List (CRL), which needs to be retrieved from the internet.
However, if the machine in question does not have internet access, the retrieval of the CRL
must fail, which will lead to subsequent validation issues.

To circumvent such issues it is highly recommended to switch off the CRL retrieval prior to
installing Connect on machines without internet access. There is no security risk associated
with this, as the CRLs would never be retrievable without internet access, anyway. Advantage
of the switch will not only be found during the installation and operation of Connect, but also in
some speed improvements for any application which use signed binaries.

To switch off CRL retrieval on the computer, complete the following steps:

1. Open the “Internet Options” via the Control Panel
2. Select the “Advanced” tab and scroll down to “Security” node.

3. Uncheck the entry “Check for publisher’s certificate revocation” under that node.
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4. Click the OK button to close the dialog.

5. Re-startthe computer.

Installation Wizard
Starting the PlanetPress Connect installer
The PlanetPress Connect installer may be supplied as an ISO image or on a DVD.

« Ifan ISO image, either burn the ISO onto a DVD or unzip the contents to a folder (keeping
the folder structure)

« Ifona DVD, eitherinsertthe DVD and initiate the installation from there or copy the
contents to a folder (keeping the folder structure)

Navigate to the PlanetPress_Connect_Setup_x64.exe or and double-click on it. After a short
while the Setup Wizard will appear as a guide through the installation steps.

Note

PlanetPress Connect requires prior installation of Microsoft NET Framework 3.5.

Please refer to https://www.microsoft.com/en-us/download/details.aspx?id=21 for more
details on how to install Microsoft NET Framework 3.5, if this is not already done.

Note

If the same version of PlanetPress Connect is already installed on the target machine,
you will be presented with options to either Uninstall or Modify the existing instance.

If Modify is selected, the standard installation Wizard sequence will be followed, but with
all options from the existing installation selected.

Selecting the required components

After clicking the Next button, the component selection page appears, where the different
components of PlanetPress Connect can be selected for installation. Currently, the following
are available:
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« PlanetPress Connect Designer: The Designer module (see "The Designer" on
page 302). It may be used as a standalone with no other installed modules, but it will not
have certain capabilities such as automation and commingling.

« PlanetPress Connect Server: The Server back-end giving capabilities such as
automation, commingling, picking. It saves all entities generated from the Automation
module into a database for future use.

« MySQL Product: Install the supplied MySQL database used by PlanetPress Connect.
The database is used for referencing shared and temporary Connect files, as well as for
sorting temporarily extracted data, and the like.

A pre-existing MySQL or Microsoft SQL server (referred to as an external database, in
this documentation) could be used for the same purpose, however.

The external database could reside on either the same computer or on a separate server.
If you wish to make use of an external database, please make sure the MySQL Product
option is not selected.

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a
pre-existing external database then you must ensure that your external database is
accessible to Connect, yourself. Objectif Lune Inc. will take no responsibility for
database connections to any but the supplied MySQL database.

See "Database Considerations" on page 17 for more information about setting up
external databases.

« Installation Path: This is the location where modules are to be installed.

The installer can also calculate how much disk space is required for installing the selected
components as well as how much space is available:

« Disk space required: Displays the amount of space required on the disk by the selected
components.

« Disk space available on drive: Displays the amount of space available for installation on
the drive currently in the Installation Path.

« Recalculate disk space: Click to re-check available disk space. This is useful if space
has been made available for the installation while the installer was open.
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« Source repository location: Displays the path where the installation files are located.
This can be a local drive, installation media, or a network path.

Selection Confirmation

The next page confirms the installation selections made. Click Next to start the installation
itself.

End User License Agreement

The next page displays the End User License Agreement, which needs to be read and
accepted before clicking Next.

Configuring Supplied Database Connection

The Default Database Configuration page appears if the supplied MySQL Product module
was selected for installation in the Product Selection screen. It defines the administrative
password for the MySQL server as well as which port it uses for communication.

The installer will automatically configure the Connect Serverto use the supplied password and
port.

« MySQL user 'root' Password: Enter the password for the 'root', or administration
account, for the MySQL server. The password must be at least 8 characters long and
contain at least one of each of the following:

» alower case character(a, b, c...)

« an upper case character (A, B, C ...)

« anumericdigit(1,2,3 ...)

« apunctuation character (@, $, ~ ...)
For example: "This1s@K"

Note

When updating from an earlier Connect version, the appropriate MySQL password
must be entered or the update will fail.
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If the password is subsequently forgotten, then the MySQL product must be
uninstalled and its database deleted from disk before attempting to reinstall.

« Confirm 'root' Password: Re-enter to confirm the password. Both passwords must
match for installation to continue.

o TCP/IP Port Number: The port on which MySQL will expect, and respond to, requests. A
check is run to confirm whether the specified TCP\IP Port Number is available on the
local machine. Ifitis already being used by another service (generally, an existing
MySQL installation), the number is highlighted in red and a warning message is
displayed at the top of the dialog.

Note

The MySQL Product controlled by the OLConnect MySQL service communicates
through port 3306 by default.

o Allow MySQL Server to accept non-local TCP connections: Click to enable external
access to the MySQL server.

Note

This option is required if MySQL Server will need to be accessed from any other
machine.

Itis also required if the MySQL database is on a separate machine to PlanetPress
Connect.

Tip
This option may represent a security risk if the machine is open to the internet.

Itis heavily recommended that your firewall is set to block access to port 3306 from
external requests.
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Configuring External Database Connection

The Database Connection page appears if the supplied MySQL Product module was not
selected for installation. This page is for setting up the connection to the existing External
database.

- Database Configuration: Select the database type to use for the PlanetPress Connect
Engine. Currently only MySQL and Microsoft SQL Server are supported.

« Administrator Username: Enter the username for a user with administrative rights on the
database. Administrative rights are required since tables need to be created in the
database.

If accessing a database on a different machine, the server must also be able to accept
non-local TCP connections, and the username must also be configured to accept remote
connection. For example, the "root" MySQL user entered as root@localhost is not allowed
to connect from any other machine than the one where MySQL is installed.

« Administrator Password: Enter the password for the above user. The appropriate
MySQL password must be entered or the Connect installation will fail.

« TCP/IP Port Number: Enter the port on which the database server expects connections.
For MySQL, this is 3306 by default.
For MS SQL itis 1433 by default.

« Database Host Name: Enter the existing database server's IP or host name.

« Server SchemalTable: Enter the name of the MySQL database into which the tables will
be created. The Connect standard name is "objectiflune".

« Test Connection button: Click to verify that the information provide into previous fields is
valid by connecting to the database.

Note

This test does not check whether the remote user has READ and WRITE
permissions to the tables under the objectiflune schema. It is solely a test of
database connectivity.

PlanetPress Connect Server Configuration

The Server Configuration page is where the Connect Server component is configured.

The Connect Server (Master) settings are as follows:.
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e Run Server as: Defines the machine username and password that the PlanetPress
Connect Server module's service uses.

Note

The "Server Security Settings" on page 90 dialog can only ever be executed from
the user specified here.

« Username: The account that the service uses to login. If the machine is on a
domain, use the format domain\username.
This account must be an existing Windows profile with local administrator rights.

o Password: The password associated with the selected user.

« Validate user button: Click to verify that the entered username and password
combination is correct and that the service is able to login.
This button must be clicked and the user validated before the Next button becomes
available.

Click Next to start the actual installation process. This process can take several minutes.

Completing the installation

This screen describes a summary of the components that have been installed.

« Configure Update Check checkbox: This option is enabled by default. It causes the
Product Update Manager to run after the installation is complete. This allows
configuring PlanetPress Connect to regularly check for entitled updates.

Note: this checkbox may not be available in the event that an issue was encountered
during the installation.

« Show Log... : If an issue was encountered during the installation, click this button to
obtain details. This information can then be provided to Objectif Lune for troubleshooting.

« When ready, click the Finish button to close the installation wizard, and initialize the
Product Update Manager, if it was selected.

The Product Update Manager

If the Configure Update Check option has been selected, the following message will be
displayed after clicking “Finish” in the setup:
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Click “Yes” to install or open the Product Update Manager where the frequency with which the
updates can be checked and a proxy server (if required) can be specified.

Note: if the Product Update Manager was already installed by another Objectif Lune
application, it will be updated to the latest version and will retain the settings previously
specified.

Select the desired options and then click OK to query the server and obtain a list of any
updates that are available for your software.

« Note that the Product Update Manager can also be called from the “Objectif Lune Update
Client” option in the Start menu.

« ltcan be uninstalled via Control Panel | Programs | Programs and Features.
Product Activation

After installation, it is necessary to activate the software. See Activating your license for more
information.

Note

Before activating the software, please wait 5 minutes for the database to initialize. If the
software is activated and the services rebooted too quickly, the database can become
corrupted and require a re-installation.

Running connect installer in Silent Mode

PlanetPress Connect can be installed in a so called "silent mode" to allow an automated setup
during a company wide roll-out or comparable situations. The trigger for the Connect Installer to
run in silent mode is a text file with the fixed name install.properties, which is located either in
the same folder as the PlanetPress_Connect_Setup x86_ 64.exe or in the unpacked folder of
the installer.exe.

Note

Only the installation can be run silently. Silent Mode does not apply to uninstalling, modifying, or
updating Connect. Any previous version of Connect must be uninstalled before using the Silent
Installer.
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The required properties file has the following attributes:

« Comment Lines, starting with # (e.g. # The options to configure an external database)

« Key =Value pairs (e.g. install.product.0 = Connect Designer)

For supported keys, please refer to the next paragraph.

Note

install.properties file notation must follow commons configuration rules. Please refer to
Properties files for more details.

Required and optional properties

Required properties depend on the specified product. Only fields related to that specified
product must be entered. If no product is mentioned, properties must be specified for all valid
Connect products.

Here is an example of an install.properties file.

# Verbose logging
logging.verbose = true

# Product selection
install.product.0 = Connect Designer
install.product.l = Connect Server

# Server settings
server.runas.username = Localadmin
server.runas.password = admin

# Database configuration
database.type = mysqgl
database.host = 192.168.116.10
database.port = 3308

database.username = root
database.password = admin
database.schema = my ol
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Verbose logging (optional)

By default, the Silent Installer will log the same way as the GUI installer. That means logging
of error and warnings, and certain information during database configuration. A more verbose
logging can be switched on by using logging.verbose = true.

Product selection (optional)

By default, if nothing is entered for the products to be installed (install.product.X), Silent
Installer will install all products which are visible to the user for the respective brand (except for
the Server Extension, because only Server or Server Extension can be installed at the same
time).

PlanetPress defaults

install.product.0 = Connect Designer
install.product.l1 Connect Server
install.product.?2 MySQL Product

Note

The values of install.product properties must contain the exact product names.

Server configuration (required if Server is selected for install)

For Server, the following properties need to be provided:

server.runas.username = <username>
server.runas.password = <password>

Server Extension configuration (required if Server Extension is selected for install)

For Server Extension, the following properties need to be provided:

server.runas.username = <username>

server.runas.password = <password>

server.master.host = <IP or name>

Sserver.master.port = <port>

server.master.authenticate = true or false
server.master.username = <username for the Connect Server>
server.master.password = <password>
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Database configuration

Case 1: MySQL is among the selected Connect products to be installed (new MySQL
installation)

If MySQL is selected and there is no previous MySQL configuration on the machine, the
following properties should be defined:

database.password = <password> (required and must meet the rules)
database.port = <port> (3306 is the default port value)
database.unlocked = true or false (the default value is false,

optional)

Note

The unlocked option should only be used when the database requires an external access.

If the Silent Installer runs with the default product selection, MySQL Product is included, and
hence the database.unlocked = true property may be optionally set if MySQL on this machine
is intended to serve as the central database also for remote machines.

If the Silent Installer runs with the explicit installation of a stand-alone (install.product.0 =
Connect Server), the database.unlocked property is irrelevant.

Note

The port will be defined automatically for the MySQL installation. All connect products selected in
the Silent Installer will automatically be configured to use the MySQL running under the port
defined by the database.port property, regardless of the default port 3306 or any other user
defined port.

A different port is required if 3306 is already taken on that machine by another application.

Case 2: The Connect Server is selected and the MySQL Product is not selected

In this case, an external database must be configured for the Server (and other Connect
products included in the Silent installation) to be used.
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2a: Configuring an external MySQL database

To configure an external MySQL database, the following properties should be defined:

database.type = mysqgl (required)

database.host = <host> (default value is localhost, otherwise
required)

database.port = <port> (default value is 3306, otherwise required)
database.username = <username> (default value is root, otherwise
required)

database.password = <password> (required)

database.schema = <schema name> (default value is objectiflune,
optional)

2b: Configuring an external Microsoft SQL Server database

Note

Since PlanetPress Connect version 1.6 the minimum required version of the MS SQL
Serveris SQL Server 2012.

To configure an external Microsoft SQL Server database, the following properties should be

defined:

database.type = Microsoft SQL Server (required)

database.host = <host> (default value 1s localhost, otherwise
required)

database.port = <port> (default value is 1433, otherwise required)
database.username = <username> (default value is sa, otherwise
required)

database.password = <password> (required)

database.schema = <schema name> (default value is objectiflune,
optional)

Repository selection

The Connectinstallation process requires a repository from which the installer copies (locally)
or downloads (online installation) all selected Connect products.
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In Silent Installer mode, the installation process looks for the property product.repository in
the install.properties file and then proceeds with the following steps:

1. If the property exists, and its value contains an existing file location with a repository, the
installer will attempt to install from that repository.

2. Ifthe property exists, and its value starts with http:/, the installer will attempt to install from
that location. It will fail if no repository can be found at this location.

3. If none of the conditions mentioned in the previous steps are met, the installer will look
next for a local "repository" folder (located in the same folder as the running Installer
(Setup) executable file). If a repository is found, the installer will attempt to install from that
repository.

4. As alast resort, the installer will attempt to install from the default Connect Update Site
URL.

Examples

product.repository
01/repository
product.repository = C:\\iso\\2.0.0.39695 unpacked\\repository

http://192.168.79.73/Connect/Version

Locale definition
Itis possible to define the Locale which affects the installation language and installed locale for

Connect products by using the following properties in the install.properties file:

user.language
user.country

Locales supported by Connect

The Connect Setup supports a dedicated list of Locales, which is saved in the preinstall.ini file.
Each entry consists of a language tag and a country tag, formatted by the pattern:

<language>-<country>

The current list of supported Locales is found below, but it may be enhanced in future releases:

« en-US (English, US)
» de-DE (German, Germany)
« fr-FR (French, France)
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o ja-JP (Japanese, Japan)

« zh-CN (Chinese, China)

o zh-HK (Chinese, Hongkong)

« zh-MO (Chinese, Macau)

e zh-TW (Chinese, Taiwan)

o it-IT (Italian, ltaly)

» pt-BR (Portuguese, Brazil)

« €s-419 (Spanish, Latin America)

Locale selection by defining user.language and user.country

If both user.language and user.country are defined in the install.properties file, the
combination must match exactly one of the supported locales, otherwise the Installer will exit
with an error.

For example, user.language = fr and user.country = CA will cause an error since fr-CA is not
in the list of supported Locales.

Locale selection by defining only user.language

If only user.language is defined in the install.properties file, the Installer will attempt to find a
Locale in the list which starts with the given language code. The first match is selected for
installation. If no match is found, the Installer will exit with an error.

For example:

user.language = zh, will result in an installation with the Locale zh-CN

user.language = no, will resultin an error

Default Locale selection

If neither user.language nor user.country is defined in the install.properties file, the Installer will
select a default Locale:

1. Ifthe System Locale is in the list of supported Locales, it will be selected.

2. Otherwise, if there is an entry in the list of supported Locales, which matches the System
language, it will be selected (e.g. on a fr-CA system, fr-FR is selected).
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3. As lastresort, the first Locale in the preinstall.ini is selected (usually that should be en-
usS).

Getting the exit code of a silent installation

If getting the exit code of a silent installation is desirable, use the following procedure.

1. Create a new local folder on the machine (or VM) on which Connect shall be installed
and copy/extract the contents of the Connect ISO into this folder.

2. Open a command prompt with Administrator privileges and cd into this local folder.

3. Run this command to unpack the contents of the Connect Setup executable (as a sample,

we use the PReS Connect brand):
PReS Connect Setup x86 64.exe -nr -gm2 -InstallPath=".\\"

4. In the local folder, the repository subfolder should now be located next to the
preinstall.exe, installer.exe and other Installer files.
5. Create the install.properties file for silent installation in the local folder.

6. With a batch file calling preinstall.exe and then querying the %errorlevel %, silent
installation can be started and the exit code can be evaluated. See the sample batch file

below.
Exit codes
0 = Success

1 = General Error in preinstall (e.g. not supported settings for user.language / user.country, for
reason see preinstall_err.log)

2 = Unknown Error in preinstall

10 = General Error in Installer application (for reason see OL_Install_<timestamp>.log)
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Sample batch file

@echo off
preinstall.exe

if errorlevel 10 goto err installer
if errorlevel 2 goto err unknown
if errorlevel 1 goto err preinstall

echo Success
goto:eof

:err installer
echo "Installer error - see OL Install <timestamp>.log"
goto:eof

:err unknown
echo "Unknown preinstall error - see preinstall err.log"
goto:eof

:err preinstall
echo "Preinstall error - see preinstall err.log"
goto:eof

Activating a License

PlanetPress Connect and PlanetPress Workflow 8 includes separate 30 day trial periods
during which itis not necessary to have a license for reviewing basic functionality. If a
modification to the license if required, such as to allow an extension to the trial period, or for
extra functionality or plugins (e.g., the PReS Plugin for Workflow 8), then a new activation code
will need to be requested.

Obtaining the PlanetPress Connect Magic Number

To obtain an activation file the OL™ Magic Number must first be retrieved. The Magic Number
is @ machine-specific code that is generated based on the computer's hardware and software
using a top-secret Objectif Lune family recipe. Each physical computer or virtual computer
should have a different Magic Number, thus require a separate license file to be functional.

To get the PlanetPress Connect Magic Number, open the PlanetPress Connect Designer
application:
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Open the Start Menu

Click on All Programs, then Objectif Lune, then PlanetPress Connect

Open the PlanetPress Connect Designer [version] shortcut.

When the application opens, if it has never been activated or the activation has expired,
the Software Activation dialog appears:

» License Information subsection:
« Magic Number: Displays the PlanetPress Connect Magic Number.

« Copy to Clipboard: Click to copy the Magic Number to the clipboard. It can
then be pasted in the activation request email using the CTRL+V keyboard
shortcut.

« Licensed Products subsection:

« Name: Displays the name of the application or module relevant to this
activation.

« Serial Number: Displays the activation serial number if the product has been
activated in the past.

« Expiration Date: Displays the date when the activation will expire (or the
current date if the product is not activated)

« Web Activations: Click to be taken to the online activation page (not yet
functional).

« End-User License Agreement (Appears only when loading a license file):
« License: This box displays the EULA. Please note that this agreement is
legally binding.
« lagree: Select to accept the EULA. This option must be selected to install the
license.

« ldon't agree: Select if you do not accept the EULA. You cannotinstall the
license if this option is selected.

+ Load License File: Click to browse to the .olconnectlicense file, once it has been
received.

« Install License: Click to install the license and activate the software (only available
when a license file is loaded).

« Close: Click to cancel this dialog. If a license file has been loaded, it will not
automatically be installed.
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Note

The Software Activation dialog can also be reached through a shortcut located in All
Programs, then Objectif Lune, then PlanetPress Connect and is named Software
Activation. Since it does not load the software, it is faster to access for the initial activation.

Requesting a license

After getting the Magic Number, a license request must be done for bothPlanetPress Connect
and Workflow 8:

o Customersmust submit their Magic Number and serial number to Objectif Lune via the
Web Activations page: http://www.objectiflune.com/activations. The OL Customer Care
team will then send the PlanetPress Connect license file via email.

« Resellerscan create an evaluation license via the Objectif Lune Partner Portal by
following the instructions there: hitp://extranet.objectiflune.com/

Note that if you do not have a serial number, one will be issued to you by the OL Activations
team.

Accepting the license will activate it, after which the PlanetPress Connect services will need to
be restarted. Note that in some case the service may not restart on its own. To resolve this
issue, restart the computer, or start the service manually from the computer's Control Panel.

Activating PlanetPress Workflow 8

PlanetPress Workflow 8 uses the same licensing scheme as PlanetPress Connect. There are
two ways of activating the license for Workflow 8 after saving it to a suitable location:

« Ifonly PlanetPress Workflow 8 is installed, double-click on the license for the PlanetPress
Workflow 8 License Activation dialog to open. Applying the license here activates all of
the Workflow 8 components.

« If you have both PlanetPress Workflow 8 and PlanetPress Connect installed, it will not be
possible to double-click on the license file as this will always open the PlanetPress
Connect Activations Tool. Instead, open PlanetPress Workflow 8 manually and apply the
license through the activations dialog within.
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Activating PlanetPress Connect

To activate PlanetPress Connect, simply save the license file somewhere on your computer
where you can easily find it, such as on your desktop. You can then load the license by double-
clicking on it, or through the start menu:

e Open the Start Menu
e Click on All Programs, then Objectif Lune, then PlanetPress Connect

« Open the PlanetPress Connect Designer [version] shortcut. The “PlanetPress Connect
Software Activation” tool displays information about the license and the End-User License
Agreement (EULA).

+ Click the Load License File button.

- Read the EULA and click | agree option to accept it.

« Click Install License to activate the license. The license will then be registered on the
computer and you will be able to start using the software.

Warning

After installation message will appear warning that the Server services will need to be restarted. Just
click OK to proceed.

Migrating to a new workstation

The purpose of this document is to provide a strategy for transferring a Connect installation to a
new workstation. The following guide applies to OLConnect v1.x and Workflow v8.x.

Before installing the software

Before upgrading to a new version, even on a new workstation, consult the product's release
note to find out about new features, bug fixes, system requirements, known issues and much
more. Simply go to the product page and look for "Release notes" in the Downloads area.

You should also consult the following pages for some technical considerations before
installing:

« Network Considerations

« Database Considerations
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« Environment Considerations

o Installation Pre-Requisites

o Antivirus Exclusions

Downloading and Installing the Software

In order to migrate to a new workstation, the software must already be installed on the new
workstation. Follow the Installation and Activation Guide to download and install the newest
version of PlanetPress Connect on the new workstation.

Backing Up files from the current workstation

The first step in migrating to a new workstation would be to make sure all necessary production
files and resources are backed up and copied over to the new system.

Technical

Although it is not necessary to convert all of your documents when upgrading to the latest version,
we strongly recommended doing so. It is considered "Best Practice" to convert the documents to the
version installed and then re-send them to the Workflow Tools.

Backing up Workflow files

To save all Workflow-related files, backup the entire working directory:

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8

Here are a few important points when transferring these files:

« If you are upgrading to the latest version of Connect, it is recommended to open each
template in Designer, produce a proof making sure the output is correct. Then send the
template with its data mapper, job and output preset files to Workflow by clicking on File -

> Send to Workflow...

« Ifyou still use PlanetPress 7 legacy documents, PTK files can be imported by clicking on
the Workflow tool button at the top left corner of the Workflow tool interface. If copying the
PlanetPress Workflow 8 folderdirectly,it'simportant to delete any file with the .ps7
extension so as to refresh the postscript file for the new workstation.
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« The Workflow configuration file itself is named ppwatch.cfg, and is backed up with the
folders. However, it needs to be re-sent to the Service to be used. To do this, rename the
file to .OL-Workflow, open the file with the Workflow tool, and send the configuration.

« Locate Custom Plugins (.dll) from the below folder on the old workstation and import them
onto the new workstation
C:\Program Files (x86)\Common Files\Objectif Lune\PlanetPress

Workflow 8\Plugins
To import the plugins:

« Start the Workflow Configuration Tool

o Click on the Plug-in Bar

« Click on the down pointing triangle under the Uncategorized group
« Select Import Plug-in and select the .dll file.

« Import external scripts used by the Run Script plugin, making sure they reflect the same
paths as on the previous workstation

« Install any external application, executable and configuration files used by the External
Program plugin, making sure they reflect the same paths as on the previous workstation

« Reconfigure local ODBC connections. (i.e. create local copies of databases or recreate
required DSN entries)

« Backup and import other custom configuration files, Microsoft Excel Lookup files, making
sure they reflect the same paths as previously.

« Reinstall required external printer driver and recreate all Windows printer queues and
TCPIP ports

o On the new workstation if the "TCP/IP Print Server" service is running in Windows, it is
requested to disable that service so that it does not interfere with the Workflow LPD/LPR
services.

« Configure the Workflow services account as in the previous installation. If accessing,
reading and writing to network shares; itis recommended to use a domain user account
and make it a member of the local Administrators group on the new workstation. Once the
user account has been chosen:

o Click on Tools in the Workflow Configuration menu bar
« Click Configure Services
« Select the user account

« If required, grant permissions to other machines (Designer clients and other servers) to
send documents and jobs to the new server.
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o Click on Tools in the Workflow Configuration menu bar
« Click on Access Manager

« Grant necessary permissions to remote machines

« Restart the Workflow Messenger service

« Reconfigure the Workflow Preferences as previously by clicking on the Workflow button
on top left corner and clicking on Preferences:

» Reconfigure the Server Connection Settings under Behavior > OL Connect

« For PlanetPress Capture users, reconfigure the PlanetPress Capture options under
Behavior > PlanetPress Capture

« Reconfigure each of the plugin, where necessary, under Plug-in as previously.
Capture OnTheGo users may want to enable the Use PHP Arrays option under
Plug-in > HTTP Server Input 1

» Send the configuration to local Workflow service

Backing up Connect Resources

The following resources are used by Connect and can be backed up from their respective
folders:

« Job Presets (.OL-jobpreset):
C:\Users\<UserName>\Connect\workspace\configurations\JobCreatio
nConfig

e Output Presets (.OL-outputpreset):
C:\Users\<UserName>\Connect\workspace\configurations\PrinterDef
initionConfig

« OL Connect Print Manager Configuration files (.OL-ipdsprinter)
C:\Users\<UserName>\Connect\workspace\configurations\PrinterCon
fig

e OL Printer Definition Files (.OL-printerdef)

C:\Users\<UserName>\Connect\workspace\configurations\PrinterDef
initionConfig

« OMR Marks Configuration Files (.hcf)

C:\Users\<UserName>\Connect\workspacelconfigurations\HCFFiles

Other Resources
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« OL Connect Designer Templates, DataMapper or Package files, copied from the folder
where they reside.

« All Postscript, TrueType, Open Type and other host based fonts used in templates must
be reinstalled on the new workstation.

» Import all dynamic images and make sure their paths match those in the old server.

« Make sure the new workstation can also access network or remote images, JavaScript,
CSS, JSON, and HTML resources referenced in the Connect templates.

Secondary Software and Licenses

The following only apply for specific secondary products and licenses that interacts or is
integrated into the main product.

Image, Fax and Search Modules

« Reconfigure the Image and Fax outputs with the new host information.

« Import the Search Profile and rebuild the database in order to generate the database
structure required by the Workflow.

Capture

« Download the latest version of the Anoto PenDirector.

« Before installing the PenDirector, make sure the pen’s docking station isn’t plugged into
the server. Then install the PenDirector.

« Stop the Messenger 8 service on old and new server from the Workflow menu bar > Tools
> Service Console > Messenger > right-click and select Stop.

« Import the following files and folders from the old server into their equivalent location on
the new server:
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\capture\PPCaptureDefault.mdb
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC

« If Capture was previously using an external MySQL or Microsoft SQL Server, reconfigure
the ODBC connection details as previously from the Workflow Preferences by clicking on
the Workflow button on top left corner and clicking on Preferences, then reconfigure the
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PlanetPress Capture options under Behavior >PlanetPress Capture > Use ODBC
Database

» Start the Messenger 8 service on new server from the Workflow menu bar > Tools >
Service Console > Messenger > right-click and select Start.

OL Connect Send

* Re-install OL Connect Send on the new Workstation. This should reinstall the OL Connect
Send plugins in the Workflow Tool

» Reconfigure the Server URL and port during the OL Connect Send Printer Driver setup

* Re-run the OL Connect Send printer driver setup on client system and select the Repair
option to point the clients to the new Server URL.

Configuring the Connect Engines

Any changes made to the Server preferences require the OLConnect_Server service to be
restarted to take effect.

« Stop the OLConnect_Server service from Control Panel > Administrative Tools >
Services > OLConnect_Server > Stop

« Configure the Merge and Weaver Engines scheduling preferences as in the previous
installation

« Open the Server Configuration from :
C:\Program Files\Objectif Lune\OL Connect\Connect
Server\ServerConfig.exe

« Configure the Merge and Weaver engines preferences under Scheduling (see
Engine configuration)

« Configure any other options for the Clean-up Service

« Configure the minimum (Xms) and maximum (Xmx) memory utilization for the Server,
Merge and Weaver engines as previously or better (see Memory per engine):

« Edit the following Xms and Xmx fields in the following configuration files:

e C:\Program Files\Objectif Lune\OL Connect\Connect
Server\Server.ini

e C:\Program Files\Objectif Lune\OL
Connect\MergeEngine\Mergeengine.ini
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e C:\Program Files\Objectif Lune\OL
Connect\weaverengine\weaverengine.ini

« Now startthe OLConnect_Server service

Configuring the Server Extensions

In the case where the OLConnect MySQL is installed on the new Master Server, itis important
to reconnect all Server Extension systems to the new Master Server.

Perform the following action on each Server Extension:

« Stop the OLConnect_ServerExtension service from Control Panel > Administrative
Tools > Services > OLConnect_ServerExtension > Stop

« Open the Server Extension Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Extension\ServerExtension.exe

« Click on Database Connection and configure the JDBC Database connection settings so
that the hostname points to the new Master server

« Click on Scheduling and type in the location of the new Master server

o Startthe OLConnect_ServerExtension service

Transferring Software Licenses

Once all the above resources have been transferred over to the new server, it is recommended
to thoroughly test the new system with sample files under normal production load to identify
points of improvement and make sure the output match the user’s expectation. Output
generated at this point will normally bear a watermark which can be removed by transferring
licenses from the old server to the new one.

« To transfer Connect and Workflow licenses, the user is usually required to complete a
License Transfer Agreement which can be obtained from their local Customer Care
department

« Upgrades cannot be activated using the automated Activation Manager. Contact your
local Customer Care department.
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To apply the license file received from the Activation Team:

« Startthe PReS Connect, PlanetPress Connect or PrintShopMail Connect Software
Activation module:
C:\Program Files\Objectif Lune\OL Connect\Connect Software Activation\
SoftwareActivation.exe

« Click on Load License File to import the license.OLConnectLicense
« Start the Software Activation module on the Extension servers, where applicable
« Click on Load License File to import the above same license.OLConnectLicense

» Restartthe OLConnect_Server service and restart the OLConnectServer_Extension
service on the Extension servers, where applicable

« The number of Expected Remote Merge and Weaver engines should now be
configurable in the Connect Server Configuration module (C:\Program Files\Objectif
Lune\OL Connect\Connect Server Configuration\ ServerConfig.exe)

To apply the PlanetPress Capture License

« Open the Workflow Configuration

« Click on Help on the Menu Bar and click on PlanetPress Capture License manager to
import your license.

Uninstalling PlanetPress Connect from the previous workstation

Itis recommended to keep the previous install for a few days until everything is completed.
However, once your transition is successful and complete, the OL Connect software must be
uninstalled from the original server.

Information about PlanetPress Workflow 8

If you wish to use PlanetPress Workflow (automation) in conjunction with PlanetPress Connect,
you will need to install PlanetPress Workflow 8.8 onto the same machine. Workflow 8.8 is
provided through a separate installer which is available on CD or for download as follows:

« If you are a Customer, the installer can be downloaded from the Objectif Lune Web
Activations page: http://www.objectiflune.com/activations

« If you are a Reseller, the installer can be downloaded from the Objectif Lune Partner
Portal: http://extranet.objectiflune.com/
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PlanetPress Workflow 8 can be installed in parallel on the same machine as an existing
PlanetPress® Suite 7.x installation.

Note however:

« If both versions need to be hosted on the same machine, PlanetPress Workflow 8.8 must
always be installed after the legacy PlanetPress® Suite 7.x installation.

« When uninstalling PlanetPress Workflow 8.8, you may be prompted to repair your legacy
PlanetPress® Suite 7.x installation.

« If PlanetPress Workflow 8.8 has been installed alongside PlanetPress® Suite 7, Capture
can no longer be used with Workflow 7.
The plugins are now registered uniquely to Workflow 8.8 and the messenger for Workflow
7 is taken offline. It is only then possible to use Capture from PlanetPress Workflow 8.8.

o PlanetPress Workflow 8.8 and PlanetPress® Suite Workflow 7 cannot run
simultaneously, since only one version of the Messenger service can run at a time. In fact,
no two versions of Workflow can be run simultaneously on the same machine, regardless
of versions.

« ltis possible to switch between different versions running by shutting down one version's
services and then starting the other. However, this is not recommended. There are no
technical limitations that prevent processes from previous PlanetPress Suite Workflow
versions (as far back as Version 4) to run on PlanetPress Workflow 8, removing the need
to run both versions.

For more information on the licensing of Workflow 8.8, please see Activating your license.

Upgrading from PlanetPress Suite 6/7

Note

This document is intended for people who already received their upgrade to PlanetPress Connect.
They should already have their new serial number(s) in hand and the PlanetPress Connect installers.

With the release of PlanetPress Connect, Objectif Lune’s innovative new technology, existing
users of PlanetPress Suite version 7 and 6 have the possibility to migrate to an introductory
version of PlanetPress Connect called “PlanetPress Connect Print-Only”.
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This migration benefits existing users in many ways and has limited impact on their current
processes and how they use PlanetPress Suite version 7 and 6.

This document provides information on the migration process and the requirements and
considerations for existing PlanetPress Suite users to upgrade to the latest generation of our
products.

Note

PlanetPress Connect Print-Only is available for existing users of PlanetPress version 7 or 6 with a
valid OL Care agreement. If you are using a previous version or are not covered by OL Care,
please contact your reseller or your Objectif Lune Account Manager for more information.

What does PlanetPress Connect contain?

PlanetPress Connectis comprised of the following modules:

« PlanetPress Workflow 8. This is the natural evolution of PlanetPress Suite Workflow 7
(Watch, Office or Production). PlanetPress Workflow 8 is very similar to the PlanetPress
Suite Workflow 7 version but contains some new features and has the ability to run
PlanetPress Connect jobs, as well as PlanetPress Suite, PrintShop Mail Suite and PReS
Classic documents.

o Imaging for PlanetPress Connect is available as an option. It contains:
o PlanetPress Fax
« PlanetPress Image
« PlanetPress Search

o PlanetPress Capture is still supported in PlanetPress Workflow 8 but only with
documents created with the PlanetPress Suite Design 7.

« PlanetPress Connect Designer. This is the design tool based on completely new
technology. Itis not backwards compatible and therefore cannot open PlanetPress Suite
Design 7 documents. If you want to continue editing those documents you can keep doing
so in PlanetPress Suite Design 7.

« PlanetPress Connect Server. This is the core of the Connect technology. This new
module automates the merging of data with your new templates and generates the output.
It is required for PlanetPress Workflow 8 to handle templates created with the
PlanetPress Connect Designer. It can be installed on the same or a different machine as
PlanetPress Workflow 8.
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IMPORTANT: PlanetPress Connect does not contain the PlanetPress Design 7.

GOOD NEWS: PlanetPress Connect does not need any printer licenses to print from
PlanetPress Connect or PlanetPress Suite. It can also print PrintShop Mail 7 and PReS
Classic documents if these programs are licensed.

You can keep everything you have

The first thing to know is that you can keep your current PlanetPress Suite Workflow 7
configuration and your PlanetPress Suite Design documents. When upgrading to PlanetPress
Connect, they will remain functional.

Please note that PlanetPress Suite Workflow 7 and PlanetPress Workflow 8 cannot run at the
same time. See Information about Connect Workflow 8 for information about these limitations.
The only exception is the PlanetPress Suite Design tool that you can continue to use as it is not
part of PlanetPress Connect.

For customers upgrading to the free “Print only” version, if you wish you to continue your OL
Care engagement, the next year will be priced at the same price as your current price.

For customer upgrading to the full version of PlanetPress Connect, with or without new options,
the next year of OL Care will be priced at the value of the new software you upgraded to.

Before going into any further details, please read the following section carefully.

PlanetPress Connect installation considerations

The PlanetPress Suite could run on a computer with a minimum of only 1GB of RAM available.
The PlanetPress Connect Server with PlanetPress Workflow 8, by default, requires 8 GB of
RAM, but if you intend on using the new PlanetPress Connect Designer on the same computer,
you should consider having at least 12 GB of RAM available. See System requirements.

Distributed installation or not

You can decide to install PlanetPress Connect modules all on the same computer or have each
module on a different computer. Reasons for this could be:

« There is insufficient memory in the computer currently running PlanetPress Workflow 8 to
also run PlanetPress Connect Server.
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« You want to use a more powerful computer with more RAM and more cores to run the
Server to achieve maximum performance.

What do | gain by upgrading to PlanetPress Connect?

PlanetPress Watch users

When upgrading to PlanetPress Connect, you receive key features of PlanetPress Office such
as the following:

« Ability to input data from PDF

« Ability to print your PlanetPress Suite documents on any Windows printer (no need for
printer licenses)

« Ability to create standard PDF output from your PlanetPress Suite documents

« Even if you don’t recreate your existing PlanetPress Suite documents, you can easily
change your workflow to convert your output to PDF, then output them in PCL to any
device supporting it.

Note

If you were a PlanetPress Production user, you retain all functionalities within
PlanetPress Workflow 8. These are automatically imported during the activation (see
below).

Re-purpose your existing documents

IMPORTANT: PlanetPress Suite users covered by a valid OL Care contract receive a “Print
only” version of PlanetPress Connect which can produce printed output. If you also own
PlanetPress Imaging, which can produce PDF, Tiff and other archive formats, you will also
receive a new version.

The full version of PlanetPress Connect can open your company to the digital world by
enabling you to send HTML responsive emails as well as creating dynamic responses and
interactive web pages. All that for a minimal fee. For more information on the full version of
PlanetPress Connect, contact your reseller or your Objectif Lune Account Manager.
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Upgrade to the full multi-channel version and expand onto the Web

If you choose to take the optional “multi-channel” upgrade, you can start right away to reuse the
content of your existing documents and map it onto responsive documents that can be sent by
email in full HTML glory and/or make them available as native HTML web pages using the
latest CSS/JavaScript features.

IMPORTANT: If you owned them, you must also upgrade your Imaging modules to use the new
PReS version.

Create new documents and integrate them into your workflow at your own pace

You can start benefiting from the innovative technology of the new PlanetPress Connect
Designer right away by designing new documents, or re-doing existing ones at your own pace.
With PlanetPress Connect Print-Only, you can now:

« Use the new Data Mapper to easily map any input data into a clean data model that any
designer person can use

« Easily create documents with tables that spread over multiple print pages, respecting
widow and orphan rules, displaying sub-totals and totals properly

« Have text that wrap around images
Upgrade steps

1. To upgrade to PlanetPress Connect, the first step is to stop your PlanetPress Workflow
services. You can do so from the PlanetPress Workflow configuration tool or from the
Windows Service Management console.

2. Then, using the PlanetPress Connect setup, install the Designer and/or Server on the
appropriate computers. Then, using the PlanetPress Workflow 8 setup, install
PlanetPress Workflow and/or PlanetPress Image on the appropriate computers. (See the
installation and activation document for more details)

3. Ifyou installed PlanetPress Workflow 8 on the same computer where you had
PlanetPress Suite Workflow 6 or 7, you can use the Upgrade Wizard to import your:

« PlanetPress Workflow:
« Processes configuration
« PlanetPress Suite compiled documents

« Service configuration
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« Access manager configuration
o Custom plug-ins

« PlanetPress Fax settings

« PlanetPress Image settings

« PlanetPress Search profiles

« Printer activation codes

« PlanetPress Capture database

« PlanetPress Capture pen licenses

o Custom scripts

« Content of your virtual drive

« PlanetPress Messenger configuration

4. Ifyou installed PlanetPress Workflow 8.8 on a different computer, please see "How to
perform a Workflow migration" on page 70 for help importing all those settings, if you wish
to import them.

5. Tolaunch the Upgrade wizard, open the PlanetPress Workflow 8 configuration tool and,
from the Tools menu, launch the Upgrade Wizard.

IMPORTANT: Before you start this process, make sure you have a backup of your current
installation/computer.

= s

Home Wiew Debug Tools Help

# Printer Utilities :djﬁ'xccess Manager OCheckar updates & Pen Manager

A Install PostScript Font 1Y Virtual Drive Manageq || £ Launch Upgrade Wizard g Documents Manager

Managers PlanetPress Capture
|Cnnﬁguratinn Components 4 | Process - Processl
= ¥t Processes 1
&, Process1 [asap) 1 4 | Folder Capture
# Subprocesses J Ic:'\snurce
' Global variables
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6. Then select your upgrade type:

% Upgrade wizard opticns
- Upgrade option
Custom Upgrade LI
prezz Upgrade
wztom Uparade porade

all the curentiy nztalled F regs W orkflow

goftware to your new PlanetPress W aork low

WETEION.

Select 'Custom Upgrade' if pou want to chooze
which of the currently installed PlanetPress
WorkHow software iz to be upgraded to wour
new PlanetPreszs Worklow version,

< Back MHest >
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7. Then select the product from which you wish to upgrade:

% Upgrade wizard opticns

Upgrade from version

IF'IanetF'ress Suite  to PlanetPress Connect ;I

fram which to perfarm the upgrade, and press
et

WARMIMG - Ay files upgraded from a previous
wvergion of the PlanetPreszs Workfow will
avenarite your curent files bearing the same
name. Pleaze backup your curent files to avaoid
arny data lozs.

Exit MHest >

8. Ifyou selected to do a Custom upgrade, select the required options:
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% Upgrade wizard options
[v Al software

-
[w Printer activation codes

[ PFlanetPressz Capture Databaze

[v Cugtom scripts

-
-
-
-

v PlanetPress Fax
[v PFlanetPressz Fax settings

[v FlanetPress Image
v PlanetPrezs Image settingz

[v PlanetFrezz Search

[w “irtual drive content
[v Meszzenger configuration

[v PlanetPress Capture pen licenze

[v PlanetPress Workfow
[v Compiled documents
[v Active configuration
[v Service configurations
[v Access Manager
[v Custam plug-in:

Iv PlanetPress Search Profiles

< Back MHest »

9. Then finally review the log in the final dialog for details on how it went:

Page 68

PlanetPress.
Connect



% Upgrade wizard options @

LOG: pgrade Completed. -

Exit

10. After that you will need to get the activation file for your product.

To obtain your activation, download the PlanetPress Connect installer from the Web
Activation Manager, follow the instructions for the installation using the serial number
provided to you. You can activate your license through the Web Activation Manager.

11. From now on, if you need to modify your PlanetPress Design documents, simply open
PlanetPress Design 6 or 7, edit your document and send the updated version to
PlanetPress Workflow 8. In order to do that:

« If you have the PlanetPress Design on the same computer as the PlanetPress
Workflow 8, you need to save the documents to PTK by using the “Send to” menu,
then "PlanetPress Workflow”, and there use the “Save to file” button. Then, from the
PlanetPress Workflow 8 configuration tool, in the “Import” menu, select “Import a
PlanetPress Document” and select the previously saved file.

« Ifyou have the PlanetPress Design on a computer and the PlanetPress Workflow 8
on another, you can simply use the “Send to” menu in the Designer and select the
PlanetPress Workflow 8 to which you want to send the PlanetPress Design
document.
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How to perform a Workflow migration

What do you need to consider when upgrading from PlanetPress Suite 7 to PlanetPress
Connect Workflow 8.8 on a new computer?

Installing and Activating Workflow 8.8 on a new computer
Points to consider:
» Before installing, be sure to read the Installation and Activation Guide. There you will find

detailed Connect Workflow installation steps as well as system requirements, notes on
license activation and much more.

« Itis recommended you retain your existing PlanetPress Suite installation for a period of
time after the PlanetPress Connect Workflow 8.8 installation. We recommend this
particularly when undertaking migration from one to the other. Once the migration has
completed, you should uninstall PlanetPress Suite from your original installation. In the
meantime, a fresh installation of PlanetPress Connect will run for 30 days without
requiring an activation code, to simplify the migration process.

« Request new activation codes for your software licenses (License Transfer agreement
needs to be filled out and signed). Contact your local Activations Department.
ww.objectiflune.com/activations

« Please note that PlanetPress Suite Workflow 7 and PlanetPress Workflow 8 cannot run at
the same time. See Information about Connect Workflow 8 for information about these
limitations. The only exception is the PlanetPress Suite Design tool that you can continue
to use as itis not part of PlanetPress Connect.

Printer Licences

If you are currently using Printer Licenses under PlanetPress Suite 7 and wish to continue
doing so in PlanetPress Connect Workflow 8.8, there are a few ways in which you can reinstall
those printer activation codes onto PlanetPress Connect Workflow 8.8. They are as follows:

« If you retained the .pac file (printer activation codes) from your previous installation, then
double click on that file from within your new computer, and the printers will get activated.

If you did not retain the pac file, you can export a new printer activation code. This is done
from the PlanetPress Suite Designer Help > Printer Activation menu option. When the
"Activate a printer" dialog is launched, right click within it and select the Export context
menu option, then save the file on the new computer. Double clicking on the .pac file will
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then activate all of your printers on the new computer.

« Login to our Web Activation Manager (www.objectiflune.com/activations) using your
customer number and password to get your Printer Activation Codes.

« If you do not have access to the computer in which PlanetPress Suite was previously
installed, print a Status Page for each printer from your Connect Workflow 8
Configuration. Do this via the Tools > Printer Utilities menu option. Select “Print Status
Page” and then select your printers from the list.

Email the Status Page(s) to activations@ca.objectiflune.com and you will receive a .pac
file in return, with which you can activate your printer(s).

Documents and Resources

PlanetPress Suite Documents and Resources

« Backup all your PlanetPress Suite Design documents from your old computer and copy
them onto the new computer. The files use the extension .ppX, where X is the version
number of the PlanetPress Suite that created the files.

The documents do not have to be in any specific folder.

« Back up the entire directory of: "C:\ProgramData\Objectif Lune\PlanetPress Suite
7\PlanetPress Watch\Documents".
This folder contains all the PlanetPress Design documents and compiled forms (*.ptk and
*.ptz).
Paste the files onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Documents"

« Back up the latest .pwX (PlanetPress Workflow Tools Configuration) file, found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\".
Paste onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\"

There are several ways you can import Documents into PlanetPress Workflow. They are as
follows.

1. In Connect Workflow go to File > Import > PlanetPress Document ... and select the .ptk
document you wish to import.
These files will most likely be found in the Documents folder on the PlanetPress Suite
computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Documents"
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2. Copy all the PlanetPress Suite 7 Documents and Compiled forms (*.ptk and *.ptz) from
the Documents folder on the PlanetPress Suite computer and paste them into the
equivalent folder on the Connect Workflow Computer.

The PlanetPress Suite 7 folder would be "C:\ProgramData\Objectif Lune\PlanetPress
Suite 7\PlanetPress Watch\Documents".

The PlanetPress Connect Workflow 8 folder will be "C:\ProgramData\Objectif
Lune\PlanetPress Workflow 8\PlanetPress Watch\Documents"

3. Use the File > Send To menu option in PlanetPress Suite Designer and select the
PlanetPress Connect Workflow 8 to which you want to send the PlanetPress Suite
Designer document.

This should work with PlanetPress Suite versions 6 and 7.

Make sure that ports 5863 and 5864 are not blocked by firewall on either machine.

Also make sure you add the PlanetPress Suite machine’s IP address to the permissions
listin Connect Workflow 8 from Tools > Access Manager.

Further information about Workflow Access Manager can be found here: Access

Manager.

Windows Operating System Steps:

« Install all the Windows printer queues from the old computer, making sure they are named
the same.

« If your existing documents referenced any local dynamic image resources in a folder orin
Local Host, make sure that you import them onto the new computer as well, or make them
available on a network accessible drive.

« Any special Postscript or TrueType fonts used will also need be installed on the new
computer.

« Verify that you have access to any other resources that the PlanetPress Suite used. This
includes network folders, printers, third party software and the like.

Workflow Plug-ins

Back up any custom PlanetPress Suite Workflow configuration Plug-ins (.dll) and copy them
onto the new computer.

The PlanetPress Suite Workflow plug-ins folder can be found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Plugins".

Make sure that you copy only the custom plug-ins.
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Alternatively, you can download custom plug-ins from this link onto the new computer.

Once you've copied your PlanetPress Suite Workflow configurations to Connect Workflow, you
can confirm their availability through the Plug-in Bar Uncategorized category. There you will
find all the Custom plug-ins that have been installed.

Missing plug-ins will be represented in Workflow steps through the use of a "?" icon. Such as in
the following image, which shows that the " TelescopingSortPlugin" is not installed.

Mot Found
T elezcopingS ortFlugin

I
™)

To import a plugin:

1. Click on the popup control ( 2 )in the Plug-in bar.

Select Import Plugin
Browse to the location of the plug-in DLL file

Click on Open.

Al A

The new plug-in should appear in the Plug-in Bar Uncategorized category.
Configuring PlanetPress Connect Workflow 8

« Reconfigure any settings that may need to be applied to the PlanetPress Suite
Messenger and PlanetPress Workflow Tools LPD services using the Access Manager.

« All PostScript and TrueType host based fonts must be reinstalled. Make sure you restart
the computer after this step.

« If necessary, reconfigure local ODBC connections. (i.e. create local copies of databases
or recreate required DSN entries)

« Manually install all external executables that will be referenced by the Connect Workflow
processes in the configuration file. If possible, retain the local path structure as used on
the older installation.

« Ifthe Windows "TCP/IP Print Server" service is running on the new computer, itis
recommended that you disable the Server so that it does not interfere with the
PlanetPress LPD/LPR services.
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« If you are using images from a virtual drive, copy the entire contents of
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PSRIP" and paste them onto the new
computer here: "C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PSRIP".

« Make sure to set the user who will run the PlanetPress Services. This is done by going
into Tools/Configure services. The user will need to have local administration rights in
order to be able to run the services.

For more information, see Users and Configurations.

« Once all these steps have been completed, you will need to import your configuration file.
Find the latest pwX file located on the old computer, ifitis not already copied across to
the new computer. The default location on the old computer is “C:\ProgramData\Objectif
Lune\PlanetPress Suite 7\PlanetPress Watch\".

On the new computer you will need to File > Import > Configuration Components.
Browse and find your file. If the file is not visible change the file type to *.pw7

PlanetPress Image, Fax and Search

« Reconfigure the PlanetPress Image and PlanetPress Fax outputs with the new host
information.

« You mustimport the Search Profile and rebuild the database in order to generate the
required database structure.

PlanetPress Capture

« If you have a Capture Solution, please see "How to perform a Capture migration" below.

How to perform a Capture migration

This page provides information on how to conduct a proper migration of a Capture solution.

These steps must be executed after a proper Workflow Migration has been completed.
Instructions on how to do such can be found here: "How to perform a Workflow migration" on
page 70.

Failure to do so will resultin unexpected problems.
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Note

Itis recommended that you first update your PlanetPress Suite to version 7.6 before
cross-grading to PlanetPress Connect.

Using PlanetPress Connect Workflow 8.8 on the same computer as PlanetPress Suite 7.6

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PlanetPress Connect Workflow 8.8 on the same computer.

3. Do the following for both PlanetPress Suite version 7.6 and PlanetPress Connect
Workflow 8.

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).

2. Select Messenger in the tree list, right click and select Ml Stop from the context

menu.

Note

These steps must be done for both PlanetPress Suite Workflow 7 and
PlanetPress Connect Workflow 8.

4. Copy the file PPCaptureDefault.mdb from this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and
overwrite the existing database.
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Note

Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6
a separate database has been used for the patterns alone
(PPCaptureDefault.mdb).

5. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\DocumentManager"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".

6. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

7. Restart the PlanetPress Connect Workflow 8 Messenger. To do this,

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).

2. Select Messenger in the tree list, right click and select | Start from the context
menu options.

8. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Using PlanetPress Connect Workflow 8.8 on a different computer to PlanetPress Suite

7.6

Tip
It is safer to migrate outside high peak production since the Capture solution cannot be
run in parallel on two computers.
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Once the Capture database has been transferred to the new computer, any update made
to the old computer will be lost unless the steps to migrate are reproduce again.

Once a Pen has been docked and the data transfer done, its memory is wiped, thus
rending the parallel mode very hard to produce. It is not impossible, but describing how it
can be done this is beyond the scope of this migration article.

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PlanetPress Connect Workflow 8.8 on new computer.

3. The Anoto PenDirector must be installed. It if is not, you can download it from here and
then install it.

Note

Itis strongly recommended that you install the latest version of the PenDirector.
Please use the link provided on the previous line.

Do not get any other version of the PenDirector from the Anoto website, as
they will not have been set up correctly for our Capture solution.

Note

Prior to installation, make sure you unplug the Pen docking station from the USB
port on the computer where you are about to install the Anoto PenDirector.

4. Do the following for both PlanetPress Suite version 7.6 and PlanetPress Connect
Workflow 8.

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).
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2. Select Messenger in the tree list, right click and select Ml Stop from the context

menu.

Note

These steps must be done for both PlanetPress Suite Workflow 7 and
PlanetPress Connect Workflow 8.

5. Copy the file PPCaptureDefault.mdb from this folder on the PlanetPress Suite 7.6
computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder on the new PlanetPress Connect Workflow 8.8 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and
overwrite the existing database.

Note

Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6
a separate database has been used for the patterns alone
(PPCaptureDefault.mdb).

6. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\DocumentManager"
to this folder on the new PlanetPress Connect Workflow 8.8 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".

7. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder on the new PlanetPress Connect Workflow 8.8 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

8. Restart the PlanetPress Connect Workflow 8 Messenger. To do this,

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
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> Service Console).
2. Select Messenger in the tree list, right click and select p Start from the context
menu options.

9. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Known Issues

This page lists important information that applies to PlanetPress Connect 1.8.

Issues with Microsoft Edge browser

The Microsoft Edge browser fails to display web pages when the Workflow's CORS option (in
the HTTP Server Input 2 section) is set to "*". This issue will be resolved in a future release.

Worklfow - "Execute Data Mapping" - Issues with mutliple
PDFs

If a process has a Folder Capture step (but not the first input step) to capture multiple PDFs
within a folder, followed by a Execute Data Mapping step to extract XML files for each PDF,
only the first PDF file will be processed. The workaround is to put the Extract Datamapperin a
Branch, just after the Folder Input. This issue will be fixed in a later release. (SHARED-59752)

Installation Paths with Multi-Byte Characters

When installing the Chinese (Traditional or Simplified) or Japanese versions of Connect, if the
user specifies an alternative installation path containing multi-byte/wide-char characters it can
break some of the links to the Connect-related shortcuts in the Start Menu and cause an error to
appear at the end of the installer. The workaround for the moment is to use the default
installation path. The problem will be addressed in a later release.

Switching Languages

Changing the language using the Window>Preferences>Language Setting menu option
does not currently change all of the strings in the application to the selected language. This is a
known issue and will be fixed in a later release.
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In the meantime we offer the following workaround for anyone who needs to change the
language:

1. Go to the .ini files for the Designer and Server Config:
« C:\Program Files\Objectif Lune\OL Connect\Connect Designer\Designer.ini

o C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.ini

2. Change the language parameter to the required one under Duser.language=en | es | de |
fr|it|ja|ko|pt|tw|zh

Only one of the above language tags should be selected. Once saved, Connect will appearin
the selected language at next start-up.

GoDaddy Certificates

When installing Connect offline, dialogs allow installing the GoDaddy certificates. Most users
should use the default settings and click Next. In some cases, however, this may not work
correctly. For this reason those users should activate Place all certificates in the following
store and then select the Trusted Root Certification Authorities as the target certificate store.

MySQL Compatibility

After installing Connect 1.8 a downgrade to a Connect version earlier than Connect 1.3 orto a
MySQL version earlier than 5.6.25 is not seamlessly possible. This is because the database
model used in Connect 1.3 and later (MySQL 5.6) is different to that used in earlier versions. If
you need to switch to an older version of Connect/ MySQL, itis first necessary to remove the
Connect MySQL Database folder from "%ProgramData%\ConnectiMySQL\data" before
installing the older version.

PostScript Print Presets
The print presets for PostScript were changed from Version 1.1 onwards meaning that some
presets created in Version 1.0 or 1.0.1 may no longer work.

Any PostScript print preset from Version 1.0 that contains the following will not work in Version
1.8: *.all[0].

Any preset containing this code will need to be recreated in Version 1.8.
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Available Printer Models
Note that only the single Printer Model (Generic PDF) will appear on the Advanced page of the

Print Wizard by default.

To add additional printer models click on the settings =% button next to the Model selection
entry box.

Note that the descriptions of some of the printers were updated in version 1.2 meaning that if
you had version 1.n installed, you may find that the same printer style appears twice in the list,
but with slightly different descriptions.

For example the following printer types are actually identical:

« Generic PS LEVEL2 (DSC compliant)
o Generic PS LEVEL2 (DSC)

External Resources in Connect

There are certain limitations on how external resources can be used in Connect. For example if
you want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you
do not want to have a copy of the file saved with the template you need to do the following:

1. The resource must be located where it can be accessed by all Servers/Slaves run as
users. Failure to do this will cause the image to appear as a Red X in the output for all
documents which were merged by engines which could not access the file. The job will
terminate normally and the error will be logged.

2. The file must be referenced via a UNC path e.g.,
file:/llllw2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg

« UNC paths are required because the services will be unable to access mapped
network drives (Windows security feature).

« The engine processing the job will look on the local file system for the direct file
path leading to the “resource not found” issue mentioned above.

Warning

Important Note: The Designer itself and Proof Print do not use processes that run as
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services and they may find local files with non-UNC paths which can lead to the false
impression that the resources are correct.

Using Capture After Installing Workflow 8

If PlanetPress Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7,
Capture can no longer be used within Workflow 7. The plugins are now registered uniquely to
Workflow 8 and the Messenger for Workflow 7 is taken offline. Itis only possible to use Capture
from PlanetPress Connect Workflow 8 thereafter.

Capturing Spool Files After Installing Workflow 8

If PlanetPress Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, the
PlanetPress Suite 7 option to capture spool files from printer queues will no longer function.
The solution is to use PlanetPress Connect Workflow 8 to capture spool files from printer
queues.

Colour Model in Stylesheets
The colour model of colours defined in a stylesheet can sometimes change after editing the
stylesheet. This is a known issue and will be addressed in a subsequent release.

Image Preview in Designer

If in the Windows Internet settings (Connection Settings > LAN configuration) a proxy is
enabled, but "Bypass proxy settings for local addresses" is not checked, the image preview
service, conversion service and live preview tab in the Designer will not work and exhibit the
following issues:

« Images will be shown as 0 size boxes (no red 'X' is displayed)

« Live preview does not progress, and when re-activated reports "browsers is busy"

To fix the issue you must check the "Bypass proxy settings for local addresses" option

Merge\Weaver Engines when Printing

The print operation in the Designer will automatically detect whether the Merge\Weaver
engines are available and display a message for the user to retry or cancel if not. Once the
Merge\Weaver engine becomes available and the user presses retry the print operation will
proceed as normal. This message can also occur in the following circumstances:
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« Ifthe serveris offline and you are not using Proof Print

o On some occasions before the Print Wizard opens

REST Calls for Remote Services

The Server will now accept REST calls for all remote services and will make commands wait
indefinitely until the required engines become available. The Server will log when itis waiting
for an engine and when it becomes available. Note that there is no way to cancel any
commands other than stopping the Server.

Print Content and Email Content in PlanetPress Workflow
In PlanetPress Workflow’s Print Content and Email Content tasks, the option to Update
Records from Metadata will only work for fields whose data type is set to String in the data
model. Fields of other types will not be updated in the database and no error will be raised.
This will be fixed in a later release.

Print Limitations when the Output Server is located on a
different machine

The following limitation may occur when using the Print options from a Designer located on a
different machine to the Output Server:

« The file path for the prompt and directory output modes is evaluated on both the client
AND server side. When printing to a network share it must be available to BOTH the
Designer and Server for the job to terminate successfully.

« The Windows printer must be installed on both the Server and Designer machines.

« When printing via the Server from a remote Designer, the output file remains on the
Server machine. This is remedied by selecting “Output Local” in the Output Creation
configuration

VIPP Output

Some templates set up with landscape orientation are being produced as portraitin VIPP. It can
also sometimes be the case that text and images can be slightly displaced. These are known
issues and will be addressed in a later release of Connect.
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Server Configuration Settings

This chapter describes configuring the PlanetPress Connect Server.

The Connect Sever settings are maintained by the "Connect Server Configuration" utility
tool which is installed alongside PlanetPress Connect.

"Connect Server Configuration" can be launched from the Start Menu, as seen in the
following screen-shot:

Objectif Lune
Mew

E Connect Designer

m Connect Server Configurati..,

v Connect Software Activation

The "Connect Server Configuration™ dialog is separated into individual pages, where each
page controls certain aspects of the software.

The following pages are available:

"Clean-up Service preferences" on page 697

« "Database Connection preferences" on page 700
» "Language Setting Preferences" on page 710
» "Scheduling Preferences" on the next page
« "Merge Engine Scheduling" on page 86
« "Weaver Engine Scheduling" on page 88
« "Server Security Settings" on page 90
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Scheduling Preferences

The scheduling preferences are a way to control precisely how the PlanetPress Connect
services work in the background.

Whenever an operation is scheduled:

o The number of instances to use is determined based on whether the operation is small,
medium or large

« Ifthere is a reserved instance for that type of command available then it will use a
reserved instance

« If no reserved instances are available then any unreserved instance that is available will
be used

« If noinstances are available then the command will be blocked until an appropriate
instance becomes available

Technical

For more information on instances and performance, see Performance Considerations.

Scheduling Properties
« Definitions group: Defines whatis to be considered a Small or Large job. Anything in

between is considered a Medium job.

o Maximum records in a small job: Enter the maximum number of records for a job
to be considered Small.

o Minimum records in a large job: Enter the minimum number of records for a job to
be considered Large.

Note

Changes made to these settings will be applied on the run. Existing jobs will
be taken into account when determining if a job can run.

For instance, if the minimum records for a Large job is increased from 1,000 to
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10,000 and a job of 2,000 records is already running, then this existing job will
now be considered a Medium job.

Likewise, if the minimum records for a Large job is decreased from 10,000 to
5,000 and a job of 7,000 records is already running, then this existing job will
now be considered a Large job.

Additional Scheduling Preferences:

Scheduling Preferences can be applied to the two distinct Engines used in the Connect
production process. The Merge Engine merges the template and the data to create Email and
Web output, or to create an intermediary file for Printed output. The intermediary file is in turn
used by the Weaver Engine to prepare the Print output.

Each of these Engines has its own Scheduling Preference page:

« "Merge Engine Scheduling" below

« "Weaver Engine Scheduling" on page 88

Merge Engine Scheduling

The Merge Engine merges the template and the data to create Email and Web output, or to
create an intermediary file for Printed output. The intermediary file is in turn used by the Weaver
Engine to prepare the Print output.

This preferences page defines how different instances and speed units are attributed to
different jobs when creating Content ltems (Print Content, as well as Web and Email output
Content generation). For information on the terminology and some performance tips, see
Performance Considerations. Note that in this dialog, the use of the word "Engine" is
synonymous to both "Instance" and "Speed Unit" since a single Speed Unit can be used for
each Engine.

Email and Web output is generated only with the Merge Engine and thus their output speed is
limited through this engine. However, the output speed of Print jobs is limited through the
Weaver Engine, so when Print Content is generated through the Merge Engine, its speed is not
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limited. Additionally, you may launch up to 256 engines for Print Content generation, but Email
and Web may only use the number of engines permitted by your license.

Note

Changes made to the following settings will be applied on the run (when the Apply button is
pressed), and do not require the OLConnect _Server service to be restarted.

« Use one internal engine: Check to limit to a single instance of the server. Useful for
computers that run below the recommended System requirements, or demo machines.

« Total Engines Available: Read-only box indicating the current number of engines that
are active or available.

« Engines Launched: Enter the total number of Merge Engines desired on this server.
When changing the number of engines, it is necessary to save this dialog (Apply) to
actually apply the changes.

« Reserved Count: Read-only box indicating the total number of "Reserved" engines, as
setin the Speed unit reservations area below.

« Restart After (mins): Due to a currently un-fixable memory leak in some libraries used by
PlanetPress Connect, itis necessary to restart our engines after a certain amount of time.
The defaultis generally sufficient for all our clients. Only change on the advice of a
technical support agent.

« Parallel Engines/Speed Units per job: This area determines how many engines and
speed units are used for each job that runs through it. In short, if any specific type of job
has more than one parallel speed unit assigned to it, that many engines will be used to
run each of its jobs. This is in fact a multiplier of speed, however itis a divider of the
number of jobs that can be run simultaneously. You cannot attribute more parallel speed
units than what you have available for any specific type of job, and you require at least
that number of floating speed units, or reservations, for the required parallel speed units
required.

« Engine reservations:This area is used to reserve engines specifically for certain types of
jobs. Reserved engines cannot be used by any other type of job.

» Floating: Read-only box indicating the number of floating engines that can be used
for any type of job. This number is equal to the Total Engines Available -
Reservations. For example if 6 engines are launched and 4 are reserved for small
jobs, 2 will be Floating.
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« Small job speed unit reservations: Enter a number of engines reserved for
small print jobs.

« Medium job speed unit reservations: Enter a number of engines reserved for
medium print jobs.

« Large job speed unit reservations: Enter a number of engines reserved for large
print jobs.

« Email engine reservations: Enter a number of engines reserved for Email jobs.
« HTML engine reservations: Enter a number of engines reserved for Web jobs.

« Maximum concurrent engine per type: This area defines the maximum possible
Engines used for any specific job type. The limit needs to be at least the number of
reservations or parallel speed units, whichever is lowest.

o Small print job limit: Enter the maximum number of engines that can run small print
jobs.

e Medium print job limit: Enter the maximum number of engines that can run medium
print jobs.

« Large print job limit: Enter the maximum number of engines that can run large print
jobs.

« Email limit: Enter the maximum number of engines that can run Email jobs.

o Maximum Email limit in license: Read-only box indicating the maximum number of
engines useable for Email content creation.

e HTML limit: Enter the maximum number of engines that can run Web jobs.

o Maximum HTML limit in license: Read-only box indicating the maximum number of
engines useable for Web content creation.

Weaver Engine Scheduling

The Merge Engine merges the template and the data to create Email and Web output, or to
create an intermediary file for Printed output. The intermediary file is in turn used by the Weaver
Engine to prepare the Print output.

This preference page determines the number of Weaver engines launched, as well as their
speed, when generating the output. One single engine can only process a single job at a time,
at the speed available depending on licence and configuration. Note that in this dialog, the use
of the term "Speed Unit" is in relation of the available speed for each engine. One speed unit =
one unit of speed at the maximum speed your licence and number of Performance Packs
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allows. With no Performance Pack, PlanetPress Connect's Weaver engine can generate output
at 500 ppm (pages per minute). Additional Performance Packs increase this base speed per
engine.

Changes made to the following settings will be applied on the run (when the Apply button is
pressed), and do not require the OLConnect_Server service to be restarted.

« Use one internal engine: Check to limit to a single instance of the server. Useful for
computers that run below the recommended system requirements (see "System
Requirements" on page 27) or demo machines.

« Total Engines Available: Read-only box indicating the current number of engines that
are active or available.

« Local Engines Launched: Enter the total number of Weaver Engines desired on this
server. When changing the number of engines, it is necessary to save this dialog (Apply)
to actually apply the changes.

« Speed Units Launched: Read-only box indicating the number of speed units launched.

« Limit in license: Read-only box indicating the maximum number of speed units useable
to produce output.

« Reserved Count: Read-only box indicating the total number of "Reserved" engines, as
setin the Speed unit reservations topic below.

» Restart after (mins): Restarts the Weaver Engines at the selected time interval. If a job is
in progress at that point, the Weaver Engines will await job completion before restarting.

o Parallel engines/speed units per job:

« Parallel engines/speed units per medium job: Enter the number of engines/speed
units that prioritize medium print jobs.

« Parallel engines/speed units per large job: Enter the number of engines/speed
units that prioritize large print jobs.

« Speed unit reservations:

» Floating: Read-only box indicating the number of floating speed units that can be
used for any type of job.

« Small job speed unit reservations: Enter a number of speed units reserved for
small print jobs.

« Medium job speed unit reservations: Enter a number of speed units reserved for
medium print jobs.
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» Large job speed unit reservations: Enter a number of speed units reserved for
large print jobs.

« Maximum speed units:

« Small job limit: Enter the maximum number of speed units that can run small print
jobs.

e Medium job limit: Enter the maximum number of speed units that can run medium
print jobs.

« Large job limit: Enter the maximum number of speed units that can run large print
jobs.

Server Security Settings

This dialog controls the security settings for external applications connecting to the PlanetPress
Connect Server, such as PlanetPress Workflow or scripts communicating through the REST
API.

Warning

It is highly recommended to keep security enabled and change the password on any server that
accessible from the web. If these precautions are not taken, data saved in the server may be
accessible from the outside!

« Enable server security: Enable to add authentication to the REST server.
- When enabled, the same username and password (which cannot be blank) must be
entered in any remote Connect Designer that links to this Server. The Designer username
and password entries can be found under the "Print Preferences" on page 710 sub-
section of the Designer Preferences dialog.
- When disabled, a username and password is not required to make REST request, and
tasks in PlanetPress Workflow do not require them in the Proxy tab. Nor would a
username and password be required on any remote Connect Designer that links to this
Server.

« Administrator's username: Enter the username for the server security. The default
username is ol-admin.

« Administrator's password: Enter a password for the server security. The default
password is secret.
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« Confirm password: Re-enter the password for the server security.

« Default session length (min): Enter a session time (in minutes) that the authentication
stays valid for the requested process. This can reduce the number of requests to the
server since an authentication request is not necessary during the session.

Uninstalling

This topic provides some important information about uninstalling (removing) PlanetPress
Connect1.8.

To uninstall PlanetPress Connect select the application from within the Add/Remove programs
option under the Control Panel. This will start the PlanetPress Connect Setup Wizard in
uninstall mode.

Note

The PlanetPress Connect Setup Wizard might take some seconds to appear.

Important Note: Stop any active Anti-Virus software before
uninstalling Connect.

Some anti-virus systems are known to block the uninstallation of MySQL datafiles, as well as
blocking the uninstallation of the MySQL database application itself. Therefore itis highly
recommended that any anti-virus application be stopped prior to uninstalling PlanetPress
Connect, as otherwise the Connect uninstallation might not work correctly.

Impacts upon other Applications and Services

« The Uninstall will terminate the installed Server / MySQL service(s)

» The following applications / services should be stopped in a controlled fashion, before
running the PlanetPress Connect Uninstall:

1. PlanetPress Connect

2. Connect products on remote systems which refer to this MySQL database.
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3. Any Connect Workflow using PlanetPress Connect plugins which connect to this
server.

Uninstallation Wizard

The uninstallation is done by running the PlanetPress Connect Setup Wizard in uninstall mode.
The Wizard consists of the following pages:

1. PlanetPress Connect Setup: An information page, listing what will be uninstalled, and
also warning about impacts upon running Applications and Services.

2. Data Management: A page that provides options for backing up or deleting Connect
data. Selections are as follows:

« Delete Connect Workspace Data: Check this box to delete the Workspace data for
the current user, or for selected users (as determined by the "Select Users" button)

- Backup Connect Workspace Data for all specified Users: Check this box
to backup the Workspace data for the specified users (as previously
determined) into a compressed ZIP file (whose location can be customized),
before deletion of the full Workspace data.

« Delete MySQL objectlune Data: Check this box to delete the MySQL database
installed with PlanetPress Connect.

o Backup MySQL Date: If the deletion check box is selected, this option
appears to allow backing up the MySQL database to a customizable location,
prior to uninstallation.
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General information

Connect consists of visible and invisible parts. The invisible parts process the Connect job to
provide the actual output. They are introduced to you in the topic: "Connect: a peek under the
hood" below.

For a list of all file types used in Connect, see: "Connect File Types" on page 98.

You can find additional information that complements the user manuals, such as error codes
and frequently asked questions about PlanetPress Connect, in the Knowledge base.

Connect: a peek under the hood

Connect consists of visible and invisible parts.

The visible parts are the tools that you use to create templates, data mapping configurations,
and print presets (the Designer/DataMapper), and to create Workflow configurations (the
Workflow configuration tool).

The invisible parts process the Connect job to provide the actual output. This topic introduces
you to those parts.

Here's a simplified, graphical representation of the architecture of PlanetPress Connect. The
components described below are all located in the 'Server' part.

Page 93

PlanetPress.
Connect


http://help.objectiflune.com/en/kb-connect/#Welcome.htm

Workflow Server Connect Server Server

Data
Mapping
Connect
Database

Content
Watch Creation

Service HTTP

OL Connect Server

: Service 108
Service Creation

Messenger Qutput Weaver File Store
Service Creation engine(s)

Workfl Workflow Data Mapping Job = =
e Configuration Configurations Presets SRS
Service Server

Lorerls et Output Configuration
srmpletes Presets

Workflow Connect

Configuration Designer
Tool (DataMapper/
o8 Template Designer)

The Workflow server

The Workflow server (also referred to as the 'Watch service') executes processes
independently, after a Workflow configuration has been uploaded and the services have been
started. The Workflow server can run only one configuration at a time.

Watch

Service HTTP

Service

Messenger
Service

There are a number of services related to Workflow. The Messenger service, for example,
receives the files sent to Workflow from the Designer and the Workflow configuration tool.
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The Workflow Service Console lets you start and stop the different services, except the
Connect server, and see their log files (see Workflow Service Console).

Note that Workflow isn't strictly limited to Connect functionality. It was originally developed as
part of the PlanetPress Suite. Many of the plugins in the Workflow configuration tool are older
than Connect; they were left in for compatibility reasons, even though they aren't all useful or
usable within Connect. However, the Connect plugins cannot be used with the PlanetPress
Suite software.

The Connect server

As opposed to the Workflow server, the Connect server was designed to be used only with
Connect. The Connect server performs several different tasks, all of which are related to
Connect content and content management:

« It communicates with the Workflow service (with the Connect plugins, specifically) and
with the Designer when output is generated from the Designer.

« It creates records (by extracting data from a data source using a data mapping
configuration), and jobs.

« It communicates with the engines (see below) in order to make them create content items
and output (spool) files.

Data
Mapping

Connect
Content Merge Database
Creation engine(s) .

OL Connect Server

Service .

Creation
Qutput Weaver File Store
Creation engine(s)

The Connect server is one of the components that has to be installed with Connect (see
"Installation Wizard" on page 35).

In the Workflow Configuration Tool preferences you have to set the OL Connect server settings
to enable Workflow to communicate with the server (see Workflow Preferences).
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The Connect Server Configuration tool lets you change the settings for the Connect server,
the engines and the service that cleans up the database and the file store. These settings can
also be made in the preferences of the Designer.

The Connect database

The Connect database is the database back-end used by Connect itself when processing jobs.
It can be either the MySQL instance provided by the Connect installer, or a pre-existing
(external) instance (see "Database Considerations" on page 17).

All generated items (records, content items etc.) are stored in this database , for the next task in
the process, as well as for future use, making it possible to commingle Print jobs, for example.

Note

Email content items are not stored in the Connect database.

A clean-up of the database is performed at regular intervals in accordance with the settings
(see "Clean-up Service preferences" on page 697).

The File Store

Connect has its own File Store which it uses for transient files.
The Clean-up service takes care of removing obsolete files when those files are not marked as
permanent (see "Clean-up Service preferences" on page 697).

Tip

As of version 1.8, the File Store has become accessible for customer implementations. The
Workflow configuration tool implements three tasks that allow you to Upload, Download and
Delete files in the Connect File Store. The files can be accessed through the REST API, which

means web portals could potentially access the files directly without having to go through a
Workflow process.
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The engines

Merge engine/s. A merge engine merges data with a template using the scripts in the template,
in order to create (Print,Email or Web) content items.

The number of merge engines is configurable. By default, only one merge engine is used, but
this number can be increased depending on the capacity of the machine that runs the solution
(see "Performance Considerations" on page 25).

Weaver engines. The Weaver engines create Print output from Print content items. It takes the
settings made in Print presets or in the Print Wizard into account. It also helps the data mapping
engine by preparing any paginated input data.

The number of Weaver engines is configurable as well (see "Weaver Engine Scheduling" on
page 88).

Speed units (parallels)

The number of 'speed units' is the maximum number of engines that can work in parallel, which
is why they are also called 'parallels'. The output speed of all speed units together is limited to
a certain number of output items (web pages, emails, or printed pages) per minute.

How many speed units you have and what the maximum total output speed will be is
determined by your licence and any additional Performance Packs you might have.

There is one important twist: when generating Print output, the limitimposed by the number of
speed units, only applies to the Weaver engines; when creating Email or Web output, the limit
applies to the Merge engines only (the Weaver engine is not involved). Nevertheless, in
situations where Print and Email or Web output are being created at the same time, all engines,
regardless of their type, count towards the maximum number of speed units.

Each engine needs at least one speed unit. However, since the number of engines is
configurable, and since small, medium and large jobs may run concurrently, the number of
engines in use may not match the number of available speed units. When there are more speed
units than there are engines in use, the Connect server distributes the speed units and the
maximum output speed to the engines proportionally.

The REST API

The Connect server receives REST commands (see The Connect REST API CookBook),
normally either via the Workflow service or from the Designer. This design allows the Connect
functionality to be used by other applications. The server forwards the commands to the
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appropriate engine and returns the results to the caller. The results are the id's of the items
(records, content items, job etc.) that are stored in the Connect database (see below). All
Connect tasks except the Create Web Content task integrate the results in the Metadata in
Workflow.

The figure below shows the communication between Connect tasks and the Connect serverin
a Print process.

Workflow Server Connect Server
1 .

/ a E;ﬁ;%lﬁd%ﬂ;mg 1\ REST command: create records Dat?

results: record ID's, record set ID Mapping
Create Print Ca :

@ e ot < REST command: create content ((:Ionttl?nt
results: content items ID’s, content set ID fEaticn

Create Job REST command: create job (= item collection) lob
OLCS-job-creation. OL-jobpre: | results job ID’s, job set ID Creation

Create Dutput REST command: create output (spool) file Output

Create PostSCript - .
K L2 0L outputpreset resulfs: output 1D Lizrtlen

Printing and emailing from the Designer

To print or send email from within the Designer, the Connect service has to be running. The
service is started automatically when the Designer starts, but it may not be running if the
Connect Server and the Designer are installed on different computers. The Connect service
can be found on the Services tab in the Task Manager.

For a proof print the Connect server is not used. Proof printing is always done locally, by the
Designer.

Connect File Types

This article describes the different File Types that are related to PlanetPress Connect and its
different modules. These are files that are generally transferable between machines, can be
sent via email or other means.

« .OL-template: A Designer Template file, including up to 3 contexts. Is linked to a data
mapping configuration by default, but not necessarily.

Page 98

PlanetPress.
Connect



.OL-datamapper: A Data Mapping Configuration file, which can include sample data
(excluding database source files such as mySQL, oracle, etc).

« .OL-datamodel: A data model file which can be imported or exported into either a data
mapping configuration or a template. Contains a list of fields and their data type (date,
currency, string, etc).

« .OL-jobpreset: A job preset file, used when generating a job (ready for output) from
Designer or through automation (Create Job task). Does sorting, splitting, adding
metadata fields.

« .OL-outputpreset: An output preset file, used to generate the actual print output in the
appropriate format (pcl, afp, pcl, ipds, pdf, etc). Includes print settings such as imposition
(n-up, cut & stack), inserter marks, tray settings, etc.

« .OL-package: A transfer file used to package one or many of the above files (the data
model being part of both the template and the data mapping configuration). Created by
using the File -> Send to Workflow dialog, and choosing "File..." in the Destination box.

e .OL-script: One or more designer "scripts". Can be imported or exported from the Scripts
pane in Designer when a template is open.

« .OL-printerdef: A Printer Definition File. Used by the Output Preset to determine what
type of output to produce. These are generated by an internal application thatis not
currently distributed outside of OL, but the definition files themselves can be provided.

e .OL-workflow: A Workflow file used by PlanetPress Workflow. Equivalent to .pp7 files
(they are, in fact, essentially the same format), containing the processes and such used by
Workflow.
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The DataMapper Module

The DataMapper is the tool to create a data mapping configuration.

A data mapping configuration file contains the information necessary for data mapping: the
settings to read the source file (Delimiter and Boundary settings), the data mapping workflow
with its extraction instructions ('Steps'), the Data Model and any imported data samples.

Data mapping configurations are used to extract data and transpose that data into a format that
can be shared amongst different layouts and outputs created with the Connect Designer and
Workflow.

The original data, located in a file or database outside of Connect, is called a data source.

The first step in the data extraction process is making settings for the input data (see "Data
source settings" on page 115), including boundaries for each record inside the data sample.
When you define the boundaries, you are actually defining a series of records inside your data
sample file.

After configuring these settings you can start working on the logic to extract data from each of
those records. You need to identify and extract data from each record. To achieve this, you will
create a data mapping workflow, consisting of multiple steps (extractions, loops, conditions and
more) (see "Data mapping workflow" on page 113 and "Extracting data" on page 118).

When this process is complete, the resultis a Data Model. This model contains the necessary
information to add variable data to Connect Designer templates. (see "The Data Model" on
page 151 for more information). It has a generic format with an emphasis on content, free from
any restrictions imposed by the file types or the origin of the data. This allows a same layout or
output to be populated with data from different sources and formats without the need to modify
it.

DataMapper basics

Connect’s DataMapper lets you build a data mapping workflow to extract data from a variety of
data sources. The data mapping workflow consists of multiple 'steps' which process and extract
data from each record of a data source and store itin a new, extracted record set. The data
mapping workflow is saved in a data mapping configuration.

1. Create a new data mapping configuration.
Run the Designer and start creating a data mapping configuration by selecting a data
source. See "Data mapping configurations" on the next page.
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2. Configure settings for the data source.
The data source can be a file (CSV, PDF, TXT, XML) or a particular database. Configure
how the data source is read by the DataMapper and create a record structure. See "Data
source settings" on page 115.

3. Build the data mapping workflow.
A data mapping workflow always starts with the Preprocessor step and ends with the
Postprocessor step. You can add as many steps as you like and edit the Data Model of
the extracted data as required. See "Data mapping workflow" on page 113 and "The Data
Model" on page 151.

What's next?

Use the data mapping configuration in the Designer module to create templates for
personalized customer communications. To learn more, see "The Designer" on page 302.

In Workflow, a data mapping configuration can be used to extract data. The extracted data can
then be merged with a Designer template to generate output in the form of print, email or a web
page. See Workflow and Connect tasks in Workflow.

Data mapping configurations

A data mapping configuration file contains the information necessary for data mapping: the
settings to read the source file (Delimiter and Boundary settings), the data mapping workflow
with its extraction instructions ('Steps'), the Data Model and any imported data samples.

Data mapping configurations are used in the Designer to help add variable data fields and
personalization scripts to a template. In fact, only a Data Model would suffice (see
"Importing/exporting a Data Model" on page 153). The advantage of a data mapping
configuration is that it contains the extracted records to merge with the template, which lets you
preview a template with data instead of field names.

Itis also possible to generate output of a data mapping configuration directly from the Designer
(see "Generating output" on page 953).

Ultimately data mapping configurations are meant to be used by the Execute Data Mapping
task in Connect Workflow processes, to extract data from a particular type of data file. Typically
the extracted data is then merged with a template to generate output in the form of print, email
and/or a web page. To make this happen, the data mapping configuration as well as the
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template and any print presets have to be sent to Workflow; see "Sending files to Workflow" on
page 309.

Note

AFP input requires the CDP library. The library licence allows PlanetPress Connect to run up to 4
instances of that library on a given machine at a given time.

Creating a new data mapping configuration

A new data mapping configuration can be made with or without a wizard. When you open a
data file with a DataMapper wizard, the wizard automatically detects a number of settings. You
can adjust these settings. Next, the wizard automatically extracts as many data fields (or
metadata, in case of a PDF/VT or AFP file) as it can, in one extraction step.

Without a wizard you have to make the settings yourself, and configure the extraction workflow
manually.

Note

The DataMapper doesn’t use the data source directly, rather it uses a copy of that data: a data

sample. Although the data sample is a copy, it is updated each time the data mapping
configuration is opened or whenever the data sample is selected.
More samples can be added via the Settings pane; see "Data samples" on page 211.

From a file
To start creating a data mapping configuration without a wizard, first select the data file. There

are two ways to do that: from the Welcome screen and from the File menu.

« From the Welcome screen
1. Click Create a New Configuration.

2. From the From a file pane and select a file type (Comma Separated Values or
Excel (CSV/XLSX/XLS), MS-Access, PDF/VT, Text or XML).

3. Click the Browse button and open the file you want to work with (for a database,
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you may have to enter a password).
4. Click Finish.
o From the File menu
1. Click the File menu and select New.

2. Click the Data mapping Configuration drop-down and select Files and then the
file type (Comma Separated Values or Excel (CSV/XLSX/XLS), MS-Access,
PDF/N/T, Text or XML).

3. Click Next.
4. Click the Browse button and open the file you want to work with.
5. Click Finish.

Note

« Excel files saved in "Strict Open XML" format are not supported yet.

o PCL and PostScript (PS) files are automatically converted to PDF format. When
used in a production environment (a Connect Workflow process) this may influence
the processing speed, depending on the available processing power.

After opening the file, you have to make settings for the input data (see "Data source settings"
on page 115). Then you can start building the data extraction workflow.

With a wizard

Data mapping wizards are available for PDF/N/T, AFP, XML, CSV and database tabular files,
because these files are structured in a way that can be used to automatically set record
boundaries.

The wizard for PDF/VT and AFP files cannot extract data, only metadata. After opening such a
file with the wizard, you can build the data extraction workflow.

The other wizards use the Extract All step to extract data, but they cannot create detail tables,
so they are less suitable for files from which you want to extract transactional data.

There are two ways to open a data file with a wizard: from the Welcome screen or from the File
menu.
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¢« From the Welcome screen

1. Open the PlanetPress ConnectWelcome page by clicking the ¢ icon at the top right
or select the Help menu and then Welcome.

2. Click Create a New Configuration.

3. From the Using a wizard pane, select the appropriate file type.
o From the File menu

1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select the appropriate file type.

The steps to take with the wizard depend on the file type. See:

"Using the wizard for CSV and Excel files" on page 106

« "Using the wizard for databases" on page 108

« "Using the wizard for PDF/VT and AFP files" on page 111
» "Using the wizard for XML files" on page 112

Generating a counter

Instead of creating a data mapping configuration for a certain type of data file, you may create a
data mapping configuration that only contains a series of sequential numbers. This is a solution
if, for instance, you need to create sequential tickets or anything that has an ID that changes on
each record.

Note

You can’t join this configuration to another data file. It is just a counter to be applied on a static
template.

To generate a counter:

¢ From the Welcome screen

1. Open the PlanetPress ConnectWelcome page by clicking the ¢ icon at the top right
or select the Help menu and then Welcome.
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2. Click Create a New Configuration.

3. From the Using a wizard pane, select Generate counters.
o From the File menu

1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select Generate counters.

You can set the following parameters:

« Starting Value: The starting number for the counter. Defaults to 1.

« Increment Value: The value by which to increment the counter for each record. For
example, an increment value of 3 and starting value of 1 would give the counter values of
1,4,7,10,[..]

« Number of records: The total number of counter records to generate. This is not the end
value but rather the total number of actual records to generate.

« Padding character: Which character to add if the counter's value is smaller than the
width.

o Width: The number of digits the counter will have. If the width is larger than the current
counter value, the padding character will be used on the left of the counter value, until the
width is equal to the set value. For example for a counter value of "15", a width of "4" and
padding character of "0", the value will become "0015".

« Prefix: String to add before the counter, for example, adding # to get #00001. The prefix
length is not counted in the width.

« Suffix: String to add after the counter. The suffix length is not counted in the width.

Opening a data mapping configuration

To open an existing data mapping configuration, in the Menus, select File > Open. Make sure
that the file type is either DataMapper files or Connect files. Browse to the configuration file to
open, selectitand click Open.

Alternatively, click on File > Open Recent to select one of the recently opened configuration
files.
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Saving a data mapping configuration

A Data Mapping Configuration file has the extension .OL-datamapper. The file contains the
settings, the extraction workflow ('Steps'), the Data Model and the imported Data Samples
(excluding database source files such as mySQL, oracle, etc).

To save a data mapping configuration:

« In the Menus, click on File > Save, or click on Save As to save a copy of a data mapping
configuration under a different name.

« In the Toolbars, click the Save button.

If the data mapping configuration has not been saved before, you have to browse to the location
where the data mapping configuration should be saved and type a name, then click Save.

Using the wizard for CSV and Excel files

The DataMapper wizard for CSV and Excel files helps you create a data mapping configuration
for such files. The wizard automatically detects delimiters and extracts all data in one extraction
step.

The wizard interprets each line in the file as a record. If your data file contains transactional
data, you will probably want more lines to go in one record and put the transactional data in
detail tables.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 102).

There are two ways to open a CSV file or Excel file with a wizard: from the Welcome screen or
from the File menu.

¢« From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the g icon at the top
right, or select the Help menu and then Welcome.

2. Click Create a New Configuration.
3. From the Using a wizard pane, select CSV/XLSX/XLS.
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4. Click the Browse button and open the file you want to work with.
5. Click Next.

o From the File menu
1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select From CSV/XLSX/XLS
File.

3. Click Next.
4. Click the Browse button and open the file you want to work with.
5. Click Next.

After selecting the file, take a look at the preview to ensure that the file is the right one and the
encoding correctly reads the data. Click Next.

For an Excel file you can indicate whether or not the first row contains field names, and from
which sheet the data should be extracted.

Note

Excel files saved in "Strict Open XML" format are not supported yet.

Fora CSV file the will display the different settings it has detected, allowing you to change
them:

« Encoding: Defines which encoding is used to read the file.
« Separator: Defines which character separates each field in the file.
« Comment Delimiter: Defines which character starts a comment line.

« Text Delimiter: Defines which character surrounds text fields in the file. Separators and
comment delimiters within text are not interpreted as separator or delimiter; they are seen
as text.

« Ignore unparseable lines: Ignores any line that does not correspond to the settings
above.
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« First row contains field names: Uses the first line of the CSV as headers, which
automatically names all extracted fields.
Verify that the data are read properly.

Finally click Finish. All data fields are automatically extracted in one extraction step.

Using the wizard for databases

The DataMapper wizard for database files helps you create a data mapping configuration for a
database file. The wizard extracts the data in one extraction step.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 102).

Opening a database file with a wizard

There are two ways to open an XML file with a wizard: from the Welcome screen or from the
File menu.

« From the Welcome screen

1. Open the PlanetPress ConnectWelcome page by clicking the ¢ icon at the top right
or select the Help menu and then Welcome.

Click Create a New Configuration.

From the Using a wizard pane, select Database.

> N

Use the drop-down to select the database type.
5. Click Next.
o From the File menu
1. In the menu, click File > New.
Click the Data mapping Wizards drop-down and select From databases.
Click Next.
Use the drop-down to select the database type.
Click Next.

A R
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Wizard settings for a database file

After opening a database file with a wizard there are a number of settings to make, depending
on the database type (see below).

On the last page of the dialog, click Finish to close the dialog and open the actual data
mapping configuration.

MySQL, SQL Server or Oracle

« Server: Enter the server address for the database.
« Port: Enter the port to communicate with the server. The default port is 3306.

+« Database name: Enter the exact name of the database from where the data should be
extracted.

« User name: Enter a user name that has access to the server and specified database. The
user only requires Read access to the database.

« Password: Enter the password that matches the user name above.

« Table name: The selected database is a set of related tables composed of rows and
columns corresponding respectively to source records and fields. Select a table from
which you want to extract data.

« Encoding: Choose the correct encoding to read the file.
Microsoft Access

o Password: Enter a password if one is required.

« Table name: The selected database is a set of related tables composed of rows and
columns corresponding respectively to source records and fields. Select a table from
which you want to extract data.

« Encoding: Choose the correct encoding to read the file.
ODBC Data Source

« ODBC Source: Use the drop-down to select an ODBC System Data Source. This must
be a data source that has been configured in the 64-bit ODBC Data Source Administrator,
as PlanetPress Connect is a 64-bit application and thus cannot access 32-bit data
sources.
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» This ODBC source is MSSQL.: Check this option if the ODBC source is MSSQL (SQL
Server). The options below appear under MSSQL-ODBC advanced configuration:

« Windows authentication: Select to use the Windows user name and password that
are used by the Connect Service.

+ SQL Server authentication: Select to use the User name and Password set below
to connect to the SQL Server:

+ User name: Enter the SQL Server user name.

« Password: Enter the password for the above user name.

JDBC

Note

Since JDBC can connect to multiple types of databases, a specific database driver and path to
this driver's JAR file must be specified.

« JDBC Driver: Use the drop-down to select which JDBC Driver to use for the database
connection.

« JAR file path: Enter a path to the JAR file that contains the appropriate driver for the
database.

+ Server: Enter the server address for the database server.

+« Database name: Enter the exact name of the database from where the data should be
extracted.

« User name: Enter a user name that has access to the server and specified database. The
user only requires Read access to the database.

« Password: Enter the password that matches the user name above.

« Advanced mode: Check to enable the Connection String field to manually enter the
database connection string.

« Connection string: Type or copy in your connection string.
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Using the wizard for PDF/VT and AFP files

The pages in PDF/N/T and AFP files can be grouped on several levels. Additional information
can be attached to each level in the structure. The structure and additional information are

stored in the file's metadata.
The DataMapper wizard for PDF files lets you select a level to trigger the start of a new record
and it also enables you to extract the additional information from the metadata. You can extract

data from the content afterwards.

Tip
To extract information from the metadata in the extraction workflow itself, you have to create a
JavaScript extraction (see "Using scripts in the DataMapper" on page 255 and "extractMeta()" on

page 277).

If the PDF doesn't contain any metadata, each page is a new record - in other words, a
boundary is set at the start of a new page -, which is exactly what happens when you open the
file without a wizard.

You can open a PDF/VT file with a wizard using the Welcome screen or the File menu.

« From the Welcome screen

1. Open the PlanetPress ConnectWelcome page by clicking the ¢ icon at the top right
or select the Help menu and then Welcome.

2. Click Create a New Configuration.
3. From the Using a wizard pane, select PDF/VT.

4. Click the Browse button and open the PDF/VT file you want to work with. Click
Next.

¢« From the File menu
1. In the menu, click File > New.
. Click the Data mapping Wizards drop-down and select From PDF/VT or AFP.

2
3. Click Next.
4

. Click the Browse button and open the PDF/VT file you want to work with. Click
Next.
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After selecting the file, select the following options in the Metadata page:

« Metadata record levels: Use the drop-down to select what level in the metadata defines
a record.

« Field List: This list displays all fields on the chosen level and higher levels in the PDF/NT
metadata. The right column shows the field name. The left column displays the level on
which itis located. Check any field to add it to the extraction.

Click Finish to close the dialog and open the actual Data Mapping configuration.
On the Settings pane, you will see that the boundary trigger is set to On metadata. The
selected metadata fields are added to the Data Model.

Using the wizard for XML files

The DataMapper wizard for XML files helps you create a data mapping configuration for an
XML file. The wizard lets you select the type of node and the trigger that delimit the start of a
new record. Next, the wizard extracts the data in one extraction step.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 102).

There are two ways to open an XML file with a wizard: from the Welcome screen or from the
File menu.

« From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the g icon at the top right
or select the Help menu and then Welcome.

2. Click Create a New Configuration.

3. From the Using a wizard pane, select XML.

4. Click the Browse button and open the XML file you want to work with. Click Next.
o From the File menu

1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select From XML File.
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3. Click Next.
4. Click the Browse button and open the XML file you want to work with. Click Next.

After selecting the file, you have to set the split level and trigger type:

« XML Elements: This is a list of node elements that have children nodes. Select the level
in the data that will define the source record.

» Trigger: select On element to create a record in the Data mapping for each occurrence of
the node element selected in the XML Elements field, or select On change to create a
record each time the element is different. (Check the option to include attributes in the list
of content items that can trigger a boundary.)

Note

The DataMapper only extracts elements for which at least one value is defined in the file. Attribute
values are not taken into account.
Attribute values (prefixed with an @ sign in the Data Viewer) are not extracted automatically.

Click Finish to close the dialog and open the data mapping configuration.

Data mapping workflow

A data mapping workflow is a series of extraction instructions, called steps. These steps
process and extract the data from the source and store them in records, of which the structure is
determined in the Data Model (see "The Data Model" on page 151). Together with the data
source settings, the Data Model, and the sample data, this is what makes a data mapping
configuration (See "Data mapping configurations" on page 101).

The data mapping workflow is shown on the Steps pane at the left (see "Steps pane" on
page 213).

Creating a data mapping workflow

A data mapping workflow always starts with the Preprocessor step and ends with the
Postprocessor step. These steps allow the application to perform actions on the data file itself
before itis handed over to the data mapping workflow ("Preprocessor step" on page 140) and
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after the Data Mapping workflow has completed ("Postprocessor step" on page 150).

When you create a new data mapping configuration, these steps are added automatically, but
they don't actually do anything until you configure these steps.

In between the Preprocessor and Postprocessor step, the workflow can contain as many steps
as needed to extract the required data.

Adding steps

Extracting data is the main way to build a data mapping workflow; see "Extracting data" on
page 118.

Extract steps, Condition steps and Repeat steps can be added after selecting data in the Data
Viewer.

All steps can be added via the Steps pane:

1. In the extraction workflow on the Steps pane, select the step after which to add the new
step.

2. Right-click on the Steps pane and select Add a Step; then select one of the step types.
Editing steps
The properties of each step in the extraction workflow become visible in the Step properties

pane when you select that step in the Steps pane.

The name of each step is shown in the Steps pane. You can change it under Description in
the Step properties pane.

The other properties are different per step type; see "Steps" on page 140.

Rearranging steps

To rearrange steps, simply drag & drop them somewhere else on the dotted line in the Steps
pane.

Alternatively you can right-click on a step and select Cut Step or use the Cut #£ button in the
Toolbar. If the step is Repeat or Condition, all steps under it will also be placed in the
clipboard. To place the step at its destination, right-click the step in the position before the
desired location and click Paste Step, or use the Paste [&] button in the toolbar.

Keep in mind that steps may influence each other, so you may have to move other steps as well
to ensure that the workflow continues to function properly. In a Text file for example, an Extract
step may need a Goto step before it that moves the cursor to a certain place in the source data.
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Deleting steps

To delete a step, right-click on it in the Steps pane and select Delete Step.

Testing the extraction workflow

The extraction workflow is always performed on the current record in the data source. When an
error is encountered, the extraction workflow stops, and the field on which the error occurred
and all subsequent fields will be greyed out. Click the Messages tab (next to the Step
properties pane) to see any error messages.

To test the extraction workflow on all records, you can:

+ Click the Validate All Records toolbar button.

+ Select Data > Validate Records in the menu.

If any errors are encountered in one or more records, an error message will be displayed. Errors
encountered while performing the extraction workflow on the current record will also be visible
on the Messages tab.

Data source settings

After opening a data file you have to make a number of settings to make sure that the source
data is interpreted and grouped the way you want. These settings are found on the Settings
pane at the left.

« Input Data settings help the DataMapper read the data source and recognize data
correctly.

« Boundaries mark the start of a new record. They let you organize the data, depending on
how you want to use them.

« Data format settings define how dates, times and numbers are formatted in the data
source.

Input data settings (Delimiters)

The Input Data settings (on the Settings pane at the left) specify how the input data must be
interpreted. These settings are different for each data type. For a CSV file, for example, it is
important to specify the delimiter that separates data fields. PDF files are already delimited
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naturally by pages, so the input data settings for PDF files are interpretation settings for text in
the file.
For an overview of all options, see: "Input Data" on page 203.

For a CSV File

Ina CSV file, data is read line by line, where each line can contain multiple fields, separated by
a delimiter. Even though CSV stands for comma-separated values, fields may be separated
using any character, including commas, tabs, semicolons, and pipes.

The text delimiter is used to wrap around each field just in case the field values contain the
field separator. This ensures that, for example, the field “Smith; John” is not interpreted as two
fields, even if the field delimiter is the semicolon.

For an explanation of all the options, see: "CSV file Input Data settings" on page 203.

For a PDF File

PDF files have a clear and unmovable delimiter: pages. So, the Input Data settings are not
used to set delimiters. Instead, these options determine how words, lines and paragraphs are
detected when you select content in the PDF to extract data from it.

For an explanation of all the options, see: "PDF file Input Data settings" on page 204.

For a database

Databases all return the same type of information. Therefore the Input Data options for a
database refer to the tables inside the database. Clicking on any of the tables shows the first
line of the data in that table.

If the database supports stored procedures, including inner joins, grouping and sorting, you can
use custom SQL to make a selection from the database, using whatever language the database
supports.

For an explanation of all the options, see: "Database Input Data settings" on page 204.

For a text file

Because text files have many different shapes and sizes, there are a lot of input data settings
for these files. You can add or remove characters in lines if it has a header you want to get rid
of, or strange characters at the beginning of your file, for example; you can set a line width if you
are still working with old line printer data; etc.

It is important that pages are defined properly. This can be done either by using a set number of
lines or using a text (for example, the character “P”), to detect on the page. Be aware that this is
not a Boundary setting; it detects each new page, not each new record.

For an explanation of all the options, see: "Text file Input Data settings" on page 205.
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For an XML file

XML is a special file format because these file types can have a theoretically unlimited number
of structure types. The input data has two simple options that basically determine at which node
level a new record is created. You can either select an element type, to create a new delimiter
every time that element is encountered, or choose to use the root node. If there is only one top-
level element, there will only be one record before the Boundaries are set.

Note

The DataMapper only extracts elements for which at least one value is defined in the file.

See also: "XML File Input Data settings" on page 206.

Record boundaries

Boundaries are the division between records: they define where one record ends and the next
record begins. Using boundaries, you can organize the data the way you want.

You could use the exact same data source with different boundaries in order to extract different
information. If, for instance, a PDF file contains multiple invoices, each invoice could be a
record, or all invoices for one customer could go into a single record.

Keep in mind that when the data is merged with a template, each record generates output

(print, email, web page) for a single recipient.

To seta boundary, a specific trigger must be defined.

The trigger can be a natural delimiter between blocks of data, such as a row in a CSV file or a
page in a PDF file.

It can also be something in the data that is either static (for example, the text "Page 1 of" in a
PDF file) or changing (a customer ID, a user name, etc).

To define a more complex trigger you could write a script (see "Setting boundaries using
JavaScript" on page 257).

A new record cannot start in the middle of a data field, so if the trigger is something in the data,
the boundary will be set on the nearest preceding natural delimiter. If for instance in a PDF file
the text "Page 1 of" is used as the trigger, the new record starts at the page break before that
text.

For an explanation of all Boundaries options per file type, see "Boundaries" on page 207.
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Data format settings

By default the data type of extracted data is a String, but each field in the Data Model can be set
to contain another data type (see "Data types" on page 168). When that data type is Date,
Number or Currency, the DataMapper will expect the data in the data source to be formatted in
a certain way, depending on the settings.

The default format for dates, numbers and currencies can be set in three places: in the user
preferences, in the data source settings, and per field in the Data Model.

By default, the user preferences are set to the system preferences. These user preferences
become the default format values for any newly created data mapping configuration. To change
these preferences, select Window > Preferences > DataMapper > DataMapper default

format (see "Datamapper preferences" on page 703).

Data format settings defined for a data source apply to any new extraction made in the current
data mapping configuration. These settings are made on the Settings pane; see "Settings
pane" on page 203.

Settings for a field that contains extracted data are made via the properties of the Extract step
that the field belongs to (see "Setting the data type" on page 159). Any format settings specified
per field are always used, regardless of the user preferences or data source settings.

Note

Data format settings tell the DataMapper how certain types of data are formatted in the data
source. They don't determine how these data are formatted in the Data Model or in a template. In
the Data Model, data are converted to the native data type. Dates, for example, are converted to a

DateTime object in the Data Model, and will always be shown as "year-month-day" plus the time
stamp, for example: 2012-04-11 12.00 AM.

Extracting data

Data are extracted via Extraction steps into fields in the Data Model. This topic explains how to
do that. Fields can also be filled with other data: the result of a JavaScript or the value of a
property. To learn how to do that, see "Fields" on page 155.
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Before you start

Data source settings

Data source settings must be made beforehand, not only to make sure that the data is properly
read but also to have it organized in a record structure that meets the purpose of the data
mapping configuration (see "Data source settings" on page 115). Itis important to set the
boundaries before starting to extract data, especially transactional data (see "Extracting
transactional data" on page 124). Boundaries determine which data blocks - lines, pages,
nodes - form a record in the source data. Data that are located in different records cannot be put
into the same record in the record set that is the result of the extraction workflow.

Preprocessor step

The Preprocessor step allows the application to perform actions on the data file itself before itis
handed over to the Data Mapping workflow. In addition, properties can be defined in this step.
These properties may be used throughout the extraction workflow. For more information, see
"Preprocessor step" on page 140.

Adding an extraction

In an extraction workflow, Extract steps are the pieces that take care of the actual data
extractions.
To add an Extract step:

1. Inthe Data Viewer pane, select the data that needs to be extracted. (See "Selecting data"
on page 122.)

2. Choose one of two ways to extract the selected data.

« Right-click on the selected data and select Add Extraction from the contextual
menu.

Note

For optimization purposes, itis better to add data to an existing Extract step
than to have a succession of extraction steps. To do that, select that step on
the Steps pane first; then right-click on the selected data and choose Add

Extract Field.

Page 119

PlanetPress.
Connect



« Alternatively, drag & drop the selected fields into the Data Model pane.

Tip

In a PDF or Text file, use the Drag icon %3 to drag selected data into the
Data Model.

With this method, a new Extract step will only be added to the extraction workflow
when no Extract step already present on the Steps pane. Otherwise the field/s will
be added to the selected Extract step or to the one that was last added.

Dragging data into an existing field in the Data Model will replace the data. The
field name stays the same.

Drop data on empty fields or on the record itself to add new fields.

Special conditions

The Extract step may need to be combined with another type of step to get the desired result.

« Data can be extracted conditionally with a Condition step or Multiple Conditions step;
see "Condition step" on page 145 or "Multiple Conditions step" on page 148.

« Normally the same extraction workflow is automatically applied to all records in the
source data. Itis however possible to skip records entirely or partially, using an Action
step. Add an Action step in a branch under a Condition step or Multiple Conditions step
(see "Action step" on page 149) and set the type of action to Stop Processing Record
(see "Textand PDF Files" on page 226).

« To extract transactional data, the Extract step must be placed inside a Repeat step. See
"Extracting transactional data" on page 124.

Note

Fields cannot be used twice in one extraction workflow.
Different Extract steps can only write extracted data to the same field in the Data Model,
if:
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« The field name is the same. (See: "Renaming and ordering fields" on page 158.)

« The Extract steps are mutually exclusive. This is the case when they are located in
different branches of a Condition step or Multiple Conditions step.

« The option Append values to current record is checked in the Step properties
pane under Extraction Definition.

Extracting data into multiple fields

When you select multiple fields in a CSV or tabular data file and extract them simultaneously,
they are putinto different fields in the Data Model automatically.

In a PDF or Text file, when multiple lines are extracted at the same time, they are by default
joined and put into one field in the Data Model. To split them and put the data into different
fields:

1. Select the field in the Data Model that contains the extracted lines.

2. On the Step properties pane, under Field Definition, click the drop-down next to Split
and select Split lines.

Adding fields to an existing Extract step

For optimization purposes, it is better to add fields to an existing Extract step than to have a
succession of extraction steps.

To add fields to an existing Extract step:

1. In the Data Viewer pane, select the data that needs to be extracted. (See "Selecting data"
on the facing page.)

2. Select an Extract step on the Steps pane.

3. Right-click on the data and select Add Extract Field, or drag & drop the data on the Data
Model.

When data are dropped on the Data Model, they are by default added to the last added Extract
step.

Editing fields

After extracting some data, you may want to:
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Change the names of fields that are included in the extraction.

Change the order in which fields are extracted.

Set the data type, data format and default value of each field.

Modify the extracted data through a script.

« Delete a field.

All this can be done via the Step properties pane (see "Settings for location-based fields in a
Text file" on page 221), because the fields in the Data Model are seen as properties of an
Extract step. See also: "Fields" on page 155.

Testing the extraction workflow

The extraction workflow is always performed on the current record in the data source. When an
error is encountered, the extraction workflow stops, and the field on which the error occurred
and all subsequent fields will be greyed out. Click the Messages tab (next to the Step
properties pane) to see any error messages.

To test the extraction workflow on all records, you can:

+ Click the Validate All Records toolbar button.

+ Select Data > Validate Records in the menu.

If any errors are encountered in one or more records, an error message will be displayed. Errors
encountered while performing the extraction workflow on the current record will also be visible
on the Messages tab.

Selecting data

In order to extract the data, it is necessary to first define the data to be extracted, by selecting it.
It depends on the data source file type how this is done. The following paragraphs explain how
to create and manipulate a data selection in each different type of file.

Data selections are used to extract promotional data ("Extracting data" on page 118),
transactional data ("Extracting transactional data" on page 124) and to apply a condition to an
extraction (Condition step).
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Right-clicking on a data selection displays a contextual menu with the actions that can be done
with that selection or the steps that can be added to them. That menu also displays the
keyboard shortcuts.

Text or PDF file

To select data in a Text or PDF file, click on a starting point, keep the mouse button down, drag
to the end of the data that needs to be selected and release the mouse button. The data
selection can contain multiple lines.

To resize a data selection, click and hold on one of the resize handles on the borders or
corners, move them to the new size and release the mouse button.

To move the data selection, click and hold anywhere on the data selection, move it to its new
desired location and release the mouse button.

Note

In a Text or PDF file, when you move the selection rectangle directly after extracting data, you can
use it to select data for the next extraction.

However, moving the selection rectangle that appears after clicking on a field in the Data Model
actually changes which data is extracted into that field.

CSYV file or database data

Tabular data is displayed in the Data Viewer in a table where multiple fields appear for each
line or row in the original data.

To select data, click on a field, keep the mouse button down, drag to the last field that you want
to select and release the mouse button.

Alternatively you can select fields just like files in the Windows Explorer: keep the Ctrl button
pressed down while clicking on fields to select or deselect them, or keep the Shift button
pressed down to select consecutive fields.

XML File

XML data is displayed as a tree view inside the Data Viewer. To get a better overview you can
also collapse any XML level.
In this tree view you can select nodes just like files in the Windows Explorer: keep the Ctrl
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button pressed down while clicking on nodes to select or deselect them, or keep the Shift
button pressed down to select consecutive nodes.
You can select multiple fields even if those fields are in different nodes.

Note

The Goto step isn't used in XML extraction workflows The DataMapper moves through the file
using Xpath, a path-like syntax to identify and navigate nodes in an XML document.

Extracting transactional data

Promotional data are data about customers, such as addresses, names and phone numbers.
In Connect, each record in the extracted record set represents one recipient. The number of
fields that contain promotional data is the same in each record. These data are stored on the
root level of the extracted record.

Transactional data, on the other hand, are used in communications about transactions
between a company and their customers or suppliers: invoices, statements, and purchase
orders, for example. Naturally these data differ per customer. They are stored in detail tables in
the extracted record. The number of fields in a detail table can vary from record to record.
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abe SubTotal 93,76

abe TaxTotal 14.04
abe Total 10780
4 7] services [1] 1

abe Number TVDIGHD
abe Description High Definition Digital TV -
abe BasePrice 30.00 [
abe Rebates -28.19
abe Charges 67.25
abe SubTotal 39.06

abe AccountMumber G784589574527852
abe UserMame

abe Type Television

a T charges [8] 1 (][]
abe 1D TVDIGES
abe Description  TB Basic Digital Service
abe Price 30.00

a T details [6] 1
abe CODE MVHDLOC
abe 1D 55123

abe Description  Gangster Squad HD
abe TirmneStamp  2013-02-1619:24:33
abe Price 585

1

Detail tables are created when an Extract step is added within a Repeat step. The Repeat step
goes through a number of lines or nodes. An Extract step within that loop extracts data from
each line or node.

It depends on the type of source data how this loop is constructed exactly.

For more information about detail tables, multiple detail tables and nested detail tables, see
"Example " on page 196.

From a CSV file or a Database

The transactional data (also called line items) appear in multiple rows.
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1. Select a field in the column that contains the first line item information.

2. Right-=click this data selection and select Add Repeat.

Settings |41, Steps = O || 21 *New config (CSV) &
# || Tabular viewer & 15 | Zoom(s)
~
Pﬂ ItemMumber  [temDesc ItemUnitPrice  ltemOrdered  IltemShipped  ltemBO  ltemTotal TotalOrdered TotalShipped TotalBO
i PSM003 Upgrade (Starter to Web) 7495 3 3 0 22485 26 26 0
Ext Ha PSMO10 Document Design Training - 1day 1230 3 3 0 3750 26 26 0
raction
PSM003 PSM Web 7995 2 2 0 15990 26 26 0
= PSM002 PSM Production (unlimited) 4895 1 1 0 4995 26 26 0
- B PSMOD4 Upgrade (Starter to Preduction) 4495 3 3 0 13485 26 26 0
H PSMO02 B2C and Payment Module Upgrade 793 2 2 0 1390 26 26 0
Iﬁ PSKOT1 PSM (price per class) - 1 day 2000 3 3 0 6000 26 26 0
PSMO00G Upgrade (Production to Web) 4375 2 2 0 8750 26 26 0
PSKI001 PSM Starter (100K records) 995 3 3 0 2985 26 26 0
PSM007 Additional 350K reccords 2500 3 3 0 7500 26 26 0
PSMO003 e-Learning - PSM Training pregram 583 1 1 0 595 26 26 0

This adds a Repeat step with a GoTo step inside it. The GoTo step moves the cursor
down to the next line, until there are no more lines (see "Goto step" on page 144).

3. (Optional.) Add an empty detail table via the Data Model pane: right-click the Data Model
and select Add a table. Give the detail table a name.

Select the Repeat step on the Steps pane.

Start extracting data (see "Adding an extraction" on page 119).

When you drag & drop data on the name of a detail table in the Data Model pane, the data
are added to that detail table.

Dropping the data somewhere else on the Data Model pane creates a new detail table,
with a default name that you can change later on (see "Renaming a detail table" on

page 193).

The extraction step is placed inside the Repeat step, just before the GoTo step.
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Settings -'i:’-i_ Steps = B8

Extract All

Extraction

=

=
-

Gato

=k
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Settings | 2, Steps. =07 et (c5W) 1 = & || Data model B ed 3 < 0
2 || Tabular viewer & 25 | Zoomi®) [10 ]2 0 @ || Neme Walue
~ 4 T record [100) 1[B]H
|P1g quage Brond  PW RemNumber  emDese RemUnitPrice  emOrdered  temShipped  ItemBO  hemTotsl TotelOrdered  TotalShi e D2 cuntsazsr
N . PSM  02285D20BTCAZACEZTCOSROEC21FTIDG PSMOOS Upgrade (Starter to Web) 7495 3 3 0 2485 % % = Date2 2012-04-1100:00
Eetrttion z PSM  0B285D20B7CAZACEZTCOBGOECZIFTIDO PSMOTO Document Design Training - 1 day 1250 3 3 0 750 % 2% DueDate2 2012-05-1100:00
E; PSM  0285D2087CA2ACE2TCOSG0EC21FTIDG PSMOO PSM Web 795 2 2 0 1500 % % e Imobumber2 INVIO11789
1 PSM  0228SD20BTCAZACE2TCOSSOEC21FTIDO PSMOG2 PSM Praduction (unlimited) 4995 1 1 0 4905 % % s Repd REPEO2E212
=z PSM  0S285D2087CAZACETCOSK0EC2TFTIDO PSMOGA Upgrade (Starter to Production) 295 3 3 0 45 % % < Gender2 Mrs
Z PSM  0B28SD20BTCA2ACE2TCOBBOEC21FTIDG PSMOGA 82C and Payment Module Upgrade 25 2 2 0 1550 % % e FirstName2 Cathleen
= PSM  0B285D20BTCAZACEZTCOROECZ1FTIDO PSMOTI PSM (price per class) - 1 day 2000 3 3 0 6000 % % s LastName2 Wit
e < PSM  08285D2087CAZACE27COSB0EC21FIDD PSMOOS Upgrade (Production to Web) 4375 2 2 0 a750 E3 % e JobTitle Rail Vard Engineer
H oo < PSM  0285D2087CA2ACEZTCOS60EC21FTIDO PSMOOT PSM Starter (100K records) %5 3 3 0 2085 % % e Company2 Viilke Storage Serices
H <z PSM  0228SD20BTCAZACEZICOSSOEC21FTID0 PSMCOT Addtiansl 350K reccords 2500 3 3 0 7500 % 2 e SteetAderessi2 206, Cleveland Avenue
H z PSM  0S285D2087CAZACEZTCOSK0EC21FTIDO PSMOGY eLearning - PSM Training program 55 1 1 0 595 % % e StreetAddress22  Bldg 18
§ < e City2 Wilkie.
H e State2 K
H e Country? ca
H Goto and Extract steps we Zip2 VEY 4y
H H e Phonei2
H H e Phone2? (555) 819-7687, 969
Sacoel we Phonel?
| - Pronet
H ate Fand
W e Email2 cwhit@oldmpa.com
e Longuage?
2 2 e Brand2
Ry Condition to end the loop =0 e W2 SA0TSD206TCAZACECTO0BNE
e TotalOrdered? %
Repeat step ™ s TotalShipped2 %
e TotalB02 o
» Description . sz
~ Repeat definition $ arfo sa123.00
iTotel2 T3
Repeattype: Until no more elements - 1
s HemNumber  PSMOCS
= “ e itemDesc Upgrade (Starter to Web)
Masimum iterations on each line: S HemUnitPrice 749500
e HemOrdered 3
e ltemShipped 3
e HemBO 0
. 5 itemTotal 248500
Detail table
« >

From an XML file

The transactional data appears in repeated elements.

1. Right-click one of the repeating elements and select Add Repeat.

Settings | L Steps | = O[5 *Name (ML) 23| =0 ostemodel B o F
© 2 | XML viewer & 13 |zoomea [ 10 B L £ @ || Name ol B
) 4 7] record [100] 1[=][E
lpi <» Rep (REP0290771) b abe FULLNAME Percy Ludwick
<» SubTotal ( 45184.98) ae D CU33615165
3. <» TaxTotal ( 3388.87) abe Gender Mr
Extraction <» Total { 48573.85) ae LastName Ludwick
a <> ITEM O abe FirstName Percy
= <» Number (PPX019) abe Address] 822, Confluence Court
Extraction Cieciption] (QREEn CANI2240) e Address2 Suite 7443
= <» UnitPrice { 300.00) abe City Rockwood
<> Ordered (2) abe State ON
<> Shipped (2) abe Country CA
<> BackOrder (0} ae ZipCode XI1R 5E4
<» Total { 800.00) abe Title Service Representative
a ¢ ITEM O sbe Company Rockwooed Engine Systems
<> Number (PPX027) abe Phone2 (555) 380-6476, #235
<» Description (PP Pen CADDX-92345) abe Ermail pludwick@oldrupa.com
< UnitPrice ( 300.00) e Language EN
<> Ordered (2) abe MD3 (C9B28FBAB37EGB4FE19C2C3EB0FDEBDE
< Shipped (2) e LINE_ITEMS 24
<> BackOrder (0) abe Number INVE103083
<> Total ( 600.00) abe Date 2012-02-19
a4 ¢ ITEM () abe DueDate 2012-03-20
<» Number (PPLOOT7) abe Rep REP0290771
<> Description (PP Prn Lic. CAODL-22345) sbe SubTotal 45184.98
<> UnitPrice { 1000.00) abe TaxTotal 3388.87
<> Ordered (1) abe Total 48573.85
<> Shipped (1) ¥

This adds a Repeat step to the data mapping configuration.
By default, the Repeat type of this step is set to For Each, so that each of the repeated
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elements is extracted. You can see this on the Step properties pane, as long as the
Repeat step is selected on the Steps pane. In the Collection field, you will find the
corresponding node path.

Tip

Itis possible to edit the Xpath in the Collection field, to include or exclude elements
from the loop. One example of this is given in a How-to: Using Xpath in a Repeat
step.

The example in the How-to uses the starts-with () function. For an overview of
XPath functions, see Mozilla: XPath Functions.

The Goto step isn't used in XML extraction workflows The DataMapper moves through the
file using Xpath, a path-like syntax to identify and navigate nodes in an XML document.

2. (Optional.) Add an empty detail table via the Data Model pane: right-click the Data Model
and select Add a table. Give the detail table a name.

3. Select the Repeat step on the Steps pane.

4. Extract the data: inside a repeating element, select the data that you want to extract. Then
right-click the selected nodes and select Add Extraction, or drag & drop them in the Data
Model.

When you drag & drop data on the name of a detail table in the Data Model pane, the data
are added to that detail table.

Dropping the data somewhere else on the Data Model pane creates a new detail table,
with a default name that you can change later on (see "Renaming a detail table" on

page 193).

Page 129

PlanetPress.
Connect


https://learn.objectiflune.com/howto/using-xpath-in-repeat-step
https://learn.objectiflune.com/howto/using-xpath-in-repeat-step
https://developer.mozilla.org/en-US/docs/Web/XPath/Functions

The new Extract step will be located in the Repeat step.

Settings &1 Steps = O || *Name oML 52 ~ B |24 pats model [ =l
o _ o
D || XML viewer & 15 | Zoomp [ 10 B2 £ @ || Neme Value
FS 4 7] record [100] 1[p][E
<> Rep (REP0290771) o abe FULLNAME Percy Ludwick
<> SubTotal { 45184.98) abe D CU53615165
o :| <» TaxTotal ( 3388.87) abe Gender Mr
raction
= ¢» Total ( 48573.85) abe LastName Ludwick
FeRSE] z 4 <» [TEM e FirstName Percy
= <> Numl.Jer (PPX019) abe Addressi 822, Confluence Court
Extraction1 <> Description (PP Pen CAQDX-12345) abe Address2 Suite 7443
= <> UnitPrice { 300.00) abe City Rockwood
<> Ordered (2) abe State ON
RE: <> Shipped (2] sbe Country CA
t
pea <> BackOrder (0} e ZipCode X1R 5E4
[:) eonas - <> Total ( 600.00) abe Title Service Representative
& H ~ a < ITEM () s Company Rockwaod Engine Systems
§ <» Number (PPX027) ave Phone? (553) 380-6476, #235
gc:cooag o Ea?cpnpt\on (;‘;‘DPDEDH CADDX-92345) abe Email p.ludwick@eoldrupa.com
g <» UnitPrice ( .00) abe Language EN
g < Ordered (2) abe MDS (C9B28FBAB3TEGBAFE19C2C3EB0FDEBDE
H <> Shipped (2) s LINE_ITEMS 24
[@ <» BackOrder (0) abe Number INV6103083
<» Total { €00.00) abe Date 2012-02-19
~
~ 4 < ITEM abe DueDate 2012-03-20
<» Number (PPLOOT) abe Rep REP0290771
<> Description (PP Prn Lic. CAODL-22345) ac SubTotal 45124.98
<> UnitPrice { 1000.00) abe TaxTotal 3388.87
<> Ordered (1) ahe Total 48573.85
<> Shipped (1} a1

From a Text or a PDF file

In a PDF or Text file, transactional data appears on multiple lines and can be spread over
multiple pages.

1. Add a Goto step if necessary. Make sure that the cursor is located where the extraction
loop must start. By default the cursor is located at the top of the page, but previous steps
may have moved it. Note that an Extract step does not move the cursor.

1. Select something in the first line item.

2. Right-click on the selection and select Add Goto. The Goto step will move the
cursor to the start of the first line item.

Settings |1, Steps = O ||[@ *Name (PDR) & = B || pata model A S T8
£ | PDF viewer €588 |men [0 EHL L@ || Nme Value
" 4 T record [134] 1[B][E
|Fjj o <> Field1 Mr Remeo Leininger<br /..
r.leininger@oldrupa.com
H EN
et 86EDFF7336B7E6CCI6CECD67C7T258EE
=
= PPX027 PP Pen CAOOX-92345 300.00 3 3 0 900.00
H PPX019 PP Pen CA00X-12345 300.00 2 2 0 600.00
PPLO06 PP Prn Lic. CAOOL-12345 950.00 2 2 0 1900.00
Iﬁ PPLO16 PP Prn Lic. CAOOL-B2345 1425.00 3 3 0 4275.00
PPLO15 PP Prn Lic. CAOOL-A2345 1400.00 3 3 0 4200.00
PPLO10 PP Prn Lic. CAOOL-52345 1150.00 1 1 0 1150.00
PPX025 PP Pen CAOOX-72345 300.00 1 1 0 300.00
PPX030 PP Pen CAOOX-C2345 300.00 2 2 0 600.00
PPLO13 PP Prn Lic. CROOL-82345 1300.00 1 1 0 1300.00
PPS004 PP Search CA00S-12345 29.99 1 1 0 29.99
SUBTOTALS : 19 19 0 15254.99
TAXES: 1144.12
TOTAL: 16399.11
v
< >
Step Properties| i Messages. i
Extract Step @ 2

» Description

~ Extraction Definition
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2. Add a Repeat step where the loop must stop.

1. In the line under the last line item, look for a text that can be used as a condition to
stop the loop, for example "Subtotals", Total" or "Amount".

2. Select that text, right-click on it and select Add Repeat. The Repeat step loops over
all lines until the selected text is found.

Settings |1, Steps, = O ||[@ *Name (PDR) & = O ||*] pata medel e =0
£ | PDF viewer &8 8| z0mea ([0 EL L@ || Neme Value
~ 4 T record [134] 1[p][H
ijj ) <> Field1 Mr Remeo Leininger<br /...
r.leininger®@oldrupa.com
3 EN
Extregtion 86EDFF7336B7E6CCI6CECD67CTT258EE
@ el PP Pen CA00X-92345 300.00 3 3 0 900.00
Goto PPXC9 PP Pen CA00X-12345 300.00 2 2 o] 600.00
= PPL0O06 PP Prn Lic. CROOL-12345 950.00 2 2 0 1900.00
— PPLOl6 PP Prn Lic. CAOOL-B2345 1425.00 3 3 o} 4275.00
5 PPLO15 PP Prn Lic. CROOL-A2345 1400.00 3 3 0 4200.00
2 PPLO10 PP Prn Lic. CAOOL-52345 1150.00 1 1 o} 1150.00
Iﬁ PPX025 PP Pen CA00X-72345 300.00 1 1 0 300.00
PPX030 PP Pen CAQ0X-C2345 300.00 2 2 0 600.00
PPLO13 PP Prn Lic. CAOOL-82345 1300.00 1 1 o 1300.00
PPS004 PP Search CA00S-12345 29.99 1 1 o] 29.99
SUBTOTALS : 19 19 0 15254.99
TAXES: 1144.12
TOTAL: 16399.11
< >
Step Properties| 1 Messages. ]

3. Include/exclude lines. Lines between the start and end of the loop that don't contain a
line item must be excluded form the extraction. Or rather, all lines that contain a line item
have to be included. This is done by adding a Condition step within the Repeat step.

1. Select the start of the Repeat step on the Steps pane.

2. Look for something in the data that distinguishes lines with a line item from other

lines (or the other way around). Often, a "." or "," appears in prices or totals at the
same place in every line item, but not on other lines.

3. Select that data, right-click on it and select Add Conditional.

Settings |, Steps = O || "Name (PDR) &2 = 0|/ Data model [N =
g . .
£ | PDF viewer &85 2| 2om [0 L L@ ||Nme Value
~ 4 [ record [134] 1 [EI[E

<> Fieldl  MrRomeo Leinin,

nger@oldrupa.com B

336B7E6CCI96CECD67C77258EE

H

H

H

o 17 o [EE

woo|3 s il 8loq [1HH 8 2 B
|4 &7

M PP Pen CA00X-92345 300.00 3 3 0 900.00

+ PP Pen CAQ0X-12345 300.00 2 2 0 600.00

+ PP Prn Lic. CAOOL-12345 950.00 2 2 0 1900.00

+ PP Prn Lic. CADOL-B2345 1425.00 3 3 0 4275.00

H + PP Prn Lic. CAOOL-A2345 1400.00 3 3 0 4200.00
o2t M PP Prn Lic. CADOL-52345 1150.00 1 1 0 1150.00
o + PP Pen CA00X-72345 300.00 1 1 0 300.00
= M PP Pen CA00X-C2345 300.00 2 2 0 600.00
3 + PP Prn Lic. CAOOL-82345 1300.00 1 1 0 1300.00
2 + PP Search CA00S-12345 29.99 1 1 0 29.99
SUBTOTALS : 19 19 0 15254.99

TAXES: 1144.12

TOTAL: 16399.11
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Selecting data - especially something as small as a dot - can be difficultin a
PDF file. To make sure that a Condition step checks for certain data: Type the value
in the right operand (in the Step properties pane).Move or resize the selection

rectangle in the data.Click the Use selection i button in the left operand (in the
Step properties pane).When the Condition evaluates to true, the value is found in
the selected region.

In the Data Viewer, you will see a green check mark in the left margin next to each
included line and an X for other lines.

Settings | 1, Steps = O |2 ] "0LSGlnvoice twolines_initemDescription (TXT) 1 =0 Step Properties =0
) N
£ | Text viewer Font | Courier New v| # & 5 5| zeomim 100 . © @ | Condition step o
INV2077448 - » Description
] REPE396866
- 9 Mr Octavio Mcdermott ¥ Rule tree
Extraction o " e School
~ Condition
= Ayt @ieatiion Bewnilpre@ | Conditon it Condition name ®BE
Gato indicate that only the lines that Left operand
= include an amount of money are Based on: Position O
5 Left: n S Right i z
peat extracted UnitPrice Ordered B.0. Shipped  Total
[ ior Hocke 15,98 9 1 L] 143,82 Top offset: 0 < Height 1
999000 g X Elbow Pads
G HPR3001  Bower Valor APX2 Junior B 104,98 2 1 0 209,98 Tim: Both v
* Hockey Gloves
” £ [HST2002  CCN 2-22 Junior Wood Hock 19,99 1z 4 (] 239,88 Operator; contains v [Jinvert condition
""""" x — Right operand
= H G HAHI001  Bower Hockey Cap 13,99 14 4 10 279,86
Extraction] H o HST1002  Bower S1 Youth Hockey Sti 21,99 29 7 2z 1304m Basedoms | Value v
& [HSKS001 Bower Valor AFX3 Junier I 199,99 2 1 1 399, 98
o= X Hockey skates Value:
= H G |HAJ1003  CON H22 Hockey Jersey 17,88 18 13 s 323,82
Conditien1 H #[HST1005  Reabuck CORE-44 Junior Ho 29,99 2 ° 2 59,88
) H X Stick
= o H G HAJ1002  CCN Z-55 Hockey Jersey 16,99 s o s 84,95
Eutraction2 Earaction22 H #|HPR1002  CCN T+2 Youth Hookey 13,88 13 z B 259,87
% Elbow Pads
hten | Res | F [HPRS003  Reabuck 87K Junior Ice 44,99 13 12 1 584,87
x Hockey
3¢ Page 2 of 2
% cuss144020
b4 2013-10-23
* 2013-11722
X !
2929|8008 eesee: x IRV077ReE
H x REPB396866
< 3¢ Mz Octavie Medermott
Gotol 3¢ |Saint-Charles de Bellechasse School I
% ¥ 258, Renee Court
= x
3 % saint-Charles de Bellechasse, OC
° 5 ca
090000 0o d ¥ X [29375-5022
[l X
s x
Eraction 5 Preduct  Description UnitPrice Ordered B.0. Shipped  Totval
FHST1001  Bower RRT Junior Grip Hoc 129,99 2 ) 2 259,98
Cini % scick
T vl 5 144 57 87 4496, 47 v
: < >
s i
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Settings -ﬁ_i«zps = [ 4| *0LSGinvoice_twolines_initemDescription (TXT) =0 Step Properties =0
) .
£ | Text viewer Font | Courier New v| # & 15 5| zeome (100 21 © @ | Condition step o
INV2077448 ~ » Description
E REPB326866
= 9 Mr Octavio Mcdermott Ll
Extraction Saint-Charles de Bellechasse School
s ~ Condition
11259, Renee Court
: Condition list: | Condition name ~vEBE
SaintCharles de Bellechasse, OC
4/ca Left operand
15(29375-5022 Based on: Position v
3 : Left ™ < Right ™
Repeat Product Descriprion UnitPrice Ordered B.O. Shipped Total
[] « HER4003 Eastown 3332 Junior Hocke 15,98 1 L] 143,82 Top offset: 0 T Height 1
80900080000608900000000000009( 0 & x Elbow Pads
< G4 HPR3001  Bower Valor APX2 Junior H 104,99 2 1 1 209,58 Tien Both 2
Condition b3 Hockey Gloves
7 ? ® & HSTZ002 GO z-22 Junior Wood Hock 13,99 12 4 8 233,88 Operstor: | contains v [Jtevest condition
~~~~~~~~~~~ o . stick
5 T 3 mRm1001 Bower Hockey Cap 19,99 14 4 10 279,86 Right operand
Extraction H & HST1002 Bower S1 Youth Hockey Sti 44,99 29 7 22 1304,71 Based on: Value v
H 7 HSKSO01  Bower Valor APXS Junior I 129,99 2 1 1 399,98
oo H * Hockey skates Value:
H
= key Jersey 17,99 18 13 5 323,82
Condition] o -44 Junior Ho 29,99 2 [} 2 59,98
*® If true, the extraction is performed.
= — Otherwise, go to the next line o vy et 5 5 = s
Eatrsction? Baraction22 (Gotol) h Hockey 15,95 13 2 1 259,87
- os PUSRIR Junior Tce 45,99 a3 12 1 584,87
3 Hockey Pants
H 3 Page 2 of 2
H pod cuss144020
S H b% 2013-10-23
3 H § 2013-11-22
* 207748
x REPE3I26666
5 ¥r Octavio Medermott
3¢ sains Bellechasse School
X2
x
3¢ |saint-Charles de Bellechasse, 0T
2 xca
Soossessssssessassassssasasnsl G0, ¥ 29375-5022
[ bod
H x
Extraction3 i Product Description UnitPrice Ordered B.O. Shipped Total
GFHST1001  Bower RKT Junior Grip Hoc 129,99 2 o 2 259,98
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4. (Optional.) Add an empty detail table to the Data Model: right-click the Data Model and
select Add a table. Give the detail table a name.

5. Extract the data (see "Adding an extraction" on page 119).
When you drag & drop data on the name of a detail table in the Data Model pane, the data
are added to that detail table.
Dropping the data somewhere else on the Data Model pane, or using the contextual
menu in the Data Viewer, creates a new detail table, with a default name that you can
change later on (see "Renaming a detail table" on page 193).
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Note

In a PDF or Textfile, pieces of data often have a variable size: a product
description, for example, may be short and fit on one line, or be long and cover two
lines. To learn how to handle this, see "Extracting data of variable length" on the
next page.

6. Extract the sum or totals. If the record contains sums or totals at the end of the line items
list, the end of the Repeat step is a good place to add an Extract step for these data. After
the loop step, the cursor position is at the end of line items.

1. Selectthe amount or amounts.
2. Click on the end of the Repeat step (%*) in the Steps panel.

3. Right-click on the selected data and select Add Extraction.

Alternatively, right-click on the end of the Repeat step in the Steps panel and select Add
a Step > Add Extraction.
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Tip
This how-to describes in detail how to extract an item description that appears in a variable number
of lines: How to extract multiline items.

Extracting data of variable length

In PDF and Text files, transactional data isn't structured uniformly, as in a CSV, database or
XML file. Data can be located anywhere on a page. Therefore, data are extracted from a
certain region on the page. However, the data can be spread over multiple lines and multiple
pages:

« Line items may continue on the next page, separated from the line items on the first page
by a line break, a number of empty lines and a letterhead.

« Data may vary in length: a product description for example may or may not fit on one line.
How to exclude lines from an extraction is explained in another topic: "Extracting transactional

data" on page 124 (see From a PDF or Text file).
This topic explains a few ways to extract a variable number of lines.
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Text file: setting the height to 0

If the variable partin a TXT file is at the end of the record (for example, the body of an email) the
height of the region to extract can be setto 0. This instructs the DataMapper to extract all lines
starting from a given position in a record until the end of the record, and store them in a single
field.

This also works with the data.extract() method in a script; see "Examples" on page 271.

Finding a condition

Where itisn't possible to use a setting to extract data of variable length, the key is to find one or
more differences between lines that make clear how big the region is from where data needs to
be extracted.

Whilst, for example, a product description may expand over two lines, other data - such as the
unit price - will never be longer than one line. Either the line above or below the unit price will
be empty when the product description covers two lines.

Such a difference can then be used as a condition in a Condition step or a Case in a Multiple
Conditions step.

A Condition step, as well as each Case in a Multiple Conditions step, can only check for one
condition. To combine conditions, you would need a script.

Using a Condition step or Multiple Conditions step

Using a Condition step ("Condition step" on page 145) or a Multiple Conditions step ("Multiple
Conditions step" on page 148) one could determine how big the region is that contains the data
that needs to be extracted.

In each of the branches under the Condition or Multiple Conditions step, an Extract step could
be added to extract the data from a particular region. The Extract steps could write their data to
the same field.

Fields cannot be used twice in one extraction workflow.
Different Extract steps can only write extracted data to the same field in the Data Model, if:

« The field name is the same. (See: "Renaming and ordering fields" on page 158.)

« The Extract steps are mutually exclusive. This is the case when they are located in
different branches of a Condition step or Multiple Conditions step.

« The option Append values to current record is checked in the Step properties pane
under Extraction Definition.
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Tip
Create and edit the Extract step in the 'true' branch, then right-click the step on the Steps pane, select

Copy Step, and paste the step in the 'false' branch. Now you only have to adjust the region from
which this Extract step extracts data.

To learn how to configure a Condition step or a Case in a Multiple Conditions step, see
"Configuring a Condition step" on page 147.
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Using a script

A script could also provide a solution when data needs to be extracted from a variable region.
This requires using a Javascript-based field.
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1. Add afield to an Extract step, preferably by extracting data from one of the possible
regions; see "Extracting data" on page 118. To add a field without extracting data, see
"JavaScript-based field" on page 156.

2. On the Step properties pane, under Field Definition, select the field and change its Mode
to Javascript.
If the field was created with its Mode set to Location, you will see that the script already
contains one line of code to extract data from the original location.

3. Expand the script. Start by doing the check(s) to determine where the data that needs to
be extracted is located. Use the data.extract () function to extract the data. The
parameters that this function expects depend on the data source, see "Examples" on
page 271.

Example

The following script extracts data from a certain region in a Text file; let's assume that this
region contains the unit price. If the unit price is empty (after trimming any spaces), the product
description has to be extracted from two lines; else the product description should be extracted
from one line.

var s = data.extract(1l,7,1,2,"");

if (s.substring(l,3).trim().length == 0)

{ data.extract (12,37,0,2,""); } /* extract two lines */
else { data.extract(12,37,0,1,""); } /* extract one line */

The fourth parameter of the extract () function contains the height of the region. When working
with a Text file, this equals a number of lines.

Tip
With a Text file, the data.extract() method accepts 0 as its height parameter. With the height set to 0
it extracts all lines starting from the given position until the end of the record.

Note that this script replicates exactly what can be done in a Condition step. In cases like this, it
is recommended to use a Condition step. Only use a script when no steps are sufficient to give
the expected result, or when the extraction can be better optimized in a script.
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Steps

In the DataMapper, steps are part of an extraction workflow (see "Data mapping workflow" on
page 113). They contain a specific instruction for the DataMapper, for example to extract data,
create a loop, or apply a condition. Some types of steps contain other steps.

Steps are executed sequentially, from top to bottom in an extraction workflow.
Inside a Condition step, some steps may be skipped altogether when they are on a particular
branch, whereas in a Repeat step - a loop - several steps may be repeated a number of times.

The Preprocessor and Postprocessor steps are special in that the first can be used to modify
the incoming data prior to executing the rest of the extraction workflow while the latter can be
used to further process the resulting record set after the entire extraction workflow has been
executed.

Step types

These are the types of steps that can be added to a data mapping workflow:

« "Preprocessor step" below

« "Extract step"” on page 142

« "Repeat step" on page 143

« "Goto step" on page 144

« "Condition step" on page 145

« "Multiple Conditions step" on page 148
« "Action step" on page 149

« "Postprocessor step" on page 150

Preprocessor step

The Preprocessor step allows the application to modify the incoming data prior to executing the
rest of the extraction workflow through a number of preprocessors. It also lets you define
properties, to be added to each record or to the data as a whole. A unique ID could be created
to be added to each record in the output for integrity checks later on. A time stamp could be
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added to create reports. A tag could be added to process certain records differently. A
preprocessor could remove certain records altogether.

One example of how a preprocessor could be used is given in a How-to: Using Preprocessors
in DataMapper.

Properties

To add a property:

1. Select the Preprocessor step on the Steps pane.
2. On the Step properties pane, under Properties, click the Add button '&. See
"Properties" on page 217 for an explanation of the settings for properties.

To set the value of a property you can use an Action step (see "Action step" on page 149).

Preprocessors

The Preprocessor step can contain any number of preprocessors. They will be run in sequence
before the data is sent to the Data Mapping workflow. To add a preprocessor:

1. Select the Preprocessor step on the Steps pane.
2. On the Step properties pane, under Preprocessor, click the Add button ' &.

3. Under Preprocessor definition, add the script. Preprocessing tasks must be written in
JavaScript (see "Using scripts in the DataMapper" on page 255 and "DataMapper Scripts
API" on page 252).
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Configuring the Preprocessor step

For an explanation of the settings for preprocessors, see: "Preprocessor step properties" on
page 216.

Extract step

The Extract step is essential in each and every data mapping configuration. It extracts data
from the data source, based on their location (a row and column in CSV or tabular data, an
XPath in XML, or a region of the page in PDF and Text) or on a JavaScript. The data is placed
in the record set that is the result of the extraction workflow.

Fields always belong to an Extract step, but they don't necessarily all contain extracted data. To
learn how to add fields without extracted data to an Extract step, see "Fields" on page 155.
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Adding an Extract step

To add an Extract step, first select the step on the Steps pane after which to insert the Extract
step. Then:

« In the Data Viewer, select some data, right-click that data and choose Add Extraction, or
drag & drop the data in the Data Model. For more detailed information and instructions,
see: "Extracting data" on page 118.

« Alternatively, right-click the Steps pane and select Add a Step > Add Extraction. Make
the required settings on the Step properties pane.

If an Extract step is added within a Repeat step, the extracted data are added to a detail table
by default; see "Extracting transactional data" on page 124 and "Example " on page 196.

Configuring an Extract step

The names, order, data type and default value of the fields extracted in an Extract step are
properties of that Extract step. These and other properties can be edited via the Step properties
pane. For an explanation of all the options, see "Settings for location-based fields in a Text file"
on page 221.

Fields cannot be used twice in one extraction workflow.
Different Extract steps can only write extracted data to the same field in the Data Model, if:

« The field name is the same. (See: "Renaming and ordering fields" on page 158.)

« The Extract steps are mutually exclusive. This is the case when they are located in
different branches of a Condition step or Multiple Conditions step.

« The option Append values to current record is checked in the Step properties pane
under Extraction Definition.

Repeat step

The Repeat step is a loop that may run 0 or more times, depending on the condition specified.
Itis used for the extraction of transactional data; see "Extracting transactional data" on
page 124.

Repeat steps do not automatically move the pointer in the source file. Therefore a Goto step
that moves the cursor is added automatically within the loop to avoid an infinite loop, exceptin

Page 143

PlanetPress.
Connect



XML files. When you select a node in an XML file and add a Repeat step on it, the Repeat step
will automatically loop over all nodes of the same type on the same level in the XML file.

Adding a Repeat step
To add a Repeat step:

1. On the Steps pane, select the step after which to insert the Condition step.

2. Make sure that the cursor is located where the extraction loop must start. By default the
cursor is located at the top of the page or record, but previous steps in the extraction
workflow may have moved it down. If necessary, add a Goto step (see "Goto step”
below).

This step can be skipped when the data source is an XML file.

3. Add the Repeat step:

» Selectdata in the line or row where the loop must end, right-click on it and select
Add Repeat.

« Right-click the Steps pane and select Add a Step > Add Repeat. Make the
required settings on the Step properties pane.
Configuring a Repeat step
For information about how to configure the Repeat step, see "Text and PDF Files" on

page 233.

How to use itin an extraction workflow is explained in the topic: "Extracting transactional data"
on page 124.
Goto step

Although invisible, there is a cursor in the Data Viewer. In an extraction workflow, the cursor
starts off at the top-left corner of each record in the source data.

The Goto step can move the cursor to a certain location in the current record. The new location
can be relative to the top of the record or to the current position.

When the Goto step is used within a Repeat step, it moves the cursor in each loop of the
Repeat step. In this case the new location has to be relative to the current position.

Page 144

PlanetPress.
Connect



Note

The Goto step isn't used in XML extraction workflows The DataMapper moves through the file
using Xpath, a path-like syntax to identify and navigate nodes in an XML document.

Adding a Goto step
To add a Goto step:
« On the Steps pane, select the step after which to insert the Goto step. In the Data Viewer,

select some data, right-click that data and choose Add Goto, to add a Goto step that
moves the cursor to that data.

« Alternatively, right-click the Steps pane and select Add a Step > Add Goto. Make the
required settings on the Step properties pane.

Configuring a Goto step

For information about how to configure the Goto step, see "Text file" on page 244.

Condition step

A Condition step is used when the data extraction must be based on specific criteria. The
Condition step splits the extraction workflow into two separate branches, one that is executed
when the condition is true, the other when it is false.

Extract steps can be added to both the 'true’ and the 'false' branch (see "Extracting data" on
page 118 and "Extracting transactional data" on page 124).

In the Data Viewer pane, icons on the left indicate the result of the evaluation in the Condition
step: ¥ when true and # when false.
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Adding a Condition step
To add a Condition step:

« On the Steps pane, select the step after which to insert the Condition step; then, in the
Data Viewer, select some data, right-click that data and choose Add Conditional.
In the Step properties pane, you will see that the newly added Condition step checks if
the selected position (the left operand) contains the selected value (the right operand).
Both operands and the operator can be adjusted.
Note that the left operand is by default trimmed, meaning that spaces are cut off.
Selecting data - especially something as small as a dot - can be difficultin a PDF file. To
make sure that a Condition step checks for certain data: Type the value in the right
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operand (in the Step properties pane).Move or resize the selection rectangle in the

-----

pane).When the Condition evaluates to true, the value is found in the selected region.

« Alternatively, right-click the Steps pane and select Add a Step > Add Conditional. Enter
the settings for the condition on the Step properties pane.

Configuring a Condition step

The condition in a Condition step is expressed in a rule or combination of rules. Rules have a
left operand, an operand type (for example: contains, is empty) and a right operand.

For an overview of all options on the Step properties pane, see "Condition step properties" on
page 238.

Inverting a rule

Inverting a rule adds not to the operand type. For instance, is empty becomes is not empty.
To invert a rule, check the Invert condition option next to Operator under Condition on the
Step properties pane.

Combining rules

One rule is already presentin a newly added Condition step. To add another rule, click the Add
condition button under Condition, next to Condition List, on the Step properties pane.

Step Properties 1 Messages =08
Condition step @
b Description

* Rule tree

~ Condition
Condition list; Condition name
Left operand

Rules are by default combined with AND. To change the way rules are combined, right-click
"AND" in the Rule Tree, on the Step properties pane, and select OR or XOR instead. (XOR
means one or the other, but not both.)
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Step Properties 1 Messages = O

Condition step

€

F Description

* Rule tree

A[xl [}

AND el
OR
% xoR
Condition listt | Condition name v| B
Left operand

Renaming a rule

To rename a rule, double-click its name in the Rule Tree and type a new name.

Multiple Conditions step

The Multiple Conditions step is useful to avoid the use of nested Condition steps: Condition
steps inside other Condition steps.

In a Multiple Conditions step, conditions or rather Cases are positioned side by side.

Each Case condition can lead to an extraction.

Cases are executed from left to right.
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Settings -ﬁ_ Steps = 0|m switch-example (CSV) 2% | = switch-example-template [Section 1] |
#~ || Tabular viewer &
"~
P‘ﬂ COLUMMN1 COLUMMZ COLUMM3 COLUMMNA COLUMMS COLUMMNG COLUMMNT C(
CU97407951 2012-02-28 2012-03-29 INV3139493 REP9739930 Miss Marquita Wi
Multiple Cenditions CU97407951 2012-02-28 2012-03-29 INV2135493 REP9739930 Miss Marquita Wi
CUS7407951 2012-02-28 2012-03-29 INVE135493 REP9739930 Miss Marquita Wi
% CUS7407951 2012-02-28 2012-03-29 INVE135493 REP9739930 Miss Marquita Wi
3 CUS7407951 2012-02-28 2012-03-29 INVE135493 REP9739930 Miss Marquita Wi
2 CUS7407951 2012-02-28 2012-03-29 INVE135493 REP9739930 Miss Marquita Wi
8 CUS7407951 2012-02-28 2012-03-29 INV8135493 REP9739930 Miss Marquita Wi
e ° g e CUS7407951 2012-02-28 2012-03-29 INV8135493 REP9739930 Miss Marquita W,
Case Casel Case? Default ¥ >
@ @ @ Qg» Step Properties| 1 Messages T
= H H 3 ~ Condition %
Extraction Exir2 Extr3 Exird
== FH == == Left operand
e hinaay Kimaa i
Position
H H H H
2 H 2 2 COLUMNG
@ @ @
@ =) g g9 @ o
@ -
@
] Both
W Condition: | Case2 v @ E s
Operator: | contains v [ Invert condition
Right operand
Based on: | Value ]
o Value: Mr
< > v

Adding a Multiple Conditions step

To add a Multiple Conditions step, right-click the Steps pane and select Add a Step > Add
Multiple Conditions.

To add a case, click the Add case button to the right of the Condition field in the Step
properties pane.

Configuring a Multiple Conditions step

For information about how to configure the Multiple Conditions step, see "Left operand, Right
operand" on page 241. The settings for a Case are the same as for a Condition step; see
"Condition step properties" on page 238.

Action step

The Action step can:
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« Execute JavaScript code.

« Setthe value for a record property. Record properties are defined in the Preprocessor
step; see "Preprocessor step" on page 140.

« Stop the processing of the current record. Normally an extraction workflow is
automatically executed on all records in the source data. By stopping the processing of
the current record, you can filter records or skip records partially.

The Action step can run multiple specific actions one after the other in order.

Adding an Action step
To add an Action step, right-click on the Steps pane and select Add a Step > Add Action.

Configuring an Action step

For information about how to configure the Action step, see "Text and PDF Files" on page 226.

Postprocessor step

The Postprocessor step allows the application to further process the resulting record set after
the entire extraction workflow has been executed, using JavaScript.

For example, a postprocessor can export all or parts of the data to a CSV file which can then be
used to generate daily reports of the Connect Workflow processes that use this data mapping
configuration (see "Data mapping configurations" on page 101).

A postprocessor could also write the results of the extraction process to a file and immediately
upload that file to a Workflow process.

The Postprocessor step can contain any number of postprocessors.
To add a postprocessor:

« Selectthe Postprocessor step on the Steps pane.
« On the Step properties pane, under Postprocessor, click the Add button ' &.

« Under Postprocessor definition, add the script. Postprocessor tasks must be written in
JavaScript (see "Using scripts in the DataMapper" on page 255 and "DataMapper Scripts
API" on page 252).
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j Data model

|| Name |
| 4 T record [15] 1 [l

Value

<> Invoicelnfo_Custom CU39144020
<2 Invoicelnfo_Invoicel 2013-10-23
<2 Invoicelnfo_Paymen 2013-11-22
<> Invoicelnfo_SubFielc

<> Invoicelnfo_Invoicell INV2077448
<% Invoicelnfo_SalesRer REP8396866

<> FullName Mr Octavio Mcdermott

< Company Saint-Charles de Bellechasse ... |
<> Street 259, Renee Court

<> City Saint-Charles de Bellechasse

<> Province Qac

<> Country Canada

<> ZipCode H1V 2E5

<% Totals_SubTotal 4496 47

<> Totals_Taxes 719,44

<> Totals_GrandTotal 5215,91

4 T items [13] 1 [
<> ProductlD HPR4003 |

<> Description Eastown 5532 Junior Hockey ...
<> UnitPrice 15,98 |
<> OtyOrdered 9

4 ItemTotal 143.82

Configuring the Postprocessor step

For an explanation of the settings for postprocessors, see "JavaScript " on page 249.

The Data Model

The Data Model is the structure of records into which extracted data are stored. It contains the
names and types of the fields in a record and in its detail tables. A detail table is a field that
contains a record set instead of a single value. The Data Model is shown in the Data Model
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pane, filled with data from the current record.

Name Value

v ] record [200] 1[R[
e InvNumber INV1773645
ae D CUB3585978
e Gendler M
e FirstName Asron
e LastName Palmer
e Title Mrs
we Company Gigazoom
e Address] 73722 Bellgrove Terrace
e Country Canada
abe State Ontario
ave Email apalmerd@telegraph.co.uk
e Phone 1-(560)248-0340
e UserName apalmerd
e Password 12ulxgR2
e MemberShip gold
e Language EN
e FavHobly skate
£ OrderDate 2016-06-01 12:00 AM
£ DueDate 2016-07-01 12:00 AM
$ SubTotal 414821
4 TaxTotal 622.23
$ Total 477044
~ 7 Products [18] 1[BI[H
atc ProdNumber 53674
stc Description Thule Crossroad Railing Faot P...
5 UnitPrice 199.95

# Ordered 3
# Shipped 3
# BackOrder 0
s TotalProduct 599.85

The Data Model is not related to the type of data source: whether itis XML, CSV, PDF, Text or
a database does not matter. The Data Model is a new structure, designed to contain only the
required data.

About records

A record is a block of information that may be merged with a template to generate a single
document (invoice, email, web page...) for a single recipient. It is part of the record set that is
generated by a data mapping configuration.

In each record, data from the data source can be combined with data coming from other
sources.

Creating a Data Model

A Data Model is created automatically within each data mapping configuration, butitis empty at
the start. To fill it you could use another Data Model (see "Importing/exporting a Data Model" on
the next page) or start creating a data mapping workflow (see "Data mapping workflow" on
page 113).

To learn how to add and edit fields, see "Fields" on page 155.
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Importing/exporting a Data Model

To use a Data Model in another data mapping configuration, or to use it in a Designer template
without a data mapping configuration, you have to export that Data Model and importitinto a
data mapping configuration or template.

Importing and exporting Data Models is done from within the Data model Pane, using the top-

righticons «. and L.
For information about the structure of the exported Data Model file, see "Data Model file
structure" on page 177.

When you import a Data Model, it appears in the Data Model pane where you can see all the
fields and their types.

You can delete or add fields, or change their type. Once the data model is imported and all the
fields are properly set, all you need to do is extract the information from the active data sample
(see "Extracting data" on page 118).

Note

« Imported Data Model fields always overwrite existing field properties when the field
name is the same (although they will still be part of the same Extract step). Non-
existent fields are created automatically with the appropriate field settings. The
import is case-insensitive.

« All imported data model fields are tagged with an asterisk (*).

Editing the Data Model

Empty fields and detail tables, added via the Data Model pane, can be edited (renamed,
deleted etc.) via the Data Model pane, using the contextual menu that opens when you right-
click on a field.

Fields in a Data Model that are actually used in the extraction workflow cannot be edited via the
Data Model pane. They are related to a step in the extraction workflow and are edited via the
Step properties pane instead.

The order of the fields can also not be changed via the Data Model pane. It is the Extract step
that determines the order in which data are extracted, so the order of the fields has to be
changed per Extract step.

To learn how to edit fields and change their order, see "Fields" on page 155.

Page 153

PlanetPress.
Connect



Using the Data Model

The Data Model is what enables you to create personalized templates in the Designer module.
You can drag & drop fields from the Data Model into the template that you are creating (see
"Variable Data" on page 604). For this, you have to have a template and a data mapping
configuration open at the same time, or import a Data Model (see "Importing/exporting a Data
Model" on the previous page).

The Data Model is reusable, meaning that it can be shared amongst different template layouts
and output types.

Different data mapping configurations could use the same Data Model, allowing a template to
be populated with data from different sources and formats, without the need to modify the
template (see "Importing/exporting a Data Model" on the previous page).

In Workflow, when a data mapping configuration is used to extract data from a data source
(see "Data mapping configurations" on page 101), the extracted data is stored in a record set
that is structured according to the Data Model.

About adding fields and data via Workflow

The Data Model is not extensible outside of the DataMapper. When itis used in Workflow - as
part of a data mapping configuration - the contents of its fields can be updated but not its
structure.

There are a number of instances however, where fields may need to be added to the data
model after the initial data mapping operation has been performed. For instance, you might
need to add a cleansed postal address next to the original address, or retrieve a value from a
database and add it to the record.

ExtraData field

You an add empty fields in advance to provide space in the Data Model for Workflow to store
data. For convenience, one field called ExtraData is automatically created at every level of
each data record. That means the record itself gets an ExtraData field, and each detail table
also gets one.

By default the field is not visible in the DataMapper's Data Model, because itis not meant to be
filled via an extraction. It can be made visible using the Show ExtraData Field icon at the top of
the Data Model.

Workflow process

Data can be added to the Data Model in a PlanetPress Connect Workflow process as follows:
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1. Use an Execute Data Mapping task or Retrieve Items task to create a record set. On the
General tab select Outputs records in Metadata.

2. Add a value to a field in the Metadata using the Metadata Fields Management task.
Data added to the _vger_fld_ExtraData field on the Document level will appear in the
record's ExtraData field, once the records are updated from the Metadata (in the next
step).

Other fields have the same prefix: _vger_fld_.

3. Update the record/s from the Metadata. There are several ways to do this. You could, for
example:

o Use the Update Data Records plugin.
« Add an Output task and check the option Update records with Metadata.

« Select Metadata as the data source in the Create Preview PDF plugin.

Note

Many of these actions can also be performed using REST calls.

Please refer to PlanetPress Connect Workflow documentation for more information about the
plugins involved.

Fields

Extracted data are stored in fields in the Data Model (see "The Data Model" on page 151).
Fields can be present on different levels: on the record level or in a detail table (see "Example "
on page 196).

Fields always belong to an Extract step, as can be seen on the Step Properties pane (see
"Settings for location-based fields in a Text file" on page 221), but they don't necessarily all
contain extracted data.

Location-based fields do: they read data from a certain location in the data source.

Other fields may contain the result of a JavaScript (JavScript-based fields) or the value of a
property (property-based fields).
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Adding fields

Location-based field

Generally location-based fields are added to a Data Model by extracting data; see "Extracting
data" on page 118. Location-based fields in detail tables are created by extracting
transactional data; see "Extracting transactional data" on page 124.

Alternatively, you can add fields and detail tables directly in the Data Model pane. Right-click
anywhere on the Data Model and a contextual menu will appear. Which menu items are
available depends on where you've clicked. If you right-click inside the record itself, you can
add a field or a detail table. A field will be added at the end with no extraction, while a detail
table will be added with no fields inside.

After adding a field or detail table this way, you can drag & drop data into it. Without data it is
not accessible via the Step properties pane.

JavaScript-based field

JavaScript-based fields are filled by a script: the script provides a value. Note that the last value
attribution to a variable is the one used as the result of the expression.

There is a number of ways to add a Javascript based field.

Via the Steps pane

1. Make sure there is no data selection in the Data Viewer.

2. Right-click on an Extract step on the Steps pane and select Add a Step > Add Extract
Field. (To add a new Extract step, select Add a Step > Add Extraction first.)

3. On the Step properties pane, under Field Definition, enter the script in the Expression
field.

Via the Step properties pane

1. Select an Extract step on the Steps pane. (To add a new, empty Extract step, right-click
the Steps pane and select Add a Step > Add Extraction.)
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2. On the Step properties pane, under Field Definition, click the Add JavaScript Field
button next to the Field List.

Step Properties 1 Messages = 0O

S
+ Field Definition

Field List: ID v 4

[ ] Add Unique ID to extraction field

3. On the Step properties pane, under Field Definition, enter the script in the Expression
field.

By changing a field's mode

Alternatively you can change a location-based into a JavaScript-based field.

1. Select the field in the Data Model.
2. On the Step properties pane, under Field Definition, change its Mode to JavaScript.

3. Enter the script in the Expression field.

Property-based field

A property-based field is filled with the value of a property.

Objects such as the sourcerecord and steps have a number of predefined properties. (For an
explanation of the objects to which the properties belong, see "DataMapper Scripts API" on
page 252.)

Custom properties can be added via the Preprocessor step; see "Preprocessor step” on
page 140.

A property-based field cannot be added directly. To fill a field with the value of a property, you
have to change an existing field's Mode to Properties.

1. Select the field in the Data Model.
2. On the Step properties pane, under Field Definition, change its Mode to Properties.

3. Select the property from the Property drop-down list, or click the button to the right, to
open a filter dialog that lets you find a property based on the first few letters that you type.

Another way to add the value of a property to a field is by setting the field's Mode to JavaScript

and entering the corresponding property in the Expression field, e.g.

data.properties.myProperty;.
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Adding fields dynamically

Outside of the DataMapper the Data Model cannot be changed. Itisn't possible to add fields to
it when using the data mapping configuration in Workflow. It is however possible to add data to
existing fields via Workflow; see "About adding fields and data via Workflow" on page 154.

Editing fields

The list of fields that are included in the extraction, the order in which fields are extracted and
the data format of each field, are all part of the Extract step's properties. These can be edited via
the Step properties pane (see "Settings for location-based fields in a Text file" on page 221).

Renaming and ordering fields

The order and the names of fields in the Data Model can be changed via the properties of the
Extract step that they belong to.

1. Select the Extract step that contains the fields that you want to rename. To do this you
could click on one of those fields in the Data Model, or on the step in the Steps pane.

2. On the Step properties pane, under Field Definition, click the Order and rename fields
button.

Step Properties 1 Messages = O

S
+ Field Definition

Field List: Number v | 4

[] Add Unique ID to extraction field

See "Order and rename fields dialog" on page 224.

Note

Fields cannot have the same name, unless they are on a different level in the record.

If you intend to use the field names as metadata in a Workflow process, do not add
spaces to field names, as they are not permitted in metadata field names.
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Setting the data type

Fields store extracted data as a String by default. The data type of a field can be changed via
the properties of the Extract step that the field belongs to.

1. Select the Extract step that contains the field. You can do this by clicking on the field in
the Data Model, or on the step in the Steps pane that contains the field.

2. On the Step properties pane, under Field Definition, set the Type to the desired data type.
See "Data types" on page 168 for a list of available types.

Changing the type does not only set the data type inside the record. In the case of dates,
numbers and currencies, it also means that the DataMapper will expect the data in the data
source to be formatted in a certain way. If the actual data doesn't match the format that the
DataMapper expects, it cannot interpret the date, number or currency as such. If for example a
date in the data source is formatted as "yyyy-mm-dd" but the default format adds the time, the
date cannot be read and the DataMapper will stop with an error.

The default format for dates, numbers and currencies can be set in the user preferences
("Datamapper preferences" on page 703), in the data source settings ("Data source settings" on
page 115) and per data field (in the Extract step properties, see "Data Format" on page 223).

Setting a default value

You may want to set a default value for a field, in case no extraction can be made. Make sure to
set the data type of the field via the step properties (see above). Then right-click the field and
select Default Value.

The default value must match the selected data type. If the data type of the field is set to Integer,
for example, you cannot enter a value of 2,3. A default date must be formatted as a DateTime
object ("year-month-day" plus the time stamp, for example: 2012-04-11 12.00 AM); see "Date"
on page 171.

Modifying extracted data

To modify extracted data - the contents of a field - you have to write a script. The script can be
entered as a Post function in a location-based field or as an Expression in a JavaScript-based
field.
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Post function

On the Step properties pane, under Field Definition, you can enter a script in the Post function
field to be run after the extraction. (Click the Use JavaScript Editor button to open the Script
Editor dialog if you need more space.)

A Post function script operates directly on the extracted data. Its results replace the extracted
data. For example, the Post function script replace ("-", ""); replaces the first dash character
that occurs inside the extracted string. The code toLowercase () ; converts the string to
lowercase letters.

Note that the function must be appropriate for the field's data type.

JavaScript Expression

Alternatively you can change a field's Mode from Location to Javascript:

1. Select the field in the Data Model.
2. On the Step properties pane, under Field Definition, change its Mode to JavaScript.

You will see that the JavaScript Expression field is not empty; it contains the code that was
used to extract data from the location. This code can be used or deleted.

Note

The last value attribution to a variable is the one used as the result of the expression.

Deleting a field

The list of fields that are included in an extraction is one of the properties of an Extract step. To
delete a field:

1. Select the field: click on the field in the Data Model, or select the Extract step that contains
the field that you want to delete, and in the Step properties pane, under Field Definition,
select the field from the Field List.
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2. In the Step properties pane, under Field Definition, click the Remove Extract Field button
next to the Field List drop-down.
Step Properties 1 Messages = 0O

+ Field Definition

Field List: ID v | 5 _

[ ] Add Unique ID to extraction field

Detail tables

A detail table is a field in the Data Model that contains a record set instead of a single value.
Detail tables contain transactional data. They are created when an Extract step is added within
a Repeat step; see "Extracting transactional data" on page 124.

In the most basic of transactional communications, a single detail table is sufficient. However, it
is possible to create multiple detail tables, as well as nested tables. Detail tables and nested
tables are displayed as separate levels in the Data Model (see "The Data Model" on page 151).

Renaming a detail table

Renaming detail tables is especially useful when there are more detail tables in one record, or
when a detail table contains another detail table. For this detail table, ‘products’ would be a
better name.

1. On the Data Model pane, click one of the fields in the detail table.

2. On the Step Properties pane, under Extraction Definition, in the Data Table field, you
can find the name of the detail table: record.detail by default. Change the detail partin
that name into something else.

Note

A detail table’s name should always begin with ‘record.’.

3. Click somewhere else on the Step Properties pane to update the Data Model. You will
see the new name appear.

Page 161

PlanetPress.
Connect



Creating multiple detail tables

Multiple detail tables are useful when more than one type of transactional data is presentin the
source data, for example purchases (items with a set price, quantity, item number) and services
(with a price, frequency, contract end date, etc).

ity *Mame (XML) 55 =a
S NI [SENICE REDTESEniative]
<» Company [Rockwood Engine Systems)
<» Phone2 ([555) 380-6476, #235)
<» Email (p.ludwick@aldrupa.com)
<> Language (EN)
<» MDS5 (C9B28FBAB37E6B4FE19C2C3E0FDEBDE)
4 <r INVOICES (T n 1
4 <3 INVOICE (T 1 1 1 1 1 1
€% Number [INVE103083)
<» Date (2013-03-15)
<> DueDate (2013-04-05)
<» Rep (REP0290771)
<* SubTotal [ 74.90)
< TaxTotal [ 11.22)
€% Total [ 86.12)
4 <» PURCHASES [T—— T—— T—— T T
<» Item (RT1485)
<» Description (Router)
< aty (1)
<> Price (14.75)
<» SubTotal (14.75)
4 <» PURCHASES [T—— T—— T—— T T
<» Item (CEL562E)
<» Description [Cable)
< Qty 4
<» Price (8.96)
<> SubTotal (35.84)
4 < SERVICE (T il T m il T
<» Mumber (H5F75ME]
<» Description (HighSpeed FibreOptics 7SMB/S Duplex)
<> BasePrice [34.95)
<> Rebates (-40.00)
<» Charges (0]
<» SubTotal (44.95)
<» AccountNumber (1687635787)
<» UserMame (u21CV342)
<» Type (Internet)
4 <» SERVICE [ 1 T n 1 T Second Table
4> Mumber [PHBASICRES)
<» Description (Basic Residential Phone Service]
<> BasePrice (33.95)
<» Rebates (-14.32)
<> Charges (10.32)
<> SubTotal [29.95)
¥ AccountNumber [22555380647622)
€% UserMame (r45g456h)
<» Type (Phone)}

First Table

To create more than one detail table, simply extract transactional data in different Repeat steps
(see "Extracting transactional data" on page 124).

The best way to do this is to add an empty detail table (right-click the Data Model, select Add a
table and give the detail table a name) and drop the data on the name of that detail table.

Else the extracted fields will all be added to one new detail table with a default name at first,
and you will have to rename the detail table created in each Extract step to pull the detail tables
apart (see "Renaming a detail table" on the previous page).
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Settings |5, Steps = O || B "Name gLy 52 = B | pata model £ e =
o <> Phone2 ((555) 702-5520, £665) A1l Name Value
o <3 Email (atincher@oldrupa.com) 4 T record [3] =] 2[plH
<> Language (EN) sbe FULLNAME Amie Tincher
<> MD5 (BES479B97BEEOAE3970837291B7105C8) e ID CU44643835
H 4 <> INVOICES (T L abe Gender Miss
Extraction 4 ¢ INVOICE (T 1 1 1 1 1 T - - e LastName Tincher
<> Mumber (INV8539825) abe Firsthame Amie
= <> Date (2013-03-15) abe Address] 3536, Chambers Street
Extraction] S G RS e Address? P.0. Box 6049
= <> Rep (REP880D122) e City St. Mary's
== <> SubTotal ( 125.96) abe State ON
5 <> TaxTotal ( 18.86) abe Country CA
e <> Total ( 144.82) s ZipCode L&) 5L1
I@ 4 <> PURCHASES (T—— T—— T—= 1 1 ) abe Title Driver/Sales Workers
<> ltem (RT1483) sbe Company St. Mary's Pest Control Ltd
<> Description (Router) e Phone2 (555) 702-5520, #665
< Oty (1) abe Erail atincher@oldrupa.com
¢ Price (14.75) s Language EN
<> SubTotal (14.75) abc MD5 BE9479B978EEDAEIST0R...
4 <> PURCHASES (T—— T—— T—— 1 T ! axe Number INVB339825
<> Item (CBL366) abe Date 2013-03-15
<> Description (Cable) abe DueDate 2013-04-05
© Qty (3) e Rep REP2200122
<> Price (8.96) abe SubTotal 125.96
<> SubTotal (26.88) abe TaxTotal 18.86
4 <> PURCHASES (T—— T—— T—— 1 1 ) abe Total 144,82
<> ltem (FST3678)
<> Description (Fasteners)
<> Qty (50)
<» Price (0.25)
<> SubTotal (12.5)
a <3 SFRVICF (1 hll ki 1 T kU Al bt
< >
Step Properties| 1 Messages =]
"
Extract Step
» Description
~ Extraction Definition
Data Table: | record hd
w Append values to current record
v
Settings |1, Steps = O || [@ig *Name (XML) 22 = O || Data model [ ] 8
Ie) <> SubTotal (14.75) A Name Value
= 4 <> PURCHASES (T—— T—— T—— 1 1 ) 4 T record [3] ®i[4 HEE
4> Item (CBL3626) abe FULLNAME Amie Tincher
<> Description (Cable) e 1D CU4643835
< <« Quy (3) sbe Gender Miss
Extraction <> Price (8.96) abe LastName Tincher
<> SubTotal (26.88) e FirstName fria
4 <> PURCHASES (T—— T—— T—— 1 T 1 abe Addressl 336, Chambers Street
oo <> ltem (FST5678) abe Address2 P.0. Box 6049
<> Description (Fasteners) abe City St. Mary's
<> Qty (50) abe State ON
- <> Price (0.25) e Country CA
Repeat <> SubTotal (12.5) abe ZipCode L&) 5L1
asese|CPhoses a® ELEl ! ! ! ! ! 1 abe Title Driver/Sales Workers
H = <> Number (HSF75ME) ¢ Company St. Mary's Pest Control Ltd
H H <> Description (HighSpeed FibreOptics 75MB/S Duplex) Phone? (555) 702-5520, #665
8 Exraction? BascPrice (24.35) L =
3 4» baselrice (24, abe Email atincher@oldrupa.com
H <> Rebates (-40.00) sbe Language EN
§°°““E <> Charges (0) ab: MDS BEG479B978EEDAE3ST083...
<> SubTotal (44.95) ate Number INV8539825
= - <> AccountNumber (1687635787) e Date 2013-03-15
g" <> UserName (u21CY342) w DueDate 2013-04-05
= <> Type (Intemet) b Rep REP2800122
Repeat! 4 <> SERVICE (1 T 1 1 T 1 g e SubTotal 125.96
_— - <> Number (PHBASICRES) ) e TaxTotal 18.36
s [ <> Description (Basic Residential Phone Service) e Total 148582
§  Bdraction3 o [l RS 4 T detail [6] 1[B][E
<» Rebates (-14.32]
g =] iy (22323 abe ftem RT1485
B <> Charges (22.32) st Description  Router
I <» SubTotal (41.93) we Oty 1
<> AccountNumber (22555705552022) e Price 1475
T - <5 UserName (wdS7t478) . e SubTotal2 1475
@ < 3
] = abe Number2
g Step Properties| 1 Messages = sbe DescriptionZ
- st BasePrice
I@ Extract Step @ e Rebates
» Description abe Charges
ae SubTotal3
v Extraction Definition abe AccountNum
‘ . aie Userhlame
Data Table: | record.detai abe Type
v [] Append values to current record
< = o &
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Nested detail tables

Nested detail tables are used to extract transactional data that are relative to other data. They
are created just like multiple detail tables, with two differences:

« Forthe tables to be actually nested, the Repeat step and its Extract step that extract the
nested transactional data must be located within the Repeat step that extracts data to a
detail table.

« Intheir name, the dot notation (record.services) must contain one extra level
(record.services.charges).

Note

Using nested detail tables in the Designer module requires scripting, as described in this How-to:
Cloning your way through nested tables.

Example

An XML source file lists the services of a multi-service provider: Internet, Cable, Home Phone,
Mobile. Each service in turn lists a number of "charges", being service prices and rebates, and
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a number of "details" such as movie rentals or long distance calls.

XML viewer & 5 | Zoom(m) 100 [H L £ @

<» Rep (REP2200122) ~
¢» SubTotal ( 93.76)
¢» TaxTotal { 14.04)
<» Total { 107.80)
a <» SERVICE (T 1 1 T
<» MNumber (TVDIGHD)
<» Description (High Definition Digital TV)
<» BasePrice (30.00)
<» Rebates (-28.19)
¢<» Charges (67.23)
< BxtraServices (24.70)
<» AccountMumber (6784589574527852)
<3 SubTotal (39.08)
<x Type (Television)
a <» Charges (T T T )
4 <> CHARGE (1 T T
< |0 (RETVCRTCFAPL)
<» Description (Centribution to CRTC FAPL)
<» Price (-0.13)
4 <> CHARGE (T T T
< |0 (RBTVPROG)
<» Description (PROMO: Programming Credit)
<> Price (-14.20)
4 «» CHARGE (T T T
<» |0 (RETVHDBOX)
<» Description (PROMO: Free HD Receiver Rental)
<> Price (-13.86)
4 <> DETAILS (1 T T
la <> DETAIL (T T T
<» CODE (MVHDLOC)
<» |D [35123)
<» Description (Gangster Squad HD)
<» TimeStamp (2013-02-16 19:24:33)
<» Price (5.93)
la <> DETAIL (T T T
<» CODE (MVHDLOC)
< D (35234)
<+ Description (Indiana Jones: Raiders of the Lost Ark)
<» TimeStamp (2013-02-23 18:02:46)
<» Price (2.93)
la <> DETAIL (T T T
<» CODE (MVHDLOC)
< |0 (35343)

s 5 Necerintinn (lndiana loner and the Tarmnle of Do’
— — —

Data to be Nested
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The services can be extracted to a detail table called record.services.

B e = 51 [ "Name oML 22 = B |24 pata model wed 8570
£ || XML viewer & 15 | Zoomea 10 |0 © Name Value
i 4 7] record 3] H|< 3
INVOICERUN (T T ) a e FULLNAME Melba Lumpkin
|Fm 5 CUSTOMER (1 T T T T T T T 1 T A T A 1 A 1 A ) ae D CU35692808
H @ FULLNAME (Melba Lumpkin) e Gender Miss
Extraction <> ID (CU35692808) e LastName Lumpkin
<5 Gender (Miss) e FirstName Melba
<> LastName (Lumpkin) s Address] 564, Hidden Valley Drive
Exlraghum <» FirstName (Melba) abe Address2 Suite 9530
<5 Address1 (564, Hidden Valley Drive) e City Gore Bay
o= < Address2 (Suite 9530) e State oN
5 < City (Gore Bay) e Country ca
2 ¢5 State (ON) e ZipCode F3U 383
W < Country (CA) we Title Machine Tool Cutting Oper...
< ZipCode (F3U 583) e Company Gore Bay Game Group
¢5 Title (Machine Tool Cutting Operator/Tender) ¢ Phone2 (555) 631-670, #854
<> Company (Gore Bay Game Group) s Email muumpkin@oldrupa.com
< Phone2 ((555) 631-670, £854) e Language EN
<> Email (m.lumpkin@oldrupa.com) we MDS A376734A49841 ESFO4696FBE...
< Language (EN) s Number INVA839392
<3 MDS (A376734A49841E9F04GIGFBEGGCE04A3) e Date 2013-03-15
la <> INVOICES (1 1) s DueDate 2013-04-05
4 & INVOICE (T 1 1 1 1 1 1 1 1 ) = e REP8200122
<> Number (INV4839392) e SubTotal 9376
<> Date (2013-03-13) e TaxTotal 1404
< DueDate (2013-04-05) e Total 107.80

< Rep (REPS80D122)
<> SubTotal ( 93.76)
< TaxTotal { 14.04)
<> Total { 107.80)
4 <> SERVICE (T T T T T T T T T T
< Number (TVDIGHD)
<> Description (High Definition Digital TV)
<> BasePrice (30.00)
< Rebates (-28.19)
< Charges (67.25)
<> ExtraServices (24.70)
<> AccountNumber (6784589574527852)
<> SubTotal (39.06)
<> Type (Television)
4 ¢ Charges (1 1 1 )
4 < CHARGE (T 1 1 1 )
<> ID (RBTVCRTCFAPL)
<> Description (Contribution to CRTC FAPL)
< Price (-013)
« os ruARAE M Ll L] n \

Step Properties| 1 Messages m

The "charges" and "details" can be extracted to two nested detail tables.
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= O |[g *Name (XML) 52
£ | XML viewer

Settings |1, Steps

& 5 | Zoom(%) | 100

= O || pata model

L L e

"
4 ¢ INVOICH

<

H <>
Extraction ®
<
<
<
<

Rep
Sub

Extraction
Tot:

SER\
<
<
©
<
<
@
<
<

PR

==t

9000008

0950000

"Bl roeces,

S

TaxTotal (

E( 1 1 1 T T T T T )

Number (INV4839392)
Date (2013-03-15)
DueDate (2013-04-05)

(REP2300122)
Total ( 93.76)
14.04)
al ( 107.80)
WICE (T Al T T T T Al Al A
Number (TVDIGHD)
Description (High Definition Digital TV)
BasePrice (30.00)
Rebates (-28.19)
Charges (67.25)
ExtraServices (24.70)
AccountNumber (6784589574527852)
SubTotal (39.06)
Type (Television)
Charges (T 1 1 )
< CHARGE (1 1 1 1 )
<» ID (RBTVCRTCFAPL)
<> Description (Contribution to CRTC FAPL)
< Price (-0.13)
CHARGE (T 1 T Al )
<> ID (RBTVPROG)
< Description (PROMO: Programming Credit)
< Price (-14.20)
CHARGE (T T T T )
< ID (RBTVHDBOX)
<> Description (PROMO: Free HD Receiver Rental)
<> Price (-13.86)
DETAILS (T T L T T T n )
<> DETAIL (T Al T T Al T )
<> CODE (MVHDLOC)
< 1D (55123)
< Description (Gangster Squad HD)
<> TimeStamp (2013-02-16 1%:24:33)
< Price (595)
<> DETAIL (T Al T T Al T )
<> CODE (MVHDLOC)
< 1D (55234)
<> Description (Indiana Jones: Raiders of the Lost Ark)
<> TimeStamp (2013-02-23 1&:02:46)

4\ Drira 2001

A

Step Properties

i Messages

T e
Name Value
4 [ record [3] F< 3 I~
e FULLNAME Melba Lumpkin
we D CU35692808
e Gender WMiss
e LastName Lumpkin
s FirstName Melba
ave Address] 564, Hidden Valley Drive
e Address2 Suite 9530
e City Gore Bay
abe State ON
¢ Country cA
s ZipCode F3U 583
e Title Machine Tool Cutting Oper...
s Company Gore Bay Game Group
s Phone2 (555) 631-670, 2854
e Email m.lumpkin@oldrupa.com
e Language EN
e MD5 376734749841 ESFO4696FBE...
e Number INVA4839392
e Date 2013-03-15
we DueDate 2013-04-05
e Rep REPBB00122
e SubTotal 9376
we TaxTotal 1404
e Total 107.80
4 [T detail [1] 1
sse Number2 TVDIGHD
e Description  High Definition Digital TV
ave BasePrice 30.00
e Rebates -2819
e Charges 67.25
ae ExtraServices 2470
s AccountNumbe 6784589574527852
e SubTotal2 39.06
e Type Television

The nested tables can be called record.services.charges and record.services.details.

Settings |1, Steps = 01| "Name (xmL) 52 = O/} Data model el ST O
2 | XML viewer € 15 | Zoomg 100 0 £ @ || N Value
~ 4 = record [3] H[= 3
4 <> SERVICE (1 1 T 1 T T n n 1 T we FULLNAME Melba Lumpkin
< Number (TVDIGHD) e 1D Ccu3ses2eoe
H <> Description (High Definition Digital TV) e Gender Miss
Extraction <5 BasePrice (30.00) e LastName Lumpkin
=i <> Rebates (-28.1) e FirstName Melba
= <> Charges (67.25) e Address] 564, Hidden Valley Drive
G ¢ ExtraServices (24.70) e Address? Suite 9530
5 AccountNumber (§784589574527852) e City Gore Bay
o= <> SubTotal (39.06) e State oN
= <> Type (Television) we Country cA
Repeat 4 ¢ Charges (T T T ) e ZipCode F3U 583
= 4 & CHARGE (1 1 1 1 ) e Title Machine Tool Cutting Oper...
Cj. < ID (RBTVCRTCFARL) s Company Gore Bay Game Group
B <5 Description (Contribution to CRTC FAPL) = A (555) 631-670, #6854
< Price (-0.13) e Email mulumpkin@oldrupa.com
= 4 <> CHARGE (T 1 T 1 ) e Language EN
5 ¢ 1D (RBTVPROG) e MDS A376734A49841EGFO4596F BE...
Repeat] <> Description (PROMO: Programming Credit) ae Mumber INV4839392
e <> Price (-14.20) abe Date 2013-03-15
2000|[Gul 'o°°° 4 ¢ CHARGE (T 1 L 1 ) sc DueDate 2013-04-05
oo Bion ¢ ID (RETVHDBOX) e Rep REP8200122
<> Description (PROMOC: Free HD Receiver Rental) s SubTotal 9376
g < Price (-13.88) e TaxTotal 1404
- 4 ¢ DETAILS (T 1 L T 1 L 1 ) e Total 107.20
4 < DETAL (T 1 1 1 1 1 ) 4 T details [10] 1 [RE
B cooo <> CODE (MVHDLOG) v e Number2 TVDIGHD
o
g < e Description  High Definition Digital TV
= ax BasePrice 3000
Repeat> Step Properties| 1 Messages -8 abe Rebates -28.19
— Fggvmg P— ~ s Charges 6725
= w BtraServices 2470
Extractiond ) Fixed automation properties s AccountMumbe 6784589574527852
e SubTotal2 3906
= - i
Properties e Type Television
R w102
Name Scope Type Default Value 8 o -
e Description2
e Price
s CODE
abe D3
s Description3
~ Preprocessor s TimeStamp
s Pricel
Name Type B
v
< > hd
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Now one "charges" table and one "details" table are created for each row in the "services"
table.

Data types

By default the data type of extracted data is a String, but each field in the Data Model can be set
to contain another data type.

To do this:

1. In the Data Model, select a field.

2. On the Step properties pane, under Field Definition choose a data type from the Type
drop-down.

Changing the type does not only set the data type inside the record. In the case of dates,
numbers and currencies, it also means that the DataMapper will expect the data in the data
source to be formatted in a certain way. If the actual data doesn't match the format that the
DataMapper expects, it cannot interpret the date, number or currency as such. If for example a
date in the data source is formatted as "yyyy-mm-dd" but the default format adds the time, the
date cannot be read and the DataMapper will stop with an error.

The default format for dates, numbers and currencies can be set in the user preferences
("Datamapper preferences" on page 703), in the data source settings ("Data source settings" on
page 115) and per data field (in the Extract step properties, see "Data Format" on page 223).

Note

Data format settings tell the DataMapper how certain types of data are formatted in the data

source. They don't determine how these data are formatted in the Data Model or in a template. In
the Data Model, data are converted to the native data type. Dates, for example, are converted to a

DateTime object in the Data Model, and will always be shown as "year-month-day" plus the time
stamp, for example: 2012-04-11 12.00 AM.

The following data types are available in PlanetPress Connect.

« "Boolean" on the next page

« "String" on page 176
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o "HTMLString" on page 175
 "Integer" on page 175

« "Float" on page 174

» "Currency" on the facing page
« "Date" on page 171

« "Object" on page 176

Note

The Object data type is only available in the DataMapper module. It can be used for properties in
the Preprocessor step, but not for fields in the Data Model.

Boolean

Booleans are a simple true/false data type often used in conditions and comparisons.

Defining Boolean values

e Preprocessor:
« In the Step properties pane, under Properties, add or select a field.

« Specify the Type as Boolean and set a default value of either either t rue or
false, followed by a semicolon.

« Extraction:
« In the Data Model, select a field.

« On the Step properties pane, under Field Definition set the Type to Boolean.
The field value must be true or false.

« JavaScript Expression: Set the desired value to either t rue or false. Example:
record.fields["isCanadian"] = true;

Note

The value must be all in lowercase: t rue, false. Any variation in case (True, TRUE) will not
work.
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Boolean expressions

Boolean values can also be set using an expression of which the result is true or false. This is
done using operators and comparisons.

Example: record. fields["isCanadian"] = (extract ("Country") == "CA");

For more information on JavaScript comparison and logical operators, please see
w3schools.com or developer.mozilla.org.

Currency

The Currency data type is a signed, numeric, fixed-point 64-bit number with 4 decimals. Values
range from -922 337 203 685 477.5808 to 922 337 203 685 477.5808. This data type is
routinely used for financial calculations: it is as precise as integers.

Defining Currency values

« Preprocessor:
« In the Step properties pane, under Properties, add or select a field.

« Specify the Type as Currency and set a default value as a number with up to 4
decimal points, followed by a semicolon; suchas 546513.8798;

« Extraction:
« In the Data Model, select a field.
« On the Step properties pane, under Field Definition set the Type to Currency.

« Under Data Format, specify how the value is formatted in the data source (see
Extract Step; for the default format settings, see "Data source settings" on
page 115).

The field value will be extracted and treated as a Float.

« JavaScript Expression: Set the desired value to any Float value. Example:
record.fields["PreciseTaxSubtotal”"] = 27.13465;

Note

While Currency values can be set to up to 4 significant digits, only 2 are displayed on screen.
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Building Currency values

Currency values can be the result of direct attribution or mathematical operations just like
Integer values (see "Integer" on page 175).

Date

Dates are values that represent a specific pointin time, precise up to the second. They can also
be referred to as datetime values. While dates are displayed using the system's regional
settings, in reality they are stored unformatted.

Note

The Date property is stored in Connect database with zero time zone offset, which makes it
possible to convert the time correctly in any location. PlanetPress Workflow, however, shows the
date/time as it is stored database (with 0 time zone offset). This is expected behavior for the moment
and the zone offset must be calculated manually in PlanetPress Workflow.

Extracting dates

To extract data and have that data interpreted as a Date, set the type of the respective field to
Date:

1. Select the field in the data model.
2. On the Step properties pane, under Field Definition, specify the Type as Date.

3. Make sure that the date in the data source is formatted in a way that matches the
expectations of the DataMapper. If the date doesn't match the format that the DataMapper
expects, it cannot be interpreted as a date. For example, if a date in the data source is
formatted as "yyyy-mm-dd" but the DataMapper expects a time as well, the date cannot be
read and the DataMapper will stop with an error.

The expected date format can be set in three places:

« Inthe user preferences ("Datamapper preferences" on page 703).
« In the data source settings ("Data source settings" on page 115).

« In the field properties: on the Step properties pane, under Data Format, specify the
Date/Time Format.
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For the letters and patterns that you can use in a date format, see "Defining a date/time
format" below.

Data format settings tell the DataMapper how certain types of data are formatted in the
data source. They don't determine how these data are formatted in the Data Model orin
a template. In the Data Model, data are converted to the native data type. Dates, for
example, are converted to a DateTime object in the Data Model, and will always be
shown as "year-month-day" plus the time stamp, for example: 2012-04-11 12.00 AM..

Defining a date/time format

A date format is a mask representing the order and meaning of each digit in the raw data, as
well as the date/time separators. The mask uses several predefined markers to parse the
contents of the raw data. Here is a list of markers that are available in the DataMapper:

« yy: Numeric representation of the Year when it is written out with only 2 digits (i.e. 13)
« yyyy: Numeric representation of the Year when it is written out with 4 digits (i.e. 2013)

e M: Short version of the month name (i.e. Jan, Aug). These values are based on the
current regional settings.

o MM: Long version of the month name (i.e. January, August). These values are based on
the current regional settings.

« mm: Numeric representation of the month (i.e. 1, 09, 12)

« D: Short version of the weekday name (i.e. Mon, Wed). These values are based on the
current regional settings.

« DD: Long version of the weekday name (i.e. Monday, Wednesday). These values are
based on the current regional settings.

« dd: Numeric representation of the day of the month (i.e. 1, 09, 22)
« hh: Numeric representation of the hours

« nn: Numeric representation of the minutes

« ss: Numeric representation of the seconds

« ms: Numeric representation of the milliseconds.

o ap: AM/PM string.

« In addition, any constant character can be included in the mask, usually to indicate
date/time separators (i.e./-:) . If one of those characters happens to be one of the
reserved characters listed above, it must be escaped using the \ symbol.
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Note

The markers that can be used when extracting dates are different from those that are used to
display dates in a template (see the Designer's "Date and time patterns" on page 918).

Examples of masks

Value in raw data Mask to use

June 25,2013 MMdd, YYYY

06/25/13 mm/dd/yy

2013.06.25 yyyy.mm.dd

2013-06-25 07:31 PM yyyy-mm-dd hh:nn ap
2013-06-25 19:31:14.1206 yyyy-mm-dd hh:nn:ss.ms
Tuesday, June 25,2013 @ 7h31PM DD, MM dd, yyyy @ hh\hnnap

Entering a date using JavaScript

In several places in the DataMapper, Date values can be set through a JavaScript. For
example:

« In afield in the Data Model. To do this, go to the Steps pane and select an Extract step.
Then, on the Step properties pane, under Field Definition click the Add JavaScript Field
button (next to the Field List drop-down). Type the JavaScript in the Expression field. (To
rename the field, click the Order and rename fields button.)

« InaPreprocessor property. To do this, go to the Steps pane and select the
Preprocessor step. Then, on the Step properties pane, under Properties add a property,
specify its Type as Date and put the JavaScript in the Default Value field.

The use of the JavaScript Date() object is necessary when creating dates through a JavaScript
expression. For more information, see w3schools - JavaScript Dates and w3schools - Date

Object.
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Example

The following script creates a date that is the current date + 30 days:

function addDays (date, days) {
var result = new Date (date);
result.setDate(result.getDate () + days);
return result;

}
addDays (new Date (), 30);

Float

Floats are signed, numeric, floating-point numbers whose value has 15-16 significant digits.
Floats are routinely used for calculations. Note that Float values can only have up to 3
decimals. They are inherently imprecise: their accuracy varies according to the number of
significant digits being requested.

The Currency data type can have up to 4 decimals; see "Currency" on page 170.

Defining Float values

e Preprocessor:
« In the Step properties pane, under Properties, add or select a field.

« Specify the Type as Float and set a default value as a number with decimal points,
followed by a semicolon; for example 546513.879;.

+ Extraction:
« In the Data Model, select a field.

« On the Step properties pane, under Field Definition set the Type to Float.
The field value will be extracted and treated as a Float.

« JavaScript Expression: Set the desired value to any Float value.
Example: record.fields["PreciseTaxSubtotal"] = 27.134;

Building Float values

Float values can be the result of direct attribution or mathematical operations just like Integer
values (see "Integer" on the next page).
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HTMLString

HTMLStrings contain textual data that includes HTML markup. They are essentially the same
as String values except in cases where the HTML markup can be interpreted.

Example: Assume that a field has the value He said <b>wow!</b>. If the data type is String and
the value is placed in a template, it will display exactly as "He said <b>WOW!</b>" (without the
quotes). If the data type is HTMLString, it will display as "He said WOW!" (again, without the
quotes).

Considering this is the only difference, for more information on how to create and use HTML
String values, see "String" on the facing page.

Integer

Integers are signed, numeric, whole 64bit numbers whose values range from -(2°63) to
(2763). Integers are the numerals with the highest precision (and the fastest processing speed)
of all, since they are never rounded.

Defining Integer values

e Preprocessor:

« In the Step properties pane, under Properties, add or select a field.

« Specify the Type as Integer and set a default value as a number, such as 42.
» Extraction:

 In the Data Model, select a field.

« On the Step properties pane, under Field Definition set the Type to Integer.
The field value will be extracted and treated as an integer.

« JavaScript Expression: Set the desired value to any Integer value. Example:
record.fields["AnswerToEverything"] = 42;

Building Integer Values

Integers can be set through a few methods, all of which result into an actual integer result.

« Direct attribution: Assign an integer value directly, such as 42, 99593463712 or
data.extract ("TotalOrdered") ;
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« Mathematical operations: Assign the result of any mathematical operation. For example:
22+51,3*%6,10/50r sourceRecord.property.SubTotal. For more information
on mathematics in JavaScript , see w3Schools - Mathematical Operators. For more
advanced mathematical functions, see w3schools - Math Object.

Note

When adding numbers that are not integers, for instance 4.5 + 1.2 ,around towards zero
rounding is applied after the operation was made. In the previous example, the result, 5. 7, is
rounded to 5. In another example, -1 .5 - 1 resultsin -2

Object

Objects holds addresses that refer to objects. You can assign any reference type (string, array,
class, or interface) to an Object variable. An Object variable can also refer to data of any value
type (numeric, Boolean, Char, Date, structure, or enumeration).

Defining Object values

« Preprocessor:
« In the Step properties pane, under Properties, add or select a field.

« Specify the Type as Object and set a default value as a semi-colon.

String
Strings contain textual data. Strings do not have any specific meaning, which is to say that their

contents are never interpreted in any way.

Defining String values

e Preprocessor:
« In the Step properties pane, under Properties, add or select a field.

« Specify the Type as String and set a default value as any text between quotes,
followed by a semicolon, e.g. "This is my text";
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o Extraction:
« In the Data Model, select a field.

« On the Step properties pane, under Field Definition set the Type to String.
The field value will be extracted and treated as a string.

« JavaScript Expression: Set the desired value to any string between quotes. Example:
record.fields["countryOfOrigin"] = "Canada";

Building String values

String values can be made up of more than just a series of characters between quotes. Here
are a few tips and tricks to build strings:

» Both single and double quotes can be used to surround strings and they will actin
precisely the same manner. So, "this is a string" and 'this is a string' mean the same thing.
However, it's useful to have both in order to remove the need for escaping characters. For
instance, "I'm fine!" works, but 'I'm fine!" does not since only 'l' is properly interpreted. 'l\'m
fine!" works (escaping the ' with a\\).

« ltis possible to put more than one string, as well as variables containing strings, by

concatenating them with the + operator. For example, "Hello " +
sourceRecord.property.FirstName + ", nice to meet you!".

« Adding more data to an existing string variable or field is possible using a combination of
concatenation and assignment. For example, after the statements var myvar = "Is
this the real life";,andmyVar += " or is this just fantasy?";,
the value of myvar will be, obviously "Is this the real life or is this
just fantasy?".

For more information on string variables, see quicksmode.org.

Data Model file structure

The Data Model file is an XML file that contains the structure of the Data M model, including
each field's name, data type, and any number of detail tables and nested tables.

Example: promotional data

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

<datamodel schemaVersion="1.0.0.3" name="Generic Address Block"
version="1"
xmlns="http://www.objectiflune.com/connectschemas/DataModelConfig"
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xsi:schemalocation="http://www.objectiflune.com/connectschemas/Data

ModelConfig

http://www.objectiflune.com/connectschemas/DataModelConfig/1 0 0

3.xsd" xmlns:xsi="http://www.

<field
<field
<field
<field
<field
<field
<field
<field
<field
<field
<field
</datamodel>

type="string"
type="string"
type="string"
type="string"
type="string"
type="string"
type="string"
type="string"
type="string"
type="string"
type="string"

w3.0rg/2001/XMLSchema-instance">
name="Name" required="true"/>
name="Organization" required="true"/>
name="Addressl" required="true"/>
name="Address2" required="true"/>
name="Address3" required="true"/>
name="City" required="true"/>
name="StateOrProvince" required="true"/>
name="Country" required="true"/>
name="ZipOrPostalCode" required="true"/>
name="Extral" required="true"/>
name="Extral2" required="true"/>
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Example: transactional details, in a simple invoice format

<?xml version="1.0"
<datamodel schemaVersion="1.0.0.3"

version="1"

encoding="UTF-8"

standalone="yes"?>
name="Transactional Invoice"

xmlns="http://www.objectiflune.com/connectschemas/DataModelConfig"
xsi:schemalLocation="http://www.objectiflune.com/connectschemas/Data

ModelConfig

http://www.objectiflune.com/connectschemas/DataModelConfig/1 0 0

3.xsd" xmlns:xsi="http://www.

<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field type="string"
<field
<field
<field type="string"
<field
<field
<field
<table name="detail">
<field
<field
<field
<field
<field
</table>
</datamodel>

w3.0rg/2001/XMLSchema-instance">
name="ID" required="true"/>
name="Gender" required="true"/>
name="LastName" required="true"/>
name="FirstName" required="true"/>
name="Addressl" required="true"/>
name="Address2" required="true"/>
name="City" required="true"/>
name="State" required="true"/>
name="Country" required="true"/>
name="ZipCode" required="true"/>
name="Title" required="true"/>
name="Company" required="true"/>
name="Phone2" required="true"/>
name="Email" required="true"/>
name="Language" required="true"/>
name="Number" required="true"/>

type="datetime" name="Date" required="true"/>
type="datetime" name="DueDate" required="true"/>

name="Rep" required="true"/>

type="currency" name="SubTotal" required="true"/>
type="currency" name="TaxTotal" required="true"/>
type="currency" name="Total" required="true"/>

<field type="string" name="Number2" required="true"/>
<field type="string" name="Description" required="true"/>

type="currency" name="UnitPrice" required="true"/>
type="integer" name="Ordered" required="true"/>
type="integer" name="Shipped" required="true"/>
type="integer" name="BackOrder" required="true"/>
type="currency" name="Total2" required="true"/>
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Example: nested tables (one table into another)

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<datamodel schemaVersion="1.0.0.3" name="Nested Table Example"
version="1"
xmlns="http://www.objectiflune.com/connectschemas/DataModelConfig"
xsi:schemalLocation="http://www.objectiflune.com/connectschemas/Data
ModelConfig
http://www.objectiflune.com/connectschemas/DataModelConfig/1 0 0
3.xsd" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<field type="string" name="RecordField" required="true"/>
<table name="details">
<field type="string" name="DetailsTableField" required="tr
<table name="nestedtable">
<field type="string" name="NestedTableField" requi:
</table>
</table>
</datamodel>

Example: default values

Default values can be added to any field with the defaultValue attribute:

<field type="string" name="RecordField" required="true"
defaultValue="My Default Value">

DataMapper User Interface

The main ingredients in the Designer's user interface are the following:

« "Menus" on page 186

« "Toolbar" on page 249

« "Settings pane" on page 203

« "Steps pane" on page 213

« "The Data Viewer" on page 200

« "Step properties pane" on page 215
« "Messages pane" on page 202

« "Data Model pane" on page 190
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Keyboard shortcuts

This topic gives an overview of keyboard shortcuts that can be used in the DataMapper.
Keyboard shortcuts available in the Designer for menu items, script editors and the data model
pane can also be used in the DataMapper; see "Keyboard shortcuts" on page 738.

Although some of the keyboard shortcuts are the same, this isn't a complete list of Windows
keyboard shortcuts. Please refer to Windows documentation for a complete list of Windows
keyboard shortcuts.

Menu items

The following key combinations activate a function in the menu.

Key Function

combination

Alt Put the focus on the menu. (Alt + the underlined letter in a menu name
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Key Function

combination

displays the corresponding menu.) The menu can then be browsed using
the Enter key, arrow up and arrow down buttons.

Alt + F4 Exit
Ctrl+C Copy

or Ctrl +

Insert

Ctrl + N New
Ctrl+0O Open file

Ctrl + Shift + Open configuration file

O

Ctrl + S Save file
Ctrl +V Paste

or Shift +

Insert

Ctrl + X Cut

Ctrl+Wor Close file
Ctrl + F4

Ctrl +Y Redo
or Ctrl + Shift
+Y

Ctrl + Z or Undo
Ctrl + Shift +
Z
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Key Function

combination

Ctrl + Shift + Save all
S

Ctrl + Shift + Close all

W or

Ctrl + Shift +

F4

Ctrl + F5 Revert
Ctrl + F7 Next view

Ctrl + Shift + Previous view
F7

Ctrl + F8 Next perspective

Ctrl + Shift + Previous perspective

F8

Ctrl + F10 Save as

Ctrl + F12 Send to Workflow / Package files
F4 Ignore step

F6 Add an Extract step

F7 Add a Goto step

F8 Add a Condition step

F9 Add a Repeat step
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Key Function

combination

F10 Add an Extract field

F11 Add an Action step

F12 Add a Multiple Conditions step

Alt+F12 Add a Case step (under a Multiple Conditions step)
Home Go to the first step in the workflow

End Go to the last step in the workflow

Alt+V Validate records

Shift+ F10 Open context menu

or Ctrl + Shift

+F10

Viewer pane

The following key combinations activate a function in the Viewer.

Key Function

combination

Alt + - Open system menu

Ctrl + - Zoom out

Ctrl ++ Zoom in

Ctrl + Shift+ E Switch to Editor

Ctrl + F6 Next editor (when there is more than one file open in the Workspace)
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Key Function

combination

Ctrl + Shift + F6 Previous editor (when there is more than one file open in the
Workspace)

Data Model pane

Key combination Function

PageUp Go to previous record

PageDown Go to next record

Alt+CR Property page

Alt + PageDown Scroll down to the last field

Alt + PageUp Scroll up to the first field
Steps tab

Ctrl + - Zoom out

Ctrl + + Zoom in

Edit Script and Expression windows

The following key combinations have a special function in the Expression and in the Edit
Script windows (expanded view).

Key combination Function

Ctrl + space Content assist (auto-complete)
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Key combination Function

Ctrl + A Select all

Ctrl+D Duplicate line

Ctrl +1 Indent (Tab)

Ctrl +J Line break

Ctrl + L Go to line; a prompt opens to enter a line number.

Ctrl + Shift+D Delete line

Shift + Tab Shift selected lines left

Tab Shift selected lines right

Ctrl +/ Comment out/ uncomment a line in code

Ctrl + Shift+/ Comment out / uncomment a code block
Menus

The following menu items are shown in the DataMapper Module's menu:

File Menu

e New...: Opens the Creating a New Data Mapping Configuration dialog.

« Open: Opens a standard File Open dialog. This dialog can be used to open Templates
and data mapping configurations.

« Open Recent: List the most recently opened Templates and configurations. Clicking on a
template will open itin the Designer module, clicking on a data mapping configuration will
open itin the DataMapper module.
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« Close: Close the currently open data mapping configuration or Template. If the file needs
to be saved, the appropriate Save dialog will open.

« Close All: Close any open data mapping configuration or Template. If any of the files
need to be saved, the Save Resources dialog opens.

« Save: Saves the current data mapping configuration or Template to its current location on
disk. If the file is a data mapping configuration and has never been saved, the Save As
dialog appears instead.

« Save As.... Saves the current data mapping configuration or Template to a new location
on disk. In the case of Templates, itis saved to a location that can be different than the
local repository.

« Save All: Saves all open files. If any of the open files have never been saved, the Save
As dialog opens for each new unsaved file.

« Revert: Appears only in the Designer module. Reverts all changes to the state in which
the file was opened or created.

« Add Data: Adds data either to the current data mapping configuration or to the open
template. In data mapping configuration

o From File...: Opens the dialog to add a new data file to the currently loaded data
mapping configuration. Not available if the currently loaded data mapping
configuration connects to a database source.

« From Database...: Opens the Edit Database Configuration dialog. Not available if
the currently loaded data mapping configuration is file-based.

« Send to Workflow: Opens theSend to Workflow dialog to send files to a local
PlanetPress Workflow software installation.

« Exit: Closes the software. If any of the files need to be saved, the Save Resources dialog
opens.

Edit Menu

« Undo: Undoes the previous action.
« Redo: Redoes the last action that was undone.

« Cut Step: Removes the currently selected step and places itin the clipboard. If the step is
a Repeat or a Condition, all steps under it are also placed in the clipboard. If there is
already a step in the clipboard, it will be overwritten.

o Copy Step: Places a copy of the currently selected step in the clipboard. The same
details as the Cut step applies.
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Paste Step: Takes the step or steps in the clipboard and places them in the Steps after
the currently selected step.

Delete Step: Deletes the currently selected step. If the step is a Repeat or Condition, all
steps under it are also deleted.

Cut: Click to remove the currently selected step, or steps, and place them in the clipboard.

Copy: Click to place a copy of the currently selected step, or steps, in the clipboard.

Paste: Click to place any step, or steps, from the clipboard before the currently selected
step in the Steps Pane.

Data Menu

« Hide/Show datamap: Click to show or hide the icons to the left of the Data Viewer that
displays how the steps affect the line.

« Hide/Show extracted data: Click to show or hide the extraction selections indicating that
data is extracted. This simplifies making data selections in the same areas and is useful
to display the original data.

« Validate All Records: Runs the Steps on all records and verifies that no errors are
presentin any of the records. Errors are displayed in the Messages Pane.

Steps

« Ignore Step: Click to set the step to be ignored (aka disabled). Disabled steps do not run
when in DataMapper and do not execute when the data mapping configuration is
executed in Workflow. However, they can still be modified normally.

« Add Extract Step: Adds an Extract Step with one or more extract fields. If more than one
line orfield is selected in the Data Viewer, each line or field will have an extract field.

« Add Goto Step: Adds a Goto step that moves the selection pointer to the beginning of the
data selection. For instance if an XML node is selected, the pointer moves to where that
node is located.

« Add Condition Step: Adds a condition based on the current data selection. The "True"
branch gets run when the text is found on the page. Other conditions are available in the
step properties once it has been added.

« Add Repeat Step: Adds a loop that is based on the current data selection, and
depending on the type of data. XML data will loop on the currently selected node, CSV
loops for all rows in the record. In Text and PDF data, if the data selection is on the same
line as the cursor position, the loop will be for each line until the end of the record. If the
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data selection is on a lower line, the loop will be for each line until the text in the data
selection is found at the specified position on the line (e.g. until "TOTAL" is found).

« Add Extract Field: Adds the data selection to the selected Extract step, if an extract step
is currently selected. If multiple lines, nodes or fields are selected, multiple extract fields
are added simultaneously.

« Add Multiple Conditions: Adds a condition that splits into multiple case conditions.

« Add Action Step: Adds a step to run one or more specific actions such as running a
JavaScript expression or setting the value of a Source Record Property.

View Menu

e Zoom In: Click to zoom in the Steps Pane.
o Zoom Out: Click to zoom out the Steps Pane.

Window Menu

« Show View

« Messages: Shows the Messages Pane.

« Steps: Shows the Steps Pane.
« Settings: Shows the Settings Pane.

« Record: Shows the Record Pane.

+ Detail tables : Each detail table and nested table is listed here. Click on one to
show itin the Data Model Pane.

« Step Properties: Shows the Step Properties Pane.

« Reset Perspective: Resets all toolbars and panes to the initial configuration of the
module.

« Preferences: Click to open the Preferences dialog.
Help Menu

« Software Activation: Displays the Software Activation dialog. See Activating your
license.

« Help Topics: Click to open this documentation.

« Contact Support: Click to open the Objectif Lune Contact Page in the default system
Web browser.
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o About PlanetPress Connect Designer: Displays the software's About dialog.

« Welcome Screen: Click to re-open the Welcome Screen.
Panes
The DataMapper screen contains the following panes.

"Settings pane" on page 203. The Settings pane contains settings for the data source.

« "Steps pane" on page 213. The entire extraction workflow is visible in the Steps pane.
« "The Data Viewer" on page 200. The Data Viewer shows one record in the data source.

» "Step properties pane" on page 215. The Step properties pane contains all settings for
the step thatis currently selected on the Steps pane.

« "Data Model pane" below. The Data Model pane shows one extracted record.

« "Messages pane" on page 202.

Data Model pane

The Data Model pane displays the result of all the preparations and extractions of the extraction
workflow. The pane displays the content of a single record within the record set at a time.

Data is displayed as a tree view, with the root level being the record table. On the level below
that are detail tables, and a detail table inside a detail table is called a nested table.

The Data Model is also used as a navigation tool between records and in all detail tables.

Data Model toolbar buttons

= : Import a Data Model.
= : Export the Data Model.
&t : Synchronize the Data Model and the data sample.

@ : Show the ExtraData field. Note that this field is not meant to be filled via an extraction. It
can be used in Workflow to add data to the Data Model; see "About adding fields and data via
Workflow" on page 154.

Data Model contextual menu

The Data Model is generally constructed by extracting data; see "Extracting data" on page 118.
Itis however possible to modify the Data Model, even if no data is present in the pane. To do
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this, open the contextual menu within the pane itself by right-clicking on something in the Data
Model pane. Depending on where you've clicked, it can contain the following options:

« Add afield: Click to add a new field at the current level (record or detail table). Enter the
field name in the dialog and click OK to add it.

« Add a table: Click to add a new detail table at the current level (record or existing detail
table). Enter the table name in the dialog and click OK to add it.

« Default Value: Click to set the default value for a field. This value is used if no extraction
is present, or if an extraction attached to this field returns no value.

« Collapse Fields: Collapse the fields in the selected level.

« Expand Fields: Clicking the icon that represents collapsed fields (for example: & [197)
enables this menu item. It is used to expand the fields on one level.

« Collapse All Fields: Collapse the fields on the record level and in all detail tables.

« Expand All Fields: Expand the fields on the record level and in all detail tables.

Note

The following options are only available for Data Model fields or detail tables that are not filled via
an extraction.

Fields and detail tables that are filled via an Extract step are to be changed (renamed, deleted etc.)
via the properties of that Extract step; see: "Editing fields" on page 158 and "Renaming a detail
table" on page 193.

« Rename: Click to rename the selected table or field. Enter the new name and click OK to
rename.

+ Delete: Click to delete the selected table or field.

« Set Type: Use the list to select the field type (see "Data types" on page 168).

Field display

Fields in the Data Model pane are displayed in specific ways to simplify comprehension of the
display data:

« Value: The current value of the extracted field, based on the record shown in the Data
Viewer.
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« The column on the left displays the name of the field.

« The column on the right displays the current value of the extracted field based on the
record shown in the Data Viewer, if an Extract step has an extraction for this field (see
"Extracting data" on page 118).

« The icon to the left of the name indicates the data Type of the field (see "Data types" on
page 168).

« A field name with an asterisk to the right indicates that this field is part of an imported
Data Model file.

« Afield with a grey background indicates this Data Model field does not have any
attached extracted data.

« Afield with a white background indicates that the field has attached extracted data but
the step extracting the data is not currently selected.

« Afield with a blue background indicates that the field has attached extracted data and
the step extracting the data is currently selected.

Record navigation

Records can be navigated via the Data Model pane. The default record level navigates
between records both in the Data Model pane and the Data Viewer, while each detail table has
a similar navigation that influences that table and each detail table under it.

« Expand/Contract: Click to hide or show any fields or tables under the current table level.

« Table Name: Displays the name of the table as well as the number of records at that level
(in [brackets]). At the record level this is the number of records. In other levels it represents
the number of entries in a detail table.

« Number of Records: The number of available records in the active data sample. This is
affected by the Boundary settings (see "Record boundaries" on page 117 and "Settings
pane" on page 203) and the Preprocessor step ("Preprocessor step" on page 140).

« First Record: Go to the first record in the data sample. This button is disabled if the first
record is already shown.

« Previous Record: Go to the previous record in the data sample. This button is disabled if
the first record is shown.

« Current Record: Displays the current record or table entry. Type a record number and
press the Enter key to display that record. The number has to be within the number of
available records in the data sample.
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« Next Record: Go to the next record in the data sample. This button is disabled if the last
record is shown.

« Last Record: Go to the last record in the data sample. This button is disabled if the last
record is already shown. If a record limit is set in the Settings pane ("Settings pane" on
page 203) the last record will be within that limit.

Detail tables

A detail table is a field in the Data Model that contains a record set instead of a single value.
Detail tables contain transactional data. They are created when an Extract step is added within
a Repeat step; see "Extracting transactional data" on page 124.

In the most basic of transactional communications, a single detail table is sufficient. However, it
is possible to create multiple detail tables, as well as nested tables. Detail tables and nested
tables are displayed as separate levels in the Data Model (see "The Data Model" on page 151).

Renaming a detail table

Renaming detail tables is especially useful when there are more detail tables in one record, or
when a detail table contains another detail table. For this detail table, ‘products’ would be a
better name.

1. On the Data Model pane, click one of the fields in the detail table.

2. On the Step Properties pane, under Extraction Definition, in the Data Table field, you
can find the name of the detail table: record.detail by default. Change the detail partin
that name into something else.

Note

A detail table’s name should always begin with ‘record.’.

3. Click somewhere else on the Step Properties pane to update the Data Model. You will
see the new name appear.

Creating multiple detail tables

Multiple detail tables are useful when more than one type of transactional data is presentin the
source data, for example purchases (items with a set price, quantity, item number) and services
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(with a price, frequency, contract end date, etc).

i "Narme (XML) 52 =g
S NI TSEIVICE REDTESETILative)
<» Company [Rockwood Engine Systems)
<> Phane2 ((555) 330-6476, #235)
< Email [p.ludwick@oldrupa.com)
<> Language (EN)
4» MDS [C9B28FBAB37EGBAFE13C2C3EB0FDEBDE)
4 <» INVOICES (T n I
4 <> INVOICE m m m m m m
<» Number [INVE&103083)
<» Date [2013-03-15)
<» DueDate [2013-04-05)
<% Rep (REP0O290771)
<» SubTotal [ 74.90)
<» TaxTotal [ 11.22)
<» Total [ 86.12)
4 < PURCHASES [T—— T—— M= T T
<> Item [RT1485)
<> Description [Router)
< Qty (1)
<> Price (14.75)
<» SubTotal (14.75)
PURCHASES fT—+— T—— fM—— T T
<> Item (CBLS686)
<% Description [Cable)
< Oty @)
<> Price [3.96)
<> SubTotal (35.24)
4 <3 SERVICE [T 1 T n 1 T
4% Mumber [H5F75ME]
<> Description [HighSpeed FibreOptics 75MB/S Duplex)
<» BasePrice (84.95)
<> Rebates (-40.00
<» Charges (0)
<> SubTotal [44.95)
4 AccountNumber [1687635787)
<> UserName [u21CV342)
<> Type (Internet)
4 < SERVICE (T il T m il T Second Table
<> Mumber [PHBASICRES)
<» Description (Basic Residential Phone Service)
<> BasePrice (33.95)
<> Rebates (-14.32)
<» Charges (10.32)
<» SubTotal (29.95)
<» AccountNumber (22555380647622)
<> Userlame (r45g456h)
<» Type (Phone}

First Table

S
~

To create more than one detail table, simply extract transactional data in different Repeat steps
(see "Extracting transactional data" on page 124).

The best way to do this is to add an empty detail table (right-click the Data Model, select Add a
table and give the detail table a name) and drop the data on the name of that detail table.

Else the extracted fields will all be added to one new detail table with a default name at first,
and you will have to rename the detail table created in each Extract step to pull the detail tables
apart (see "Renaming a detail table" on the previous page).
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Settings |5, Steps = O || B "Name gLy 52 = B | pata model £ e =
o <> Phone2 ((555) 702-5520, £665) A1l Name Value
o <3 Email (atincher@oldrupa.com) 4 T record [3] =] 2[plH
<> Language (EN) sbe FULLNAME Amie Tincher
<> MD5 (BES479B97BEEOAE3970837291B7105C8) e ID CU44643835
H 4 <> INVOICES (T L abe Gender Miss
Extraction 4 ¢ INVOICE (T 1 1 1 1 1 T - - e LastName Tincher
<> Mumber (INV8539825) abe Firsthame Amie
= <> Date (2013-03-15) abe Address] 3536, Chambers Street
Extraction] S G RS e Address? P.0. Box 6049
= <> Rep (REP880D122) e City St. Mary's
== <> SubTotal ( 125.96) abe State ON
5 <> TaxTotal ( 18.86) abe Country CA
e <> Total ( 144.82) s ZipCode L&) 5L1
I@ 4 <> PURCHASES (T—— T—— T—= 1 1 ) abe Title Driver/Sales Workers
<> ltem (RT1483) sbe Company St. Mary's Pest Control Ltd
<> Description (Router) e Phone2 (555) 702-5520, #665
< Oty (1) abe Erail atincher@oldrupa.com
¢ Price (14.75) s Language EN
<> SubTotal (14.75) abc MD5 BE9479B978EEDAEIST0R...
4 <> PURCHASES (T—— T—— T—— 1 T ! axe Number INVB339825
<> Item (CBL366) abe Date 2013-03-15
<> Description (Cable) abe DueDate 2013-04-05
© Qty (3) e Rep REP2200122
<> Price (8.96) abe SubTotal 125.96
<> SubTotal (26.88) abe TaxTotal 18.86
4 <> PURCHASES (T—— T—— T—— 1 1 ) abe Total 144,82
<> ltem (FST3678)
<> Description (Fasteners)
<> Qty (50)
<» Price (0.25)
<> SubTotal (12.5)
a <3 SFRVICF (1 hll ki 1 T kU Al bt
< >
Step Properties| 1 Messages =]
"
Extract Step
» Description
~ Extraction Definition
Data Table: | record hd
w Append values to current record
v
Settings |1, Steps = O || [@ig *Name (XML) 22 = O || Data model [ ] 8
Ie) <> SubTotal (14.75) A Name Value
= 4 <> PURCHASES (T—— T—— T—— 1 1 ) 4 T record [3] ®i[4 HEE
4> Item (CBL3626) abe FULLNAME Amie Tincher
<> Description (Cable) e 1D CU4643835
< <« Quy (3) sbe Gender Miss
Extraction <> Price (8.96) abe LastName Tincher
<> SubTotal (26.88) e FirstName fria
4 <> PURCHASES (T—— T—— T—— 1 T 1 abe Addressl 336, Chambers Street
oo <> ltem (FST5678) abe Address2 P.0. Box 6049
<> Description (Fasteners) abe City St. Mary's
<> Qty (50) abe State ON
- <> Price (0.25) e Country CA
Repeat <> SubTotal (12.5) abe ZipCode L&) 5L1
asese|CPhoses a® ELEl ! ! ! ! ! 1 abe Title Driver/Sales Workers
H = <> Number (HSF75ME) ¢ Company St. Mary's Pest Control Ltd
H H <> Description (HighSpeed FibreOptics 75MB/S Duplex) Phone? (555) 702-5520, #665
8 Exraction? BascPrice (24.35) L =
3 4» baselrice (24, abe Email atincher@oldrupa.com
H <> Rebates (-40.00) sbe Language EN
§°°““E <> Charges (0) ab: MDS BEG479B978EEDAE3ST083...
<> SubTotal (44.95) ate Number INV8539825
= - <> AccountNumber (1687635787) e Date 2013-03-15
g" <> UserName (u21CY342) w DueDate 2013-04-05
= <> Type (Intemet) b Rep REP2800122
Repeat! 4 <> SERVICE (1 T 1 1 T 1 g e SubTotal 125.96
_— - <> Number (PHBASICRES) ) e TaxTotal 18.36
s [ <> Description (Basic Residential Phone Service) e Total 148582
§  Bdraction3 o [l RS 4 T detail [6] 1[B][E
<» Rebates (-14.32]
g =] iy (22323 abe ftem RT1485
B <> Charges (22.32) st Description  Router
I <» SubTotal (41.93) we Oty 1
<> AccountNumber (22555705552022) e Price 1475
T - <5 UserName (wdS7t478) . e SubTotal2 1475
@ < 3
] = abe Number2
g Step Properties| 1 Messages = sbe DescriptionZ
- st BasePrice
I@ Extract Step @ e Rebates
» Description abe Charges
ae SubTotal3
v Extraction Definition abe AccountNum
‘ . aie Userhlame
Data Table: | record.detai abe Type
v [] Append values to current record
< = o &
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Nested detail tables

Nested detail tables are used to extract transactional data that are relative to other data. They
are created just like multiple detail tables, with two differences:

« Forthe tables to be actually nested, the Repeat step and its Extract step that extract the
nested transactional data must be located within the Repeat step that extracts data to a
detail table.

« Intheir name, the dot notation (record.services) must contain one extra level
(record.services.charges).

Note

Using nested detail tables in the Designer module requires scripting, as described in this How-to:
Cloning your way through nested tables.

Example

An XML source file lists the services of a multi-service provider: Internet, Cable, Home Phone,
Mobile. Each service in turn lists a number of "charges", being service prices and rebates, and
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a number of "details" such as movie rentals or long distance calls.

XML viewer & 5 | Zoom(m) 100 [H L £ @

<» Rep (REP2200122) ~
¢» SubTotal ( 93.76)
¢» TaxTotal { 14.04)
<» Total { 107.80)
a <» SERVICE (T 1 1 T
<» MNumber (TVDIGHD)
<» Description (High Definition Digital TV)
<» BasePrice (30.00)
<» Rebates (-28.19)
¢<» Charges (67.23)
< BxtraServices (24.70)
<» AccountMumber (6784589574527852)
<3 SubTotal (39.08)
<x Type (Television)
a <» Charges (T T T )
4 <> CHARGE (1 T T
< |0 (RETVCRTCFAPL)
<» Description (Centribution to CRTC FAPL)
<» Price (-0.13)
4 <> CHARGE (T T T
< |0 (RBTVPROG)
<» Description (PROMO: Programming Credit)
<> Price (-14.20)
4 «» CHARGE (T T T
<» |0 (RETVHDBOX)
<» Description (PROMO: Free HD Receiver Rental)
<> Price (-13.86)
4 <> DETAILS (1 T T
la <> DETAIL (T T T
<» CODE (MVHDLOC)
<» |D [35123)
<» Description (Gangster Squad HD)
<» TimeStamp (2013-02-16 19:24:33)
<» Price (5.93)
la <> DETAIL (T T T
<» CODE (MVHDLOC)
< D (35234)
<+ Description (Indiana Jones: Raiders of the Lost Ark)
<» TimeStamp (2013-02-23 18:02:46)
<» Price (2.93)
la <> DETAIL (T T T
<» CODE (MVHDLOC)
< |0 (35343)

s 5 Necerintinn (lndiana loner and the Tarmnle of Do’
— — —

Data to be Nested
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The services can be extracted to a detail table called record.services.

B e = 51 [ "Name oML 22 = B |24 pata model wed 8570
£ || XML viewer & 15 | Zoomea 10 |0 © Name Value
i 4 7] record 3] H|< 3
INVOICERUN (T T ) a e FULLNAME Melba Lumpkin
|Fm 5 CUSTOMER (1 T T T T T T T 1 T A T A 1 A 1 A ) ae D CU35692808
H @ FULLNAME (Melba Lumpkin) e Gender Miss
Extraction <> ID (CU35692808) e LastName Lumpkin
<5 Gender (Miss) e FirstName Melba
<> LastName (Lumpkin) s Address] 564, Hidden Valley Drive
Exlraghum <» FirstName (Melba) abe Address2 Suite 9530
<5 Address1 (564, Hidden Valley Drive) e City Gore Bay
o= < Address2 (Suite 9530) e State oN
5 < City (Gore Bay) e Country ca
2 ¢5 State (ON) e ZipCode F3U 383
W < Country (CA) we Title Machine Tool Cutting Oper...
< ZipCode (F3U 583) e Company Gore Bay Game Group
¢5 Title (Machine Tool Cutting Operator/Tender) ¢ Phone2 (555) 631-670, #854
<> Company (Gore Bay Game Group) s Email muumpkin@oldrupa.com
< Phone2 ((555) 631-670, £854) e Language EN
<> Email (m.lumpkin@oldrupa.com) we MDS A376734A49841 ESFO4696FBE...
< Language (EN) s Number INVA839392
<3 MDS (A376734A49841E9F04GIGFBEGGCE04A3) e Date 2013-03-15
la <> INVOICES (1 1) s DueDate 2013-04-05
4 & INVOICE (T 1 1 1 1 1 1 1 1 ) = e REP8200122
<> Number (INV4839392) e SubTotal 9376
<> Date (2013-03-13) e TaxTotal 1404
< DueDate (2013-04-05) e Total 107.80

< Rep (REPS80D122)
<> SubTotal ( 93.76)
< TaxTotal { 14.04)
<> Total { 107.80)
4 <> SERVICE (T T T T T T T T T T
< Number (TVDIGHD)
<> Description (High Definition Digital TV)
<> BasePrice (30.00)
< Rebates (-28.19)
< Charges (67.25)
<> ExtraServices (24.70)
<> AccountNumber (6784589574527852)
<> SubTotal (39.06)
<> Type (Television)
4 ¢ Charges (1 1 1 )
4 < CHARGE (T 1 1 1 )
<> ID (RBTVCRTCFAPL)
<> Description (Contribution to CRTC FAPL)
< Price (-013)
« os ruARAE M Ll L] n \

Step Properties| 1 Messages m

The "charges" and "details" can be extracted to two nested detail tables.
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= O |[g *Name (XML) 52
£ | XML viewer

Settings |1, Steps

& 5 | Zoom(%) | 100

= O || pata model

L L e

"
4 ¢ INVOICH

<

H <>
Extraction ®
<
<
<
<

Rep
Sub

Extraction
Tot:

SER\
<
<
©
<
<
@
<
<

PR

==t

9000008

0950000

"Bl roeces,

S

TaxTotal (

E( 1 1 1 T T T T T )

Number (INV4839392)
Date (2013-03-15)
DueDate (2013-04-05)

(REP2300122)
Total ( 93.76)
14.04)
al ( 107.80)
WICE (T Al T T T T Al Al A
Number (TVDIGHD)
Description (High Definition Digital TV)
BasePrice (30.00)
Rebates (-28.19)
Charges (67.25)
ExtraServices (24.70)
AccountNumber (6784589574527852)
SubTotal (39.06)
Type (Television)
Charges (T 1 1 )
< CHARGE (1 1 1 1 )
<» ID (RBTVCRTCFAPL)
<> Description (Contribution to CRTC FAPL)
< Price (-0.13)
CHARGE (T 1 T Al )
<> ID (RBTVPROG)
< Description (PROMO: Programming Credit)
< Price (-14.20)
CHARGE (T T T T )
< ID (RBTVHDBOX)
<> Description (PROMO: Free HD Receiver Rental)
<> Price (-13.86)
DETAILS (T T L T T T n )
<> DETAIL (T Al T T Al T )
<> CODE (MVHDLOC)
< 1D (55123)
< Description (Gangster Squad HD)
<> TimeStamp (2013-02-16 1%:24:33)
< Price (595)
<> DETAIL (T Al T T Al T )
<> CODE (MVHDLOC)
< 1D (55234)
<> Description (Indiana Jones: Raiders of the Lost Ark)
<> TimeStamp (2013-02-23 1&:02:46)

4\ Drira 2001

A

Step Properties

i Messages

T e
Name Value
4 [ record [3] F< 3 I~
e FULLNAME Melba Lumpkin
we D CU35692808
e Gender WMiss
e LastName Lumpkin
s FirstName Melba
ave Address] 564, Hidden Valley Drive
e Address2 Suite 9530
e City Gore Bay
abe State ON
¢ Country cA
s ZipCode F3U 583
e Title Machine Tool Cutting Oper...
s Company Gore Bay Game Group
s Phone2 (555) 631-670, 2854
e Email m.lumpkin@oldrupa.com
e Language EN
e MD5 376734749841 ESFO4696FBE...
e Number INVA4839392
e Date 2013-03-15
we DueDate 2013-04-05
e Rep REPBB00122
e SubTotal 9376
we TaxTotal 1404
e Total 107.80
4 [T detail [1] 1
sse Number2 TVDIGHD
e Description  High Definition Digital TV
ave BasePrice 30.00
e Rebates -2819
e Charges 67.25
ae ExtraServices 2470
s AccountNumbe 6784589574527852
e SubTotal2 39.06
e Type Television

The nested tables can be called record.services.charges and record.services.details.

Settings |1, Steps = 01| "Name (xmL) 52 = O/} Data model el ST O
2 | XML viewer € 15 | Zoomg 100 0 £ @ || N Value
~ 4 = record [3] H[= 3
4 <> SERVICE (1 1 T 1 T T n n 1 T we FULLNAME Melba Lumpkin
< Number (TVDIGHD) e 1D Ccu3ses2eoe
H <> Description (High Definition Digital TV) e Gender Miss
Extraction <5 BasePrice (30.00) e LastName Lumpkin
=i <> Rebates (-28.1) e FirstName Melba
= <> Charges (67.25) e Address] 564, Hidden Valley Drive
G ¢ ExtraServices (24.70) e Address? Suite 9530
5 AccountNumber (§784589574527852) e City Gore Bay
o= <> SubTotal (39.06) e State oN
= <> Type (Television) we Country cA
Repeat 4 ¢ Charges (T T T ) e ZipCode F3U 583
= 4 & CHARGE (1 1 1 1 ) e Title Machine Tool Cutting Oper...
Cj. < ID (RBTVCRTCFARL) s Company Gore Bay Game Group
B <5 Description (Contribution to CRTC FAPL) = A (555) 631-670, #6854
< Price (-0.13) e Email mulumpkin@oldrupa.com
= 4 <> CHARGE (T 1 T 1 ) e Language EN
5 ¢ 1D (RBTVPROG) e MDS A376734A49841EGFO4596F BE...
Repeat] <> Description (PROMO: Programming Credit) ae Mumber INV4839392
e <> Price (-14.20) abe Date 2013-03-15
2000|[Gul 'o°°° 4 ¢ CHARGE (T 1 L 1 ) sc DueDate 2013-04-05
oo Bion ¢ ID (RETVHDBOX) e Rep REP8200122
<> Description (PROMOC: Free HD Receiver Rental) s SubTotal 9376
g < Price (-13.88) e TaxTotal 1404
- 4 ¢ DETAILS (T 1 L T 1 L 1 ) e Total 107.20
4 < DETAL (T 1 1 1 1 1 ) 4 T details [10] 1 [RE
B cooo <> CODE (MVHDLOG) v e Number2 TVDIGHD
o
g < e Description  High Definition Digital TV
= ax BasePrice 3000
Repeat> Step Properties| 1 Messages -8 abe Rebates -28.19
— Fggvmg P— ~ s Charges 6725
= w BtraServices 2470
Extractiond ) Fixed automation properties s AccountMumbe 6784589574527852
e SubTotal2 3906
= - i
Properties e Type Television
R w102
Name Scope Type Default Value 8 o -
e Description2
e Price
s CODE
abe D3
s Description3
~ Preprocessor s TimeStamp
s Pricel
Name Type B
v
< > hd
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Now one "charges" table and one "details" table are created for each row in the "services"
table.

The Data Viewer

The Data Viewer is located in the middle on the upper half of the DataMapper screen. It
displays the data source thatis currently loaded in the DataMapper, specifically one record in
that data. Where one record ends and the next starts, is setin the Data Source settings (see
"Record boundaries" on page 117). One record may contain more than one unit: PDF or Text
pages, XML nodes, CSV lines, etc.

When the Delimiter or Boundary options are set in the Settings pane, the Data Viewer reflects
those changes.

Any modification of the source data by a Preprocessor takes place before the data is displayed
in the Data Viewer (see "Preprocessor step" on page 140).

The Data Viewer lets you select data, extract them ("Extracting data" on page 118), and apply a
condition where necessary.

How data can be selected depends on the type of source file (see "Selecting data" on

page 122).

Once data is extracted, clicking on any Exiract step on the Steps pane highlights any area from
which it extracts data in the Data Viewer. You can click on the Preprocessor step to select all
the steps in the extaction workflow and highlight all extracted data.

Clicking on other step types also has a visible effect in the Data Viewer:

« Clicking on a Repeat step shows where the loop takes place.
«» Clicking on a Goto step shows where the cursor is moved.

« Clicking on a Condition step shows which data fulfil the condition.
For more information about the different steps that can be added to a data mapping workflow,
see "Steps" on page 140.

Data Viewer toolbar

The Data Viewer has a toolbar at the top to control options in the viewer. Which toolbar
features are available depends on the data source type.

« Font (Text file only): Use the drop-down to change the font used to display text. Useful for
double-byte data. It is recommended that monospace fonts be used.
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» Hide/Show line numbers # (Textfile only): Click to show or hide the line numbers on
the left of the Data Viewer.

« Hide/Show datamap ¢: Click to show or hide the icons to the left of the Data Viewer
which displays how the steps affect the line.

« Hide/Show extracted data i: Click to show or hide the extraction selections indicating
that data is extracted. This simplifies making data selections in the same areas and is
useful to display the original data.

« Lock/Unlock extracted data -: Click to lock existing extraction selections so they
cannot be moved or resized. This simplifies making data selections in the same area.

o Zoom Level: Use the arrows to adjust the zoom level, or type in the zoom percentage.
o Zoom In (CTRL +) : Click to zoom in by increments of 10%

o Zoom Out (CTRL -) /2: Click to zoom out by increments of 10%

Additional Keyboard Shortcuts for XML Files:

e + (while on an XML node with children): Expand the XML Node

e - (while on an XML node with children): Collapse the XML node, hiding all its children
nodes.

Contextual Menu

You can access the contextual menu using a right-click anywhere inside the Viewer window.

Add Extraction Fo

Add Goto F7

Add Conditional F8

Add Repeat Fa

Add Action E11

Add Extract Field F10
Note

The Add Extract Field item is available only after an Extract step has been added to the
workflow.
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Messages pane

The Messages pane is shared between the DataMapper and Designer modules and displays
any warnings and errors from the data mapping configuration or template.

At the top of the Message pane are control buttons:

« Export Log: Click to open a Save As dialog where the log file (.log) can be saved on
disk.

» Clear Log Viewer: Click to remove all entries in the log viewer.
« Filters: Displays the Log filter (see "Log filter" below).

« Activate on new events: Click to disable or enable the automatic display of this dialog
when a new event is added to the pane.

o Time: The date and time when the error occurred.
o Type: Whether the entry is a warning or an error.

« Source: The source of the error. This indicates the name of the step as defined in its step
properties.

« Message: The contents of the message, indicating the actual error.

Log filter

The log filter determines what kind of events are show in the Messages pane (see "Messages
pane" above).

« Event Types group:
« OK: Uncheck to hide OK-level entries.
« Information: Uncheck to hide information-level entries.
« Warning: Uncheck to hide any warnings.
« Error: Uncheck to hide any critical errors.

« Limit visible events to: Enter the maximum number of events to show in the Messages
Pane. Defaultis 50.
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Settings pane

Settings for the data source and a list of Data Samples and JavaScript files used in the current
data mapping configuration, can be found on the Settings tab at the left. The available options

depend on the type of data sample that is loaded.

The Input Data settings (especially Delimiters) and Boundaries are essential to obtain the data
and eventually, the output that you need. For more explanation, see "Data source settings" on

page 115.

Input Data

The Input Data settings specify how the input data must be interpreted. These settings are
different for each data type. For a CSV file, for example, it is important to specify the delimiter
that separates data fields. PDF files are already delimited naturally by pages, so the input data
settings for PDF files are interpretation settings for text in the file.

CSV file Input Data settings

Ina CSV file, data is read line by line, where each line can contain multiple fields. The input
data settings specify to the DataMapper module how the fields are separated.

« Field separator: Defines what character separates each field in the file. Even though
CSV stands for comma-separated values, CSV can actually refer to files where fields are
separated using any character, including commas, tabs, semicolons, and pipes.

« Text delimiter: Defines what character surrounds text in the file, preventing the Field
separator from being interpreted within those text delimiters. This ensures that, for
example, the field “Smith; John” is not interpreted as two fields, even if the field delimiter
is the semicolon.

« Comment delimiter: Defines what character starts a comment line.

« Encoding: Defines what encoding is used to read the Data Source ( US-ASCII, ISO-
8859-1, UTF-8, UTF-16, UTF-16BE or UTF-16LE ).

e Lines to skip: Defines a number of lines in the CSV that will be skipped and not used as
records.

« Set tabs as a field separator: Overwrites the Field separator option and sets the Tab
character instead for tab-delimited files.

+ First row contains field names: Uses the first line of the CSV as headers, which
automatically names all extracted fields.
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« Ignore unparseable lines: Ignores any line that does not correspond to the settings
above.

PDF file Input Data settings

PDF Files have a natural, static delimiter in the form of pages, so the options here are
interpretation settings for text in the PDF file.

The Input Data settings for PDF files determine how words, lines and paragraphs are detected
in the PDF when creating data selections.

Each value represents a fraction of the average font size of text in a data selection, meaning
"0.3" represents 30% of the height or width.

« Word spacing: Determines the spacing between words. As PDF text spacing is
somehow done through positioning instead of actual text spaces, text position is what is
used to find new words. This option determines what percentage of the average width of a
single character needs to be empty to consider a new word has started. The default value
is 0.3, meaning a space is assumed if there is a blank area of 30% of the width of the
average character in the font.

« Line spacing: Determines the spacing between lines of text. The default value is 1,
meaning the space between lines must be equal to at least the average character height.

« Paragraph spacing: Determines the spacing between paragraphs. The default value is
1.5, meaning the space between paragraphs must be equal to at least 1.5 times the
average character height to start a new paragraph.

« Magic number: Determines the tolerance factor for all of the above values. The tolerance
is meant to avoid rounding errors. If two values are more than 70% away from each other,
they are considered distinct; otherwise they are the same. For example, if two characters
have a space of exactly the width of the average character, any space of between 0.7 and
1.43 of this average width is considered one space. A space of 1.44 is considered to be 2
spaces.

« PDF file color space: Determines if the PDF if displayed in Color or Monochrome in the
Data Viewer. Monochrome display is faster in the Data Viewer. This has no influence on
the actual data extraction or the data mapping performance.

Database Input Data settings

Databases all return the same type of information. Therefore the Input Data options for a
database refer to the database itself instead of to the data.
The following settings apply to any database or ODBC Data Sample.
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« Connection String: Displays the connection string used to access the Data Source.

« Table: Displays the tables and stored procedures available in the database. The selected
table is the one the data is extracted from. Clicking on any of the tables shows the first line
of the data in that table.

« Encoding: Defines what encoding is used to read the Data Source ( US-ASCII, ISO-
8859-1, UTF-8, UTF-16, UTF-16BE or UTF-16LE ).

« Browse button (=: Opens the Edit Database configuration dialog, which can replace
the existing database data source with a new one. This is the same as using the Replace
feature in the Data Samples window.

o Custom SQL button (z: Click to open the SQL Query Designer (see "SQL Query
Designer" on page 213) and type in a custom SQL query. If the database supports stored
procedures, including inner joins, grouping and sorting, you can use custom SQL to make
a selection from the database, using whatever language the database supports.

Text file Input Data settings

Because text files have many different shapes and sizes, there are many options for the input
data in these files.

« Encoding: Defines what encoding is used to read the Data Source ( US-ASCII, ISO-
8859-1, UTF-8, UTF-16, UTF-16BE or UTF-16LE ).

« Selection/Text is based on bytes: Check for text files that use double-bytes characters
(resolves width issues in some text files).

« Add/Remove characters: Defines the number of characters to add to, or remove from,
the head of the data stream. The spin buttons can also increment or decrement the value.
Positive values add blank characters while negative values remove characters.

« Add/Remove lines: Defines the number of lines to add to, or remove from, the head of
the data stream. The spin buttons can also increment or decrement the value. Positive
values add blank lines while negative values remove lines.

o Maximum line length: Defines the number of columns on a data page. The spin buttons
can also increment or decrement the value. The maximum value for this option is 65,535
characters. The default value is 80 characters. You should tune this value to the longest
line in your input data. Setting a maximum data line length that greatly exceeds the length
of the longest line in your input data may increase execution time.

« Page delimiter type: Defines the delimiter between each page of data. Multiples of such
pages can be part of a record, as defined by the Boundaries.
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« On lines: Triggers a new page in the Data Sample after a number of lines.

« Cut on number of lines: Triggers a new page after the given number of lines.
With this number set to 1, and the Boundaries set to On delimiter, it is possible
to create a record for each and every line in the file.

« Cuton FF: Triggers a new page after a Form Feed character.

« On text: Triggers a new page in the Data Sample when a specific string is found in
a certain location.

« Word to find: Compares the text value with the value in the data source.
« Match case: Activates a case-sensitive text comparison.

« Location: Choose Selected area or Entire width to use the value of the
current data selection as the text value.

« Left/Right: Use the spin buttons to set the start and stop columns to the
current data selection (Selected area) in the record.

« Lines before/after: This option places the delimiter a certain number of lines
before or after the current line. This is useful if the text that triggers the
delimiter is not on the first line of each page.

« Text from right to left: Sets the writing direction of the data source to right-to-left.

« Expand tabs to spaces: Replaces tabs with the given number of spaces.

XML File Input Data settings

For an XML file you can either choose to use the root node, or select an element type, to create
a new delimiter every time that element is encountered.

« Use root element: Locks the XML Elements option to the top-level element. No other
boundaries can be set. If there is only one top-level element, there will only be one record.

o XML elements: Displays a list containing all the elements in the XML file. Selecting an
element causes a new page of data to be created every time an instance of this element
is encountered.

Note

The information contained in all of the selected parent nodes will be copied for each
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instance of that node. For example, if a client node contains multiple invoice nodes, the
information for the client node can be duplicated for each invoice.

The DataMapper only extracts elements for which at least one value or attribute value is
defined in the file.

Boundaries

Boundaries are the division between records: they define where one record ends and the next
record begins; for an explanation see "Record boundaries" on page 117.

CSV or Database file boundaries

Since database data sources are structured the same way as CSV files, the options for these
file types are identical.

« Record limit: Defines how many records are displayed in the Data Viewer. This does not
affect output production; when generating output, this option is ignored. To disable the
limit, use the value 0 (zero).

« Line limit: Defines the limit of detail lines in any detail table. This is useful for files with a
high number of detail lines, which in the DataMapper interface can slow down things.
This does not affect output production; when generating output, this option is ignored. To
disable the limit, use the value 0 (zero).

» Trigger: Defines the type of rule that controls when a boundary is set, creating a new
record.

« Record(s) per page: Defines a fixed number of lines in the file that go in each
record.

« Records: The number of records (lines, rows) to putin each record.

« On change: Defines a new record when a specific field (Field name) has a new
value.

« Field name: Displays the fields in the top line. The boundaries are set on the
selected field name.

« On script: Defines the boundaries using a custom JavaScript. For more information
see "Setting boundaries using JavaScript" on page 257.
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« On field value: Sets a boundary on a specific field value.

« Field name: Displays the fields in the top line. The value of the selected field
is compared with the Expression below to create a new boundary.

« Expression: Enter the value or Regular Expression to compare the field
value to.

« Use Regular Expression: Treats the Expression as a regular expression
instead of static text. For more information on using Regular Expressions
(regex), see the Regular-Expressions.info Tutorial.

PDF file boundaries

For a PDF file, Boundaries determine how many pages are included in each record. You can
set this up in one of three ways: by giving a static number of pages; by checking a specific area
on each page for text changes, specific text, or the absence of text; or by using an advanced
script.

« Record limit: Defines how many records are displayed in the Data Viewer. To disable the
limit, use the value 0 (zero).

« Trigger: Defines the type of rule that controls when a boundary is set, creating a new
record.

« On page: Defines a boundary on a static number of pages.
« Number of pages: Defines how many pages go in each record.
« On text: Defines a boundary on a specific text comparison.

« Start coordinates (x,y): Defines the left and top coordinates of the data
selection to compare with the text value.

« Stop coordinates (x,y): Defines the right and bottom coordinates.

« Use Selection: Select an area in the Data Viewer and click the Use selection
button to set the start and stop coordinates to the current data selection.

Note

In a PDF file, all coordinates are in millimeters.

« Times condition found: When the boundaries are based on the presence of
specific text, you can specify after how many instances of this text the
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boundary can be effectively defined. For example, if a string is always found
on the first and on the last page of a document, you could specify a number of
occurrences of 2. This way, there is no need to inspect other items for whether
itis on the first page or the last page. Having found the string two times is
enough to set the boundary.

« Pages before/after: Defines the boundary a certain number of pages before
or after the current page. This is useful if the text triggering the boundary is not
located on the first page of the record.

« Operator: Selects the type of comparison (for example, "contains").
« Word to find: Compares the text value with the value in the data source.

« Match case: Makes the text comparison case-sensitive.

Text file boundaries

For a text file, Boundaries determine how many 'data pages' are included in each record. These
don't have to be actual pages, as is the case with PDF files. The data page delimiters are setin
the "Text file Input Data settings" on page 205.

« Record limit: Defines how many records are displayed in the Data Viewer. This does not
affect output production; when generating output, this option is ignored. To disable the
limit, use the value 0 (zero).

« Selection/Text is based on bytes: Select this option for text records with fixed width
fields whose length is based on the number of bytes and not the number of characters.

» Trigger: Defines the type of rule that controls when a boundary is set, creating a new
record.

« On delimiter: Defines a boundary on a static number of pages.

« Occurrences: The number of times that the delimiter is encountered before
fixing the boundary. For example, if you know that your documents always
have four pages delimited by the FF character, you can set the boundaries
after every four delimiters.

« On text: Defines a boundary on a specific text comparison.
e Location:
« Selected area:

+ Select the area button: Uses the value of the current data
selection as the text value. Making a new selection and clicking on
Select the area will redefine the location.
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« Left/Right: Defines where to find the text value in the row.

« Top/Bottom: Defines the start and end row of the data selection to
compare with the text value.

« Entire width: Ignores the column values and compares using the whole
line.

« Entire height: Ignores the row values and compares using the whole
column.

« Entire page: Compares the text value on the whole page. Only available
with contains,not contains,is emptyandis not empty
operators.

« Times condition found: When the boundaries are based on the presence of
specific text, you can specify after how many instances of this text the
boundary can be effectively defined. For example, if a string is always found
on the first and on the last page of a document, you could specify a number of
occurrences of 2. This way, there is no need to inspect other items for whether
itis on the first page or the last page. Having found the string two times is
enough to set the boundary.

« Delimiters before/after: Defines the boundary a certain number of data pages
before or after the current data page. This is useful if the text triggering the
boundary is not located on the first data page of the record.

« Operator: Selects the type of comparison (for example, "contains").
« Word to find: Compares the text value with the value in the data source.

« Use selected text button: copies the text in the current selection as the one to
compare to it.

« Match case: Makes the text comparison case-sensitive.

« On script: Defines the boundaries using a custom JavaScript. For more information
see "Setting boundaries using JavaScript" on page 257.

XML file boundaries

The delimiter for an XML file is a node. The Boundaries determine how many of those nodes go
in one record. This can be a specific number, or a variable number if the boundary is to be set
when the content of a specific field or attribute within a node changes (for example when the
invoice number field changes in the invoice node).
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« Record limit: Defines how many records are displayed in the Data Viewer. This does not
affect output production; when generating output, this option is ignored. To disable the
limit, use the value 0 (zero).

« Trigger: Defines the type of rule that controls when a boundary is set, creating a new
record.

« On Element: Defines a new record on each new instance of the XML element
selected in the Input Data settings.

+ Occurrences: The number of times that the element is encountered before
fixing the boundary.

« On Change: Defines a new record when a specific field or attribute in the XML
element has a new value.

« Field: Displays the fields and (optionally) attributes in the XML element. The
value of the selected field determines the new boundaries.

« Also extract element attributes: Check this option to include attribute values
in the list of content items that can be used to trigger a boundary.

Data samples

The Data Sample area displays a list of all the imported Data Samples that are available in the
current data mapping configuration. As many Data Samples as necessary can be imported to

properly test the configuration.
Only one of the data samples - the active data sample - is shown in the Data Viewer.

A number of buttons let you manage the Data Samples.
In addition to using the buttons listed below, you can right-click a file to bring up the context

menu, which offers the same options plus the Copy and Paste options.

Tip
Data samples can be copied and pasted to and from the Settings pane using Windows File
Explorer.

o Add | 4: Add a new Data Sample from an external data source. The new Data Sample
will need to be of the same data type as the current one. For example, you can only add
PDF files to a PDF data mapping configuration. Multiple files can be added
simultaneously.
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» Delete  _: Remove the current Data Sample from the data mapping configuration.

« Replace #: Open a Data Sample and replace it with the contents of a different data
source.

« Reload ©: Reload the currently selected Data Sample and any changes that have been
made to it.

. Setas Active = : Activates the selected Data Sample. The active data sample is shown
in the Data Viewer after it has gone through the Preprocessor step as well as the Input
Data and Boundary settings.

External JS Libraries

Right-clicking in the box brings up a control menu, with the same options as are available
through the buttons on the right.

o Add | #: Add a new external library. Use the standard Open dialog to browse and open
the .js file.

« Delete .: Remove the currently selected library from the data mapping configuration.
« Replace # : Open a library and replace it with the contents of a different js file.

« Reload ©: Reload the currently selected library and any changes that have been made
to it.

Default Data Format

The Default Data Format settings defined here apply to any new extraction in made in the
current data mapping configuration. Any format already defined for an existing field remains
untouched.

Itis also possible to set a default format for dates and currencies in the user preferences
("Datamapper preferences" on page 703).

Specific settings for a field that contains extracted data are made via the properties of the
Extract step that the field belongs to (see "Editing fields" on page 158).

Negative Sign Before : A negative sign will be displayed before any negative value.

Decimal Separator : Set the decimal separator for a numerical value.

Thousand Separator : Set the thousand separator for a numerical value.

Currency Sign : Set the currency sign for a currency value.

Date Format : Set the date format for a date value.
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« Date Language : Set the date language for a date value (ex: If English is selected, the
term May will be identified as the month of May).

« Treat empty as 0 : A numerical empty value is treated as a 0 value.

Note

Default data formats tell the DataMapper how certain types of data are formatted in the data

source. They don't determine how these data are formatted in the Data Model or in a template. In
the Data Model, data are converted to the native data type. Dates, for example, are converted to a
DateTime object in the Data Model, and will always be shown as "year-month-day" plus the time
stamp, for example: 2012-04-11 12.00 AM.

SQL Query Designer

The SQL Query Designer is used to design a custom SQL query to pull information from a
database. It can be opened via the Settings pane when extracting data from a database.

« Tables: Lists all tables and stored queries in the database.

« Custom Query: Displays the query that retries information from a database. Each
database type has their own version of the SQL query language. To learn how to build
your own query, please refer to your database's user manual.

« Test Query button +: Click to test the custom query to ensure it will retrieve the
appropriate information.

« Results: Displays the result of the SQL query when clicking on Test Query.
Steps pane

The Steps tab displays the data mapping workflow: the process that prepares and extracts data.
The process contains multiple distinct steps and is run for each of the records in the source
data. For more information about the steps and how to use them, please refer to Steps and
"Data mapping workflow" on page 113.

Page 213

PlanetPress.
Connect



Moving a step

To rearrange steps, simply drag & drop them somewhere else on the dotted line in the Steps
pane.

Alternatively you can right-click on a step and select Cut Step or use the Cut s£ button in the
Toolbar. If the step is Repeat or Condition, all steps under it will also be placed in the
clipboard. To place the step at its destination, right-click the step in the position before the
desired location and click Paste Step, or use the Paste [&] button in the toolbar.

Viewing step details

Hovering over the task shows a tooltip that displays some of the details of that step. To see all
details for a step, click on the step and take a look at the Step properties pane ("Step properties
pane" on the next page.

Clicking on any Extract step in the Steps pane highlights any area in the Data Viewer from
which it extracts data.

You can also click on the Preprocessor step to select all the steps in the workflow to show a
complete map of all the extracted data.

Window controls

The following controls appear at the top of the Steps pane:

« Zoom In (CTRL +) : Click to zoom in by increments of 10%

o Zoom Out (CTRL -)./2: Click to zoom out by increments of 10%

Contextual menu

You can access the contextual menu using a right-click anywhere inside the Steps pane.

« Add a Step: Adds a step to the process. More options are available when a Repeat or a
Condition step is selected:

« Add Step in Repeat: Adds a step to a Repeat loop.

o Add Step in True: Adds a step to the True branch of a condition step.

« Add Step in False: Adds a step under the False branch of a condition step.
« Add Multiple Conditions Step: Adds a Multiple Conditions step.
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« Add Case Step: Adds a Case condition under the selected Multiple Conditions
step.

« Ignore Step: Click to set the step to be ignored (aka disabled). Disabled steps are grayed
and do not run, neither in the DataMapper nor when the data mapping configuration is
executed in Workflow. However, they can still be modified normally.

« Delete Step: To remove a step, right-click on it and select Delete step from the contextual
menu or use the Delete % button in the Toolbar. If the step to be deleted is Repeat or
Condition, all steps under it will also be deleted.

« Copy/Paste Step: To copy a step, right-click on it and select Copy Step or use the &
button in the Toolbar. If the step is Repeat or Condition, all steps under it will also be
placed in the clipboard. To paste the copied step at its destination, right-click the step in
the position before the desired location and select Paste Step, or use the [& button in the
Toolbar.

Step properties pane

The Step Properties pane is used to adjust the properties of each step in the process. The pane
is divided in a few subsections depending on the step and the data type. It always contains a
subsection to name and document the selected step.

Note

Step properties may also depend on the data sample's file type.

» "Preprocessor step properties" on the facing page

» "Settings for location-based fields in a Text file" on page 221
« "Textand PDF Files" on page 226

« "Textand PDF Files" on page 233

« "Condition step properties" on page 238

» "Left operand, Right operand" on page 241

« "Textfile" on page 244

« "JavaScript" on page 249
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Preprocessor step properties

The Preprocessor step does not run for every record in the source data. It runs once, at the
beginning of the extraction workflow, before anything else; see "Preprocessor step” on
page 140.

The properties described below become visible in the Step properties pane when the
Preprocessor step is selected in the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Fixed Automation Properties

The Fixed automation properties subsection lists all the fixed properties available from the
PlanetPress Workflow automation module. These properties are equivalent to data available
within the PlanetPress Workflow process. For each property, the following is available:

« Name: A read-only field displaying the name of the property.
« Scope: A read-only field indicating that the scope of the property is Automation.
« Type: A read-only field indicating the data type for each property.

« Default Value: Enter a default value for the property. This value is overwritten by the
actual value coming from PlanetPress Workflow when the data mapping configuration is
run using the Execute Data Mapping task.

There are currently the following automation properties available:
« JobInfoX: These properties are the equivalent of the Joblinfo values available in the

PlanetPress Workflow process. They can be set using the Set Job Info and Variables
task. To access these properties inside of any JavaScript code within the Data Mapping
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Configuration, use the automation.joblnfos.JobInfoX (where X is the job info number, from
010 9).

« OriginalFilename: This property contains the original file name that was captured by the
PlanetPress Workflow process and is equivalent to the %o variable in the process. To
access these property inside of any JavaScript code within the Data Mapping
Configuration, use automation.properties.OriginalFilename.

« ProcessName: This property contains the name of the process that is currently executing
the data mapping configuration and is equivalent to the %w variable in the process. To
access this property inside of any JavaScript code within the Data Mapping
Configuration, use automation.properties.ProcessName.

« TaskIndex: This property contains the index (position) of the task inside the process that
is currently executing the data mapping configuration but it has no equivalentin
PlanetPress Workflow. To access this property inside of any JavaScript code within the
Data Mapping Configuration, use automation.properties.ProcessName.

Properties

The Properties subsection is used to create specific properties that are used throughout the
workflow. Properties can be accessed through some of the interface elements such as the
Condition and Repeat step properties, or in scripts, through the "DataMapper Scripts API" on
page 252.

Note

Properties are evaluated in the order they are placed in the list, so properties can use the
values of previously defined properties in their expression.

« Name: The name of the property used to refer to its value.
« Scope: What this property applies to:

« Entire Data: These properties are static properties that cannot be changed once
they have been set, in other words they are Global constants.

« Each Record: These properties are evaluated and set at the beginning of each
Source Record. These properties can be modified once they have been set, but are
always reset at the beginning of each Source Record.
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« Automation variable: These properties initialize variables coming from the
PlanetPress Workflow automation tool. The name of the property needs to be the
same as the variable name in Workflow, and they can be either a Local variable or a
Global variable. For either one, only the actual name is to be used, so for %
{MyLocalVar} use only MyLocalVar , and for %{global.MyGlobalVar} use
MyGlobalVar. If a global and a local variable have the same name ( %{myvar} and
%{global.myvar} ), the local variable's value is used and the global one is ignored.
To access a workflow variable inside of any JavaScript code within the Data
Mapping Configuration, use automation.variables.variablename

« Type: The data type of the property. For more information see "Data types" on page 168.

« Default Value: The initial value of the property. This is a JavaScript expression. See
"DataMapper Scripts API" on page 252.

Note

Entire Data Properties are evaluated before anything else, such as Preprocessors,
Delimiters and Boundaries in the Settings pane (see "Data source settings" on

page 115). This means these properties cannot read information from the data sample or
from any records. They are mostly useful for static information such as folder locations or
server addresses.

Preprocessor

The Preprocessor subsection defines what preprocessor tasks are performed on the data file
before itis handed over to the data mapping workflow. Preprocessor tasks can modify the data
file in many ways, and each task runs in turn, using the result of the previous one as an input.

« Name: The name to identify the Preprocessor task.

« Type: The type of Preprocessor task. Currently there is only one type available: script.

Preprocessor definition

« Expression: Enter the JavaScript code to be performed on the data file. See
"DataMapper Scripts API" on page 252.
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Extract step properties

The Extract step takes information from the data source and places itin the record set that is
the result of the extraction workflow. For more information see "Extract step" on page 142 and
"Extracting data" on page 118.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Extraction Definition

« Data Table: Defines where the data will be placed in the extracted record. The root table
is record, any other table inside the record is a detail table. For more information see
"Extracting transactional data" on page 124.

o Append values to current record: When the Extract step is inside a loop, check this to
ensure that the extraction will be done in the same detail table as any previous

extractions within the same loop. This ensures that, if multiple extracts are present, only
one detail table is created.

Field Definition

The following field definition settings are identical for all fields.

« Field List: The Field List displays each of the single fields that belong to the selected
step in a drop-down. Fields can be re-ordered and re-named within the Order and rename
fields dialog (see "Order and rename fields dialog" on page 224). Select one of the fields
to make further settings for that field.

« Add Unique ID to extraction field: Check to add a unique numerical set of characters to
the end of the extracted value. This ensures no two values are identical in this field in the
record set.
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« Mode: Determines the origin of the data. Fields always belong to an Extract step, but they
don't necessarily contain extracted data. See "Fields" on page 155 for more information.

+ Location: The contents of the data selection determine the value of the extracted
field. The settings for location-based fields are listed separately, per file type:

» "Settings for location-based fields in a Text file" on the next page

» "Settings for location-based fields in a PDF File" on the next page

» "Settings for location-based fields in CSV and Database files" on page 222
» "Settings for location-based fields in an XML File" on page 223

« JavaScript : The result of the JavaScript Expression written below the drop-down
will be the value of the extracted field. If the expression contains multiple lines, the
last value attribution (variable = "value";) will be the value. See DataMapper API.

« Use JavaScript Editor: Click to display the Script Editor dialog.

« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

+ Use selection: Click to use the value of the current data selection for the
extraction.

Note

If the selection contains multiple lines, only the first line is selected.

« Properties: The value of the property selected below will be the value of the
selected field.

e Property: This drop-down lists all the currently defined properties (including
system properties).
Custom properties can be defined in the Preprocessor step; see
"Preprocessor step" on page 140.
For an explanation of the objects to which the properties belong, see
"DataMapper Scripts API" on page 252.

« Choose a property button: Click this button to open a filter dialog that lets you
find a property based on the first few letters that you type.
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« Type: The data type of the selected data; see "Data types" on page 168. Make sure that
the data format that the DataMapper expects matches the actual format of the data in the
data source; see "Data Format" on page 223.

Settings for location-based fields in a Text file

 Left: Defines the start of the data selection to extract.
« Right: Defines the end of the data selection to extract.
» Top offset: The vertical offset from the current pointer location in the Data Viewer).

« Height: The height of the selection box. When set to 0, this instructs the DataMapper to
extract all lines starting from the given position until the end of the record and store them
in a single field.

« Use selection: Click to use the value (Left, Right, Top offset and Height) of the current
data selection (in the Data Viewer) for the extraction.

Note

If the selection contains multiple lines, only the first line is extracted.

« Post Function: Enter a JavaScript expression to be run after the extraction.
A Post function script operates directly on the extracted data, and its results replace the
extracted data. For example, the Post function script replace ("-", ""); would replace
the first dash character that occurs inside the extracted string.

« Use JavaScript Editor: Click to display the Script Editor dialog.
« Trim: Select to trim empty characters at the beginning or the end of the field.
« Concatenation string:

« Split: Separate the selection into individual fields based on the Concatenation string
defined above.

Settings for location-based fields in a PDF File

These are the settings for location-based fields in a PDF file.
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« Left: Defines the start of the data selection to extract.
« Right: Defines the end of the data selection to extract.

« Top offset: The vertical offset from the current pointer location in the Data Sample
(Viewer).

« Height: The height of the selection box.

« Use selection: Click to use the value (Left, Right, Top offset and Height) of the current
data selection for the extraction.

Note

If the selection contains multiple lines, the lines are by default joined and extracted
into one field. To split the lines, select the option Split lines (see below).

« Post Function: Enter a JavaScript expression to be run after the extraction. For example
replace ("-","") would replace a single dash character inside the extracted string.

« Trim: Select to trim empty characters at the beginning or the end of the field.

« Type: The data type of the selected data; see "Data types" on page 168. If the selected
data is split (see below), this setting is applied to the first extracted field. Make sure that
the data format that the DataMapper expects matches the actual format of the data in the
data source; see "Data Format" on the next page.

« Split:
« Split lines: Separate a multi-line selection into individual fields .

« Join lines: Join the lines in the selection with the Concatenation string defined
below.

« Concatenation string: The (HTML) string used to concatenate lines when they are
joined.

Settings for location-based fields in CSV and Database files

These are the settings for location-based fields in CSV and Database files.

« Column: Drop-down listing all fields in the Data Sample, of which the value will be used.

« Top offset: The vertical offset from the current pointer location in the Data Sample
(Viewer).
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+ Use selection: Click to use the value of the current data selection for the extraction.

Note

If the selection contains multiple lines, only the firstline is selected.

o Post Function: Enter a JavaScript expression to be run after the extraction. For example
replace("-","") would replace a single dash character inside the extracted string.

« Use JavaScript Editor: Click to display the Script Editor dialog.

« Trim: Select to trim empty characters at the beginning or the end of the field.

Settings for location-based fields in an XML File

These are the settings for location-based fields in an XML file.

« XPath: The path to the XML field that is extracted.

+ Use selection: Click to use the value of the current data selection for the extraction.

Note

If the selection contains multiple lines, only the firstline is selected.

« Post Function: Enter a JavaScript expression to be run after the extraction. For example
replace("-","") would replace a single dash character inside the extracted string.

« Use JavaScript Editor: Click to display the Script Editor dialog.

« Trim: Select to trim empty characters at the beginning or the end of the field.

Data Format

Format settings can be defined in three places: in the user preferences ("Datamapper
preferences" on page 703), the current data mapping configuration ("Data format settings" on
page 118) and per field via the Step properties.

Any format settings specified per field are always used, regardless of the user preferences or
data source settings.
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Note

Data format settings tell the DataMapper how certain types of data are formatted in the data
source. They don't determine how these data are formatted in the Data Model or in a template. In
the Data Model, data are converted to the native data type. Dates, for example, are converted to a

DateTime object in the Data Model, and will always be shown as "year-month-day" plus the time
stamp, for example: 2012-04-11 12.00 AM.

« Negative Sign Before : A negative sign will be displayed before any negative value.
« Decimal Separator : Set the decimal separator for a numerical value.

« Thousand Separator : Set the thousand separator for a numerical value.

« Currency Sign : Set the currency sign for a currency value.

» Date Format : Set the date format for a date value.

« Date Language : Set the date language for a date value (ex: If English is selected, the
term May will be identified as the month of May).

« Treat empty as 0 : A numerical empty value is treated as a 0 value.

Order and rename fields dialog

The Order and rename fields dialog displays the extracted fields in the currently selected
Extract step.
To open it, first select an Extract step on the Steps pane. Then, on the Step properties pane,
under Field Definition, click the Order and Rename Fields button “+* next to the Field List drop-
down.

Step Properties 1 Messages - O

~
+ Field Definition

Field List: Number ~|

[]Add Unique ID to extraction field

Field extractions are executed from top to bottom.
In JavaScript-based fields, it is possible to refer to previously extracted fields if they are
extracted higher in this list or in previous Extract steps in the extraction workflow.
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« Name: The name of the field. Click the field name and enter a new name to rename the
field.

Note

If you intend to use the field names as metadata in a PlanetPress Workflow
process, do not add spaces to field names, as they are not permitted in metadata
field names.

Value: Displays the value of the extract field in the current Record.

Remove button '&: Click to remove the currently selected field.

Move Up button ¥": Click to move the selected field up one position.

o Move Down button #: Click to move the selected field down one position.

Action step properties

The Action step can run multiple specific actions one after the other in order; see "Action step"
on page 149 for more information.

The properties of an Action step become visible in the Step properties pane when the Action
step is selected on the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Actions

This subsection lists all actions executed by the step, and their types.
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« Name: A name by which to refer to the action. This name has no impact on functionality.
o Type:

« Set property: Sets the value of a record property which was created in the
Preprocessor step (see "Preprocessor step" on page 140).

« Run JavaScript : Runs a JavaScript expression, giving much more flexibility over
the extraction process.

« Stop Processing Record: When this option is selected, the extraction workflow
stops processing the current record and moves on to the next one.
If fields were already extracted prior to encountering the Action step, then those
fields are stored as usual.
If no fields were extracted prior to encountering the Action step, then no trace of the
record is saved in the database at run time.

Set Property

Text and PDF Files

« Property: Displays a list of record properties set in the Preprocessor step (see
"Preprocessor step” on page 140).

« Type: Displays the type of the property. This is a read-only field.
« Based on: Determines the origin of the data.

« Location: The contents of the data selection set below will be the value of the
extracted field. The data selection settings are different depending on the data
sample type.

« Left: Defines the start of the data selection to extract
« Right: Defines the end of the data selection to extract

« Top offset: The vertical offset from the current pointer location in the Data
Sample (Viewer).

« Height: The height of the selection box.

+ Use selection: Click to use the value of the current data selection for the
extraction.
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Note

If the selection contains multiple lines, only the first line is selected.

« Trim: Select to trim empty characters at the beginning or the end of the field

« JavaScript : The result of the JavaScript Expression written below the drop-down
will be the value of the extracted field. If the expression contains multiple lines, the
last value attribution (variable = "value";) will be the value. See "DataMapper Scripts
API" on page 252.

« Expression: The JavaScript expression to run.

« Use JavaScript Editor: Click to display the Edit Script dialog (see "Using
scripts in the DataMapper" on page 255 and "DataMapper Scripts API" on
page 252).

« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

+ Use selection: Click to use the value of the current data selection for the
extraction.

Note

If the selection contains multiple lines, only the first line is selected.

« Data Format: Data format settings tell the DataMapper how certain types of data are
formatted in the data source. Make sure that this format matches the actual format of the
data in the data source.

« Negative Sign Before : A negative sign will be displayed before any negative
value.

« Decimal Separator : Set the decimal separator for a numerical value.
« Thousand Separator : Set the thousand separator for a numerical value.
« Currency Sign : Set the currency sign for a currency value.

+ Date Format : Set the date format for a date value.
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« Date Language : Set the date language for a date value (ex: If English is selected,
the term May will be identified as the month of May).

o Treat empty as 0 : A numerical empty value is treated as a 0 value.

CSV and Database Files

« Property: Displays a list of record properties set in the Preprocessor step (see
"Preprocessor step" on page 140).

« Type: Displays the type of the property. Read only field.
« Based on: Determines the origin of the data.

+ Location: The contents of the data selection set below will be the value of the
extracted field. The data selection settings are different depending on the data
sample type.

« Column: Drop-down listing all fields in the Data Sample, of which the value
will be used.

« Top offset: The vertical offset from the current pointer location in the Data
Sample (Viewer).

+ Use selection: Click to use the value of the current data selection for the
extraction.

Note

If the selection contains multiple lines, only the firstline is selected.

« Trim: Select to trim empty characters at the beginning or the end of the field

« JavaScript : The result of the JavaScript Expression written below the drop-down
will be the value of the extracted field. If the expression contains multiple lines, the
last value attribution (variable = "value";) will be the value. See "DataMapper Scripts
API" on page 252.

« Expression: The JavaScript expression to run.

« Use JavaScript Editor: Click to display the Edit Script dialog (see "Using
scripts in the DataMapper" on page 255 and "DataMapper Scripts API" on
page 252).
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« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

+ Use selection: Click to use the value of the current data selection for the
extraction.

Note

If the selection contains multiple lines, only the first line is selected.

« Data Format: Data format settings tell the DataMapper how certain types of data are
formatted in the data source. Make sure that this format matches the actual format of the
data in the data source.

« Negative Sign Before : A negative sign will be displayed before any negative
value.

« Decimal Separator : Set the decimal separator for a numerical value.

« Thousand Separator : Set the thousand separator for a numerical value.
« Currency Sign : Set the currency sign for a currency value.

« Date Format : Set the date format for a date value.

« Date Language : Set the date language for a date value (ex: If English is selected,
the term May will be identified as the month of May).

« Treat empty as 0 : A numerical empty value is treated as a 0 value.

XML File

« Property: Displays a list of Source Record properties set in the Preprocessor step (see
"Preprocessor step" on page 140).

« Type: Displays the type of the Source Record property. Read only field.
« Based on: Determines the origin of the data.

« Location: The contents of the data selection set below will be the value of the
extracted field. The data selection settings are different depending on the data
sample type.
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« XPath: The path to the XML field that is extracted.

+ Use selection: Click to use the value of the current data selection for the
extraction.

Note

If the selection contains multiple lines, only the firstline is
selected.

« Trim: Select to trim empty characters at the beginning or the end of the
field

« JavaScript : The result of the JavaScript Expression written below the drop-down
will be the value of the extracted field. If the expression contains multiple lines, the
last value attribution (variable = "value";) will be the value. See "DataMapper Scripts
API" on page 252.

« Expression: The JavaScript expression to run.

« Use JavaScript Editor: Click to display the Edit Script dialog (see "Using
scripts in the DataMapper" on page 255 and "DataMapper Scripts API" on
page 252).

« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

o Use selection: Click to use the value of the current data selection for the
extraction.

Note

If the selection contains multiple lines, only the first line is selected.
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« Data Format: Data format settings tell the DataMapper how certain types of data are
formatted in the data source. Make sure that this format matches the actual format of the
data in the data source.

« Negative Sign Before : A negative sign will be displayed before any negative
value.

« Decimal Separator : Set the decimal separator for a numerical value.

o Thousand Separator : Set the thousand separator for a numerical value.
« Currency Sign : Set the currency sign for a currency value.

« Date Format : Set the date format for a date value.

« Date Language : Set the date language for a date value (ex: If English is selected,
the term May will be identified as the month of May).

o Treat empty as 0 : A numerical empty value is treated as a 0 value.

Run JavaScript

Running a JavaScript expression offers many possibilities. The script could, for example, set
record properties and field values using advanced expressions and complex mathematical
operations and calculations.

« Expression: The JavaScript expression to run (see "DataMapper Scripts API" on
page 252).

« Use JavaScript Editor: Click to display the Edit Script dialog.

« Use selected text: Inserts the text in the current data selection in the JavaScript
Expression. If multiple lines or elements are selected, only the first one is used.

+ Use selection: Click to use the value of the current data selection.

Note

If the selection contains multiple lines, only the first line is selected.

Repeat step properties

The Repeat step adds a loop to the extraction workflow; see "Steps" on page 140 and
"Extracting transactional data" on page 124.
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The properties described below become visible in the Step properties pane when the Repeat
step is selected in the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Repeat Definition

« Repeat type:

« While statement is true: The loop executes while the statement below is true. The
statement is evaluated after the loop so the loop will always run at least once.

« Until statement is true: The loop executes until the statement below is true. The
statement is evaluated before the loop so the loop may not run at all.

« Until no more elements (for Text, CSV, Database and PDF files only): The loop
executes as long as there are elements left as selected below.

« For Each (for XML files only): The loop executes for all nodes on a specified level.

Note

When using an XML For Each loop, itis not necessary to skip to the
repeating node or to have a Gotostep to jump to each sibling, as this loop
takes care of it automatically.

o Maximum iterations on each line: Defines the maximum number of iterations occurring
at the same position. This expression is evaluated once when entering the loop. The
value returned by the expression must be an integer higher than 0.

« Use JavaScript Editor: Click to display the Edit Script dialog.
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Rule Tree

The Rule tree subsection displays the full combination rules (defined below under Condition)
as a tree, which gives an overview of how the conditions work together as well as the result for
each of these conditions for the current record or iteration.

Condition

First, the Condition List displays the conditions in list form, instead of the tree form above.
Three buttons are available next to the list:

« Add condition: Click to create a new condition in the list. This will always branch the
current condition as an "AND" operator.

« Delete condition: Delete the currently selected condition.

« Torename a Condition, double click on its name from the Rule tree subsection .

Conditions are made by comparison of two operands using a specific Operator.

Note

Both the Left and Right operands have the same properties.

Text and PDF Files

« Based On:
« Position: The data in the specified position for the comparison.

« Left: The start position for the data selection. Note that conditions are done on
the current line, either the current cursor position, or the current line in a
Repeat step.

« Right: The end position for the data selection.

« Top offset: The vertical offset from the current pointer location in the Data
Sample (Viewer).

« Height: The height of the selection box.

+ Use Selection: Click to use the value of the current data selection for the
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extraction.
« Trim: Select to trim empty characters at the beginning or the end of the field.
« Value: A specified static text value.
« Value: The text value to use in the comparison.

+ Use selected text: Uses the text in the current data selection as the Value. If
multiple lines or elements are selected, only the first one is used.

« Field: The contents of a specific field in the Extracted Record.
« Field: The Extracted Record field to use in the comparison.
« JavaScript : The result of a JavaScript Expression.

« Expression: The JavaScript line that is evaluated. Note that the last value
attribution to a variable is the one used as a result of the expression.

« Use JavaScript Editor: Click to display the Edit Script dialog.

« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

Data Property: The value of a data-level property set in the Preprocessor step (see
"Preprocessor step" on page 140).

« Record Property: One of the local variables that you can create and that are reset
for each document as opposed to data variables that are global because they are
initialized only once at the beginning of each job.

« Automation Property: The current value of a Document-level property setin the
Preprocessor step (see "Preprocessor step" on page 140).

« Extractor Property: The value of an internal extractor variable:
« Counter: The value of the current counter iteration in a Repeat step.

« Vertical Position: The current vertical position on the page, either in Measure
(PDF) or Line (Textand CSV).

e Operators:
« is equal to: The two specified value are identical for the condition to be True.

« contains: The first specified value contains the second one for the condition to be
True.
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« is less than: The first specified value is smaller, numerically, than the second value
for the condition to be True.

« is greater than: The first specified value is larger, numerically, than the second
value for the condition to be True.

« is empty: The first specified value is empty. With this operator, there is no second
value.

« Invert condition: Inverts the result of the condition. For instance, is empty becomes
is not empty.

CSV and Database Files

« Based On:
« Position: The data in the specified position for the comparison.

o Column: Drop-down listing all fields in the Data Sample, of which the value
will be used.

« Top offset: The vertical offset from the current pointer location in the Data
Sample (Viewer).

o Use Selection: Click to use the value of the current data selection for the
extraction.

« Trim: Select to trim empty characters at the beginning or the end of the field.
« Value: A specified static text value.
o Value: The text value to use in the comparison.

+ Use selected text: Uses the text in the current data selection as the Value. If
multiple lines or elements are selected, only the first one is used.

« Field: The contents of a specific field in the Extracted Record.
« Field: The Extracted Record field to use in the comparison.
« JavaScript : The result of a JavaScript Expression.

« Expression: The JavaScript line that is evaluated. Note that the last value
attribution to a variable is the one used as a result of the expression.

« Use JavaScript Editor: Click to display the Edit Script dialog.
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« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

« Data Property: The value of a data-level property setin the Preprocessor step.

« Record Property: One of the local variables that you can create and that are reset
for each document as opposed to data variables that are global because they are
initialized only once at the beginning of each job.

« Automation Property: The current value of a Document-level property setin the
Preprocessor step.

« Extractor Property: The value of an internal extractor variable:
« Counter: The value of the current counter iteration in a Repeat step.

« Vertical Position: The current vertical position on the page, either in Measure
(PDF) or Line (Textand CSV).

o Operators:
« is equal to: The two specified value are identical for the condition to be True.

« contains: The first specified value contains the second one for the condition to be
True.

« is less than: The first specified value is smaller, numerically, than the second value
for the condition to be True.

« is greater than: The first specified value is larger, numerically, than the second
value for the condition to be True.

« is empty: The first specified value is empty. With this operator, there is no second
value.

« Invert condition: Inverts the result of the condition. For instance, is empty becomes
is not empty.
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XML Files

« Based On:
« Position: The data in the specified position for the comparison.
o XPath: The path to the XML field that is extracted.

+ Use Selection: Click to use the value of the current data selection for the
extraction.

« Trim: Select to trim empty characters at the beginning or the end of the field.
« Value: A specified static text value.
« Value: The text value to use in the comparison.

+ Use selected text: Uses the text in the current data selection as the Value. If
multiple lines or elements are selected, only the first one is used.

« Field: The contents of a specific field in the Extracted Record.
« Field: The Extracted Record field to use in the comparison.
« JavaScript : The result of a JavaScript Expression.

« Expression: The JavaScript line that is evaluated. Note that the last value
attribution to a variable is the one used as a result of the expression.

« Use JavaScript Editor: Click to display the Edit Script dialog.

+ Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

« Data Property: The value of a data-level property setin the Preprocessor step.

« Record Property: One of the local variables that you can create and that are reset
for each document as opposed to data variables that are global because they are
initialized only once at the beginning of each job.

« Automation Property: The current value of a Document-level property setin the
Preprocessor step.

« Extractor Property: The value of an internal extractor variable:
« Counter: The value of the current counter iteration in a Repeat step.

« Vertical Position: The current vertical position on the page, either in Measure
(PDF) or Line (Textand CSV).
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o Operators:
« is equal to: The two specified value are identical for the condition to be True.

« contains: The first specified value contains the second one for the condition to be
True.

« is less than: The first specified value is smaller, numerically, than the second value
for the condition to be True.

« is greater than: The first specified value is larger, numerically, than the second
value for the condition to be True.

« is empty: The first specified value is empty. With this operator, there is no second
value.

« Invert condition: Inverts the result of the condition. For instance, is empty becomes
is not empty.
Condition step properties
A Condition step is used when the data extraction must be based on specific criteria. See

"Condition step" on page 145 for more information.

The properties of a Conditon step become visible in the Step properties pane when the
Condition step is selected on the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Rule tree

The Rule tree subsection displays the full combination of rules (defined below under
Condition) as a tree, which gives an overview of how the conditions work together as well as
the result for each of these conditions for the current record or iteration.
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e Torename a rule, double click on its name from the Rule tree subsection.

« To change the way rules are combined, right-click "AND". Select OR or XOR instead.
XOR means one or the other, but not both.

Condition

First, the Condition List displays the conditions in list form, instead of the tree form above.
Three buttons are available next to the list:

« Add condition: Click to add a new rule. This will always branch the current condition as
an "AND" operator.

» Delete condition: Delete the currently selected condition.

Conditions are made by comparison of two operands using a specific Operator.

Note

Both the Left and Right operands have the same properties.

« Based On:
« Position: The data in the specified position for the comparison.

o Left (Txtand PDF only): The start position for the data selection. Note that
conditions are done on the current line, either the current cursor position, or
the current line in a Repeat step.

« Right (Txtand PDF only): The end position for the data selection.
« Height (Txt and PDF only): The height of the selection box.

e Column (CSV and Database only): Drop-down listing all fields in the Data
Sample, of which the value will be used.

o XPath (XML only): The path to the XML field that is extracted.

« Top offset: The vertical offset from the current pointer location in the Data
Sample (Viewer).

+ Use Selection: Click to use the value of the current data selection for the
extraction.

« Trim: Select to trim empty characters at the beginning or the end of the field.
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« Value: A specified static text value.
e Value: The text value to use in the comparison.

+ Use selected text: Uses the text in the current data selection as the Value. If
multiple lines or elements are selected, only the first one is used.

« Field: The contents of a specific field in the Extracted Record.
« Field: The Extracted Record field to use in the comparison.
« JavaScript : The result of a JavaScript Expression.

« Expression: The JavaScript line that is evaluated. Note that the last value
attribution to a variable is the one used as a result of the expression.

« Use JavaScript Editor: Click to display the Edit Script dialog (see "Using
scripts in the DataMapper" on page 255).

+« Use selected text: Inserts the text in the current data selection in the
JavaScript Expression. If multiple lines or elements are selected, only the first
one is used.

Data Property: The value of a data-level property set in the Preprocessor (see
"Preprocessor step" on page 140).

« Record Property: One of the local variables that you can create and that are reset
for each document as opposed to data variables that are global because they are
initialized only once at the beginning of each job.

« Automation Property: The current value of a Document-level property setin the
Preprocessor step (see "Preprocessor step" on page 140).

« Extractor Property: The value of an internal extractor variable:
« Counter: The value of the current counter iteration in a Repeat step.

» Vertical Position: The current vertical position on the page, either in Measure
(PDF) or Line (Textand CSV).

o Operators:
« is equal to: The two specified value are identical for the condition to be True.

« contains: The first specified value contains the second one for the condition to be
True.

« is less than: The first specified value is smaller, numerically, than the second value
for the condition to be True.
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« is greater than: The first specified value is larger, numerically, than the second
value for the condition to be True.

« is empty: The first specified value is empty. With this operator, there is no second
value.
Invert condition: Inverts the result of the condition. For instance, is empty becomes is

not empty.

Multiple Conditions step properties

The Multiple Conditons step contains a number of Case conditions (one to start with) and a
Default, to be executed when none of the other cases apply. Cases are executed from left to
right. For more information see "Steps" on page 140.

The properties described below become visible in the Step properties pane when the Multiple
Conditions step is selected in the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Condition

Left operand, Right operand
The Left and right operand can be Based on:

« Position: The data in the specified position for the comparison.

« Left (Txtand PDF only): The start position for the data selection. Note that
conditions are done on the current line, either the current cursor position, or the
currentline in a Repeat step.

« Right (Txt and PDF only): The end position for the data selection.
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« Height (Txt and PDF only): The height of the selection box.

e Column (CSV and Database only): Drop-down listing all fields in the Data Sample,
of which the value will be used.

« XPath (XML only): The path to the XML field that is extracted.
« Top offset: The vertical offset from the current pointer location in the Data Sample
(Viewer).
» Use Selection: Click to use the value of the current data selection for the extraction.
« Trim: Select to trim empty characters at the beginning or the end of the field.
« Value: A specified static text value.
« Value: The text value to use in the comparison.

o Use selected text: Uses the text in the current data selection as the Value. If
multiple lines or elements are selected, only the first one is used.

« Field: The contents of a specific field in the Extracted Record.
« Field: The Extracted Record field to use in the comparison.
« JavaScript : The result of a JavaScript Expression.

« Expression: The JavaScript line that is evaluated. Note that the last value
attribution to a variable is the one used as a result of the expression. See also:
"DataMapper Scripts API" on page 252.

« Use JavaScript Editor: Click to display the Edit Script dialog (see "Using scripts in
the DataMapper" on page 255).

« Use selected text: Inserts the text in the current data selection in the JavaScript
Expression. If multiple lines or elements are selected, only the first one is used.

- Data Property: The value of a data-level property set in the Preprocessor step (see
"Steps" on page 140).

« Record Property: One of the local variables that you can create and that are reset for
each document as opposed to data variables that are global because they are initialized
only once at the beginning of each job.

« Automation Property: The current value of a Document-level property setin the
Preprocessor step (see "Steps" on page 140).
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« Extractor Property: The value of an internal extractor variable:
« Counter: The value of the current counter iteration in a Repeat step.

« Vertical Position: The current vertical position on the page, either in Measure
(PDF) or Line (Textand CSV).

Condition

The Condition drop-down displays the cases in list form. Three buttons are available next to
the list:

« Add case: Click to add a new case to the step. It will be placed next to any existing
cases.

« Remove case: Delete the currently selected case.

« Order Cases: Under the Name column, select a case, then click one of the buttons on the
right (Delete, Move Up, Move Down) to delete or change the order of the cases in the list.

Operators

Case conditions are made by comparison of the two operands, left and right, using a specific
Operator.

« is equal to: The two specified value are identical for the condition to be True.
« contains: The first specified value contains the second one for the condition to be True.

« is less than: The first specified value is smaller, numerically, than the second value for
the condition to be True.

« is greater than: The first specified value is larger, numerically, than the second value for
the condition to be True.

« is empty: The first specified value is empty. With this operator, there is no second value.

« Invert condition: Inverts the result of the condition. For instance, is empty becomes is
not empty.

Goto step properties

The Goto step moves the pointer within the source data to a position that is relative to the top of
the record or to the current position. See also: "Steps" on page 140.
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The properties of the Goto step described in this topic become visible in the Step properties
pane when you select the Goto step on the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Goto Definition

With each type of source data, the movement of the cursor is defined in a specific way.

Text file

« Target Type: Defines the type of jump .
« Line: Jumps a certain number of lines or to a specific line.
e From: Defines where the jump begins:
« Current Position: The Goto begins at the current cursor position.
« Top of record: The Gotobegins at line 1 of the source record.
e Move by: Enter the number of lines or pages to jump.
« Page: Jumps between pages or to a specific page.
o From: Defines where the jump begins:
« Current Position: The Gotobegins at the current cursor position.
« Top of record: The Gotobegins at line 1 of the source record.
« Move by: Enter the number of lines or pages to jump.

« Next line with content: Jumps to the next line that has contents, either anywhere
on the line or in specific columns.

« Inspect entire page width: \When checked, the Next line with content and
Next occurrence of options will look anywhere on the line. If unchecked,
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options appear below to specify in which area of each line the Gotostep
checks in:

o Left: The starting column, inclusively.
« Right: The end column, inclusively.

« Use selection: Click while a selection is made in the Data Viewer to
automatically set the left and right values to the left and right edges of the
selection.

« Next occurrence of: Jumps to the next occurrence of specific text or a text pattern,
either anywhere on the line or in specific columns.

« Inspect entire page width: When checked, the Next line with content and
Next occurrence of options will look anywhere on the line. If unchecked,
options appear below to specify in which area of each line the Gotostep
checks in:

o Left: The starting column, inclusively.
« Right: The end column, inclusively.

+ Use selection: Click while a selection is made in the Data Viewer to
automatically set the left and right values to the left and right edges of the
selection.

« Expression: Enter the text or Regex expression to look for on the page.

» Use selection: Click while a selection is made in the Data Viewer to copy the
contents of the first line of the selection into the Expression box.

« Use regular expression: Check so that the Expression box is treated as a
regular expression instead of static text. For more information on using
Regular Expressions (regex), see the Regular-Expressions.info Tutorial.

PDF File

« Target Type: Defines the type of jump .
« Physical distance:
« From: Defines where the jump begins:
« Current Position: The Goto begins at the current cursor position.
« Top of record: The Gotobegins at line 1 of the source record.

« Move by: Enter distance to jump.
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« Page: Jumps between pages or to a specific page.
o From: Defines where the jump begins:
« Current Position: The Gotobegins at the current cursor position.
« Top of record: The Gotobegins at line 1 of the source record.
e Move by: Enter the number pages to jump.

« Next line with content: Jumps to the next line that has contents, either anywhere
on the line or in specific columns.

« Inspect entire page width: When checked, the Next line with content and
Next occurrence of options will look anywhere on the line. If unchecked,
options appear below to specify in which area of each line the Gotostep
checks in:

o Left: The starting column, inclusively.
« Right: The end column, inclusively.

+ Use selection: Click while a selection is made in the Data Viewer to
automatically set the left and right values to the left and right edges of the
selection.

« Next occurrence of: Jumps to the next occurrence of specific text or a text pattern,
either anywhere on the line or in specific columns.

« Inspect entire page width: \When checked, the Next line with content and
Next occurrence of options will look anywhere on the line. If unchecked,
options appear below to specify in which area of each line the Gotostep
checks in:

o Left: The starting column, inclusively.
e Right: The end column, inclusively.

« Use selection: Click while a selection is made in the Data Viewer to
automatically set the left and right values to the left and right edges of the
selection.

o Expression: Enter the text or Regex expression to look for on the page.

« Use selection: Click while a selection is made in the Data Viewer to copy the
contents of the first line of the selection into the Expression box.
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« Use regular expression: Check so that the Expression box is treated as a
regular expression instead of static text. For more information on using
Regular Expressions (regex), see the Regular-Expressions.info Tutorial.

CSV File

o From (CSV files): Defines where the jump begins:
« Current Position: The Goto begins at the current cursor position.
« Move by: Enter the number of lines or pages to jump.
« Top of record: The Gotobegins at line 1 of the source record.

« Move to: Enter the number of lines or pages to jump.

XML File

« Destination (XML files): Defines what type of jump to make:

« Sibling element: Jumps the number of siblings (nodes at the same level) defined in
the Move byoption.

« Sibling element with same name: Jumps the number of same name siblings
(nodes at the same level of which the node is the same name) defined in the Move
byoption.

« Element, from top of record: Jumps to the specified node. The XPATH in the
Absolute XPATHoption starts from the root node defined by /.

« Element from current position: Jumps to a position relative to the current position
of the cursor. The XPATH in the Relative XPATHoption defines where to go,../goes
up a level,.Irefers to the current level.

o Level Up/Down: Jumps up or down one node level (up to the parent, down to a
child). The number of levels to change is defined in the Move byoption.

Postprocessor step properties

The Postprocessor step does not run for every Source Record in the Data Sample. It runs once,
at the end of the Steps, after all records have been processed. For more information see
"Postprocessor step" on page 150.
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The properties described below become visible in the Step properties pane when the
Postprocessor step is selected in the Steps pane.

Description

This subsection is collapsed by default in the interface, to give more screen space to other
important parts.

Name: The name of the step. This name will be displayed on top of the step's icon in the Steps
pane.

Comments: The text entered here will be displayed in the tooltip that appears when hovering
over the step in the Steps pane.

Postprocessor

The Postprocessor subsection defines what postprocessors run on the Data Sample at the end
of the data mapping workflow. Each Postprocessor runs in turn, using the result of the previous
one as an input.

« Name: The name to identify the Postprocessor.
o Type: The type of Postprocessor. Currently there is a single type available.

« JavaScript : Runs a JavaScript Expression to modify the Data Sample. See
"DataMapper Scripts API" on page 252.

« Use JavaScript Editor: Click to display the Edit Script dialog (see "Using
scripts in the DataMapper" on page 255).

« Add Postprocessor: Click to add a new Postprocessor. Its settings can be modified
once itis added.

« Remove Postprocessor: Click to remove the currently selected Postprocessor.

e Move Up: Click to move the Postprocessor up one position.

« Move Down: Click to move the Postprocessor down one position.

« Export: Click to export the current Postprocessor configuration and content to a file.

« Import: Click to import a Postprocessor configuration and content from an external file.
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Postprocessor definition

JavaScript

« Expression: The JavaScript expression that will run on the Data Sample. See
"DataMapper Scripts API" on page 252.

« Use JavaScript Editor: Click to display the Script Editor dialog.

« Use selected text: Uses the text in the current data selection as the Value. If multiple
lines or elements are selected, only the first one is used.

Toolbar

In the DataMapper module, the following buttons are available in the top toolbar.

File manipulation

o Newrs: Displays the New wizard where a new data mapping configuration or a new
template can be created.

« Open (=: Displays the Open dialog to open an existing data mapping configuration.

« Save |.|: Saves the current data mapping configuration. If the configuration has never
been saved, the Save As... dialog is displayed.

Step manipulation

Note

All steps except the Action step require an active data selection in the Data Viewer (see "Selecting
data" on page 122 and "The Data Viewer" on page 200).

« Add Extract Step {=l: Adds an Extract Step with one or more extract fields. If more than
one line or field is selected in the Data Viewer, each line or field will have an extract field.

o Add Goto Step E: Adds a Goto step that moves the selection pointer to the beginning of
the data selection. For instance if an XML node is selected, the pointer moves to where
that node is located.
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« Add Condition Step 'ﬁ' : Adds a condition based on the current data selection. The
"True" branch gets run when the text is found on the page. Other conditions are available
in the step properties once it has been added.

. Add Repeat Step “:: Adds a loop that is based on the current data selection, and
depending on the type of data. XML data will loop on the currently selected node, CSV
loops for all rows in the record. In Text and PDF data, if the data selection is on the same
line as the cursor position, the loop will be for each line until the end of the record. If the
data selection is on a lower line, the loop will be for each line until the text in the data
selection is found at the specified position on the line (e.g. until "TOTAL" is found).

. Add Extract Field [7: Adds the data selection to the selected Extract step, if an extract
step is currently selected. If multiple lines, nodes or fields are selected, multiple extract
fields are added simultaneously.

o Add Multiple Conditions % Adds a condition that splits into multiple case conditions.

o Add Action Step L/: Adds a step to create a custom JavaScript snippet. See
"DataMapper Scripts API" on page 252 for more details.

« Cut Step ;£: Removes the currently selected step and places it in the clipboard. If the
step is a Repeat or a Condition, all steps under it are also placed in the clipboard. If there
is already a step in the clipboard, it will be overwritten.

« Copy Step :a: Places a copy of the currently selected step in the clipboard. The same
details as the Cut step applies.

« Paste Step [&]: Takes the step or steps in the clipboard and places them after the
currently selected step.

» Delete Step i: Deletes the currently selected step. If the step is a Repeat or Condition,
all steps under it are also deleted.

« Ignore Step @: Click to set the step to be ignored (aka disabled). Disabled steps do not
run when in DataMapper and do not execute when the data mapping configuration is
executed in Workflow. However, they can still be modified normally.

» Validate All Records «+: Runs the process on all records and verifies that no errors are
presentin any of the records. Errors are displayed in the Messages pane ("Messages
pane" on page 202).

o Add Data Sample = Displays a dialog to open a new Data Source to add it as a Data
Sample in the data mapping configuration. Data Samples are visible in the Settings pane
("Settings pane" on page 203).
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Welcome Screen

The Welcome Screen appears when first starting up PlanetPress Connect. It offers some
useful shortcuts to resources and to recent documents and data mapping configurations.

If you are new to PlanetPress Connect and you don't know where to start, see "Welcome to
PlanetPress Connect 1.8" on page 14.

The Welcome Screen can be brought back in two ways:

« The Welcome Screen button in the "Toolbars" on page 771.

e From the Menus in Help, Welcome Screen.
Contents

« Activation: Click to open the Objectif Lune Web Activation Manager.

« Release Notes: Opens the current Release Notes for PlanetPress Connect.

« Website: Opens the PlanetPress Connect website.

« Take A Tour: Click to open the YouTube Playlist giving you a tour of the software.
o Use the DataMapper to....

« Create a New Configuration: Opens the Creating a New Configuration screen.

« Open an Existing Configuration: Click to open the standard Browse dialog to
open an existing data mapping configuration.

« Recent Configurations: Lists recently used configurations. Click any configuration
to open it in the DataMapper module.

o Use the Designer to....

« Create a New Template: Lets you choose a Context to create a new template
without a Wizard.

« Browse Template Wizards: Displays a list of available Template Wizards,
producing premade templates with existing demo content; see "Creating a template"
on page 304.

« Open an Existing Template: Click to open the standard Browse dialog to open an
existing template.
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« Recent Templates: Lists recently used templates. Click any template to openitin

the Designer module.

+ Other Resources:

o Documentation: Opens this documentation.

e Courses (OL Learn): Opens the Objectif Lune e-Learning Center.

e User Forums: Opens the Questions & Answer forums.

DataMapper Scripts API

This page describes the different features available in scripts created inside DataMapper. See

"Using scripts in the DataMapper" on page 255.

Objects

Description Available in
scripts of
type

"Objects" on A ScriptableAutomation object Boundaries,
page 262 encapsulating the properties of the all steps

PlanetPress Workflow process that except Goto

triggered the current operation.

"boundaries An object encapsulating properties Boundaries
on page 264 and methods allowing to define the

boundaries of each documentin the

job.

"data" on A data object encapsulating Boundaries,
page 269 properties and methods pertaining to all steps

the original data stream. except Goto

"db" on An object that allows to connectto a Boundaries,
page 282 database. all steps

except Goto
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Description Available in
scripts of
type

"logger" on An object that allows to log error, Boundaries,
page 283 warning or informational messages. all steps
except Goto
"record" on The current record in the main data Extract,
page 283 set. Condition,
Repeat and
Multiple
Conditions
steps
"region” on An object that defines a subsection of | Boundaries
page 284 the input data.
"sourceRecord" | An object containing properties Boundaries,
on page 286 specific to the current source record all steps
being processed. except Goto
and
Postprocessor
"steps" on An object encapsulating properties Extract,
page 287 and methods pertaining to the current | Condition,
data mapping configuration. Repeat and
Multiple
Conditions
steps
Functions

These functions are available in Boudaries and Steps scripts.
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Name Description

copyFile() Copies afile to the target file path, replacing it if it already
exists.

"createHTTPRequest()" Creates a new HTTP Request Object.

on page 294

createTmpFile() Creates a file with a unique name in the temporary work folder
and returns a file object.

deleteFile() Deletes a file.

execute() Calls an external program and waits for it to end.

newByteArray() Returns a new byte array.

newCharArray() Returns a character array.

newDoubleArray() Returns a double array.

newFloatArray() Returns a float array.

newlIntArray() Returns an integer array.

newLongArray() Returns a long array.

newStringArray() Returns a string array.

openBinaryReader() Opens afile as a binary file for reading purposes.

openBinaryWriter() Opens afile as a binary file for writing purposes.

openTextReader() Opens afile as a text file for reading purposes.

openTextWriter() Opens a file as a text file for writing purposes.
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Using scripts in the DataMapper

In the DataMapper every part of the extraction process can be customized using scripts.

A script can be used to set boundaries for a data source (see "Setting boundaries using
JavaScript" on page 257). The script determines where a new record starts.

Scripts can also be used in different steps in the extraction workflow. You can:

« Modify the incoming data prior to executing the rest of the extraction workflow, via a
Preprocessor (see "Preprocessor step" on page 140).

« Editextracted data in a field of the Data Model using a Post function script (entered on
the Step properties pane, under Field Definition; see "Modifying extracted data" on
page 159 and "Settings for location-based fields in a Text file" on page 221).

« Enter a scriptin a JavaScript-based field (see "JavaScript-based field" on page 156).
Note that the last value attribution to a variable is the one used as the result of the
expression.

Itis possible to refer to previously extracted fields if they are extracted higher in this list or
in previous Extract steps in the extraction workflow.

« Letan Action step run a JavaScript, or use JavaScript to add a value to a property
defined in the Preprocessor step.

« Change the left and right operands in a Condition step to a JavaScript expression. (On
the Step properties pane, under Condition, set Based on to Javascript; see "Condition
step properties" on page 238 and "Left operand, Right operand" on page 241.)

« Further process the resulting record set after the entire extraction workflow has been
executed, via a Postprocessor (see "Postprocessor step" on page 150).

The script can always be written directly in a small script area or in the Edit script dialog. To

invoke this dialog click the Use JavaScript Editor button L. .

Tip
In the Edit script dialog, press Ctrl + Space to bring up the list of available JavaScript objects

and functions (see Datamapper API). Use the arrow keys to select a function or object and press
enter to insert it. Type a dot after the name of the function or object to see which features are
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ubsequently available.

Keyboard shortcuts for the script editor are listed in the following topic: "Keyboard shortcuts" on
page 738.

Syntax rules

In the DataMapper, all scripts must be written in JavaScript, following JavaScript syntax rules.
For example, each statement should end with ; and the keywords that can be used, such as var
to declare a variable, are JavaScript keywords. There are countless tutorials available on the
Internet to familiarize yourself with the JavaScript syntax. For a simple script all that you need to
know can be found on the following web pages: http://www.w3schools.com/js/js syntax.asp
and http://www.w3schools.com/js/js if else.asp. A complete JavaScript guide for beginners
can be found here: https://developer.mozilla.org/en-US/docs/Web/JavaScript.

DataMapper API

Certain features that can be used in a DataMapper script do not exist in the native JavaScript
library. These are additional JavaScript features, designed for use in Connect only. All features
designed for use in the DataMapper are listed in the DataMapper API (see DataMapper API).

External JavaScript libraries

The External JS Libraries box on the Settings pane lets you add JavaScript libraries to your
configuration and displays all the libraries that have been imported (see "Settings pane" on
page 203).

You can use JavaScript libraries to add more JavaScript functionality to your data mapping
configuration. Any functions included in a JavaScript library that is imported in a data mapping
configuration will be available in Preprocessor scripts as well as Action tasks, Post functions
and JavaScript-based extraction steps.

Take the following JavaScript function, for example:

function myAddFunction (pl, p2) {
return pl + p2;
}i
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If this is saved as myFunction.js and imported, then the following would work anywhere in the
configuration:

var result = myAddFunction (25, 12); // returns 37!

Setting boundaries using JavaScript

As soon as you select the On Script option as the trigger for establishing record boundaries
(see "Record boundaries" on page 117), you are instructing the DataMapper to read the source
file sequentially and to trigger an event each and every time it hits a delimiter. (What a delimiter
is, depends on the source data and the settings for that data; see "Input data settings
(Delimiters)" on page 115).

In other words, the script will be executed - by default - as many times as there are delimiters in
the input data.

If you know, for instance, that a PDF file only contains documents that are 3 pages long, your
script could keep count of the number of times it's been called since the last boundary was set
(thatis, the count of delimiters that have been encountered). Each time the count is a multiple of
3, it could set a new record boundary. This is basically what happens when setting the trigger to
On Page and specifying 3 as the Number of Pages.

Note

Remember that a boundary script is being called on each new delimiter encountered by the
DataMapper parsing algorithm. If for instance a database query returns a million records, the script
will be executing a million times! Craft your script in such a way that it doesn't waste time
examining all possible conditions. Instead, it should terminate as soon as any condition it is
evaluating is false.

Accessing data

Data available inside each event

Every time a delimiter is encountered, an event is triggered and the script is executed. The
event gives the script access to the data between the current location - the start of a row, line or
page - and the next delimiter. So at the beginning of the process for a PDF or text file, you have
access to the first page only, and for a CSV or for tabular data, that would be the first row or
record.

This means that you can:
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« Examine the data found in between delimiters for specific conditions.

Examine specific regions of that data, or the available data as a whole.

Compare the contents of one region with another.
. Etc.

To access this data in the script, use the get() function of the boundaries object. This function
expects different parameters depending on the type of source file; see "Example" on page 266.

Getting access to other data

Data that is not passed with the event, but that is necessary to define the record boundaries,
can be stored in the boundaries object using the setVariable function (see "boundaries" on
page 264 and "Example" on page 268). The data can be retrieved using the boundaries'
getVariable function (see "getVariable()" on page 266).

This way the script can access values that were evaluated in previous pages or rows, across
delimiters, so you can easily set record boundaries that span over multiple delimiters.

For more information on the syntax, please refer to "DataMapper Scripts API" on page 252.

Examples

Basic example using a CSV file

Imagine you are a classic rock fan and you want to extract the data from a CSV listing of all the
albums in your collection. Your goal is to extract records that change whenever the artist OR
the release year changes.

Here's what the CSV looks like:

"Artist","Album","Released"
"Beatles","Abbey Road",1969
"Beatles","Yellow Submarine",1969
"Led Zeppelin","Led Zeppelin 1",1969
"Led Zeppelin","Led Zeppelin 2",1969
"Beatles","Let it be",1969

"Rolling Stones","Let it bleed",1969
"Led Zeppelin","Led Zeppelin 3",1970
"Led Zeppelin","Led Zeppelin 4",1971
"Rolling Stones","Sticky Fingers",1971
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Note

The first line is just the header with the names of the CSV columns. The data is already sorted per
year, per artist, and per album.

Your goal is to examine two values in each CSV record and to act when either changes. The
DataMapper GUI allows you to specify a On Change trigger, but you can only specify a single
field. So for instance, if you were to set the record boundary when the "Released" field
changes, you'd get the first four lines together inside a single record. That's not what you want
since that would include albums from several different artists. And if you were to set it when the
"Artist" field changes, the first few records would be OK but near the end, you'd get both the Led
Zeppelin 3 and led Zeppelin 4 albums inside the same record, even though they were released
in different years.

Essentially, we need to combine both these conditions and set the record boundary when
EITHER the year OR the artist changes.

Here's what the script would look like:

/* Read the values of both columns we want to check */
var zeBand = boundaries.get(region.createRegion ("Artist"));
var zeYear = boundaries.get (region.createRegion ("Released")):;

/* Check that at least one of our variables holding previous values
has been initialized already, before attempting to compare the
values */

if (boundaries.getVariable ("lastBand") !=null) {
if (zeBand[0] != boundaries.getVariable("lastBand") || zeYear[0]
!= boundaries.getVariable ("lastYear") )

{

boundaries.set () ;

}
}
boundaries.setVariable ("lastBand", zeBand[0]) ;
boundaries.setVariable ("lastYear", zeYear[0]);

« The script first reads the two values from the input data, using the createRegion() method
(see: "Example" on page 285). For a CSV/database data type, the parameter it expects is
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simply the column name. The region is passed as a parameter to the get() method, which
reads its contents and converts it into an array of strings (because any region, even a
CSV field, may contain several lines).

« To "remember" the values that were processed the last time the event was triggered, we
use variables that remain available in between events. Note that these variables are
specific to the Boundary context and not available in any other scripting context in the
DataMapper.

« The script first checks if those values were initialized. If they weren't, it means this is the
firstiteration so there's no need to compare the current values with previous values since
there have been none yet. But if they have already been initialized, then a condition
checks if either field has changed since last time. If that's the case, then a boundary is
created through the set() method.

« Finally, the script stores the values it just read in the variables using the setVariables()
method. They will therefore become the "last values encountered" until the next event
gets fired. When called, setVariables() creates the specified variable if it doesn't already
exist and then sets the value to the second parameter passed to the function.

You can try it yourself. Paste the data into the text editor of your choice and save the file to
Albums.csv. Then create a new DataMapper configuration and load this CSV as your data file.
In the Data Input Settings, make sure you specify the first row contains field names and set the
Trigger to On script. Then paste the above JavaScript code in the Expression field and click
the Apply button to see the result.

Basic example using a text file

This example is similar to the previous example, but now the data source is a plain text file that
looks like this:

Beatles Abbey Road 1969
Beatles Yellow Submarine 1968
Led Zeppelin Led Zeppelin 1 1969
Led Zeppelin Led Zeppelin 2 1969
Beatles Letitbe 1970
Rolling Stones Letitbleed 1969
Led Zeppelin Led Zeppelin 3 1970
Led Zeppelin Led Zeppelin 4 1971
Rolling Stones Sticky Fingers 1971
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The purpose of the script, again, is to set the record boundary when EITHER the year OR the
artist changes.

The script would look like this:

/* Read the values of both columns we want to check */
var zeBand = boundaries.get(region.createRegion(1,1,30,1));
boundaries.get (region.createRegion(61,1,65,1));

var zeYear

/* Check that at least one of our variables holding previous values
have been initialized already, before attempting to compare the
values */

if (boundaries.getVariable ("lastBand") !=null) {
(zeBand[0] !=boundaries.getVariable ("lastBand") || zeYear
[0] '=boundaries.getVariable("lastYear"))

{

boundaries.set () ;
}
}

boundaries.setVariable ("lastBand", zeBand[0]) ;
boundaries.setVariable ("lastYear", zeYear[0]);

This script uses the exact same code as used for CSV files, with the exception of parameters
expected by the createRegion() method. The get method adapts to the context (the data source
file) and therefore expects different parameters to be passed in order to achieve the same thing.
Since a text file does not contain column names as a CSV does, the API expects the text
regions to be defined using physical coordinates. In this instance: Left, Top, Right, Bottom.

To try this code, paste the data into a text editor and save the file to Albums.txt. Then create a
new DataMapper configuration and load this Text file as your data file. In the Data Input
Settings, specify On lines as the Page delimiter type with the number of lines setto 1. When
you now set the boundary Trigger to On script, the file will be processed line per line
(triggering the event on each line). Paste the above code in the JavaScript expression field and
click the Apply button to see the result.

Note

The PDF context also expects physical coordinates, just like the Text context does, but since PDF
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pages do not have a grid concept of lines and columns, the above parameters would instead be
specified in millimeters relative to the upper left corner of each page. So for instance, to create a
region for the Year, the code might look like this:

region.createRegion(190,20,210,25)
which would create a region located near the upper right corner of the page.

That's the only similarity, though, since the script for a PDF would have to look through the entire
page and probably make multiple extractions on each one since it isn't dealing with single lines like
the TXT example given here.

For more information on the API syntax, please refer to "DataMapper Scripts API" on page 252.

Objects

automation

Returns a ScriptableAutomation object encapsulating the properties of the PlanetPress
Workflow process that triggered the current operation.

Note

The automation object available in Designer scripts is not of the same type. It has different
properties.

Properties

The following table lists the properties of the automation object.
These are available in Boundaries scripts, with all file types.

Property Description

joblinfo Returns a ScriptableAutomation object containing JobInfo 1 to 9 values from
PlanetPress Workflow.
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Property  Description

properties | Returns a ScriptableAutomation object containing additional information (file
name, process name and task ID) from PlanetPress Workflow.

variables Returns a ScriptableAutomation object containing the list of local and global
variables defined by the user in PlanetPress Workflow. Note that there is no
way to distinguish local variables from global ones (local variables take
precedence over global variables). To be used in the DataMapper, variables
must have already been defined in the Preprocessor step as Automation
variables. The Preprocessor step attempts to match variable names passed by
the Workflow process to those defined inside the step.

Accessing automation properties

To make a Workflow variable accessible in scripts, it must first be declared in the Properties of
the Preprocessor step (see "Properties" on page 217). Both the name and type of the variable
must be the same as the variable in Workflow.

Step Properties| i Messages

Preprocessor @
¥ Description
¥ Fixed automation properties

~ Properties

Name Scope Type Default Value
Same_as_Workflow| Automation variable String

~ Preprocessor

The other properties are accessible as they are.

Examples

To access Jobinfo 1 to 9 from Workflow:
automation.joblinfo.Joblinfo1;

To access ProcessName, OriginalFilename or Taskindex from Workflow:
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automation.properties.OriginalFilename;
To access Workflow variables (declared in the Preprocessor properties):
automation.variables.Same_as_workflow;

boundaries

Returns a boundaries object encapsulating properties and methods allowing to define the
boundaries of each document in the job.

This object is available when triggering document boundaries On script.

Properties

The following table lists the properties of the boundaries object.

Property Return Type

currentDelim | A read-only 1-based index (number) of the current delimiter in the file. In
other words, the Beginning Of File (BOF) delimiter equals 1. It indicates the
position of the current delimiter relative to the last document boundary

Methods
The following table describes the functions of the boundaries object. They are available with all
file types.
Method Description Script type
"find()" on Finds the first occurrence of a string starting | Boundaries
the next from the current position.
page Preprocessor, Extract,
Condition, Repeat, Action,
and Postprocessor steps
get() Retrieves an array of strings. Boundaries
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Method Description Script type

getVariable | Retrieves a value of a variable stored in the Boundaries

0 boundaries object.
set() Sets a new record boundary. (See: "Record | Boundaries

boundaries" on page 117.)

setVariable | Sets aboundaries variable to the Boundaries
Q specified value, automatically creating the
variable if it doesn't exist yet.

find()

Method of the boundaries object that finds a string in a region of the data source file. The
method returns a smaller region which points to the exact location where the match was found.

find(stringToFind, in Region)

Finds the string stringToFind in a rectangular region defined by inRegion.

stringToFind
String to find.

in_Region
The inRegion can be created prior to the call to find() with the region.createRegion() method.
It depends on the type of data source how a region is defined; see "Example"” on page 285.

The find () method returns a different region object whose range property is adjusted to point
to the exact physical location where the match was found. This will always be a subset of the
in Region.range property. It can be used to determine the exact location where the match
occurred.

Use boundaries.get () to retrieve the actual text from the resulting region; see "Example" on
the facing page.
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get()

The get () method reads the contents of a region object and converts it into an array of strings
(because any region may contain several lines).

How the region is defined, depends on the type of source data; see "region" on page 284 and
"Example" on page 285.

get(in Region)

in_Region
A region object. What type of object this is depends on the type of source data, howeverin

any case the region object can be created with a call to region.createRegion(); See
"Example” on page 285.

Example

This script retrieves all text from the Email_Address field in a CSV or database file.

boundaries.get (region.createRegion ("Email Address"));

getVariable()

Method that retrieves the value currently stored in a variable.

Note

Boundary variables are carried over from one iteration of the Boundaries script to the next, while
native JavaScript variables are not.

getVariable(varName)

varName

String name of the variable from which the value is to be retrieved. If the variable does not
exist, the value null is returned. It is considered good practice (almost mandatory, even) to
always check whether a variable is defined before attempting to access its value.

set()

Sets a new DataMapper record boundary.

Page 266

PlanetPress.
Connect



set(delimiters)

delimiters

Sets a new record boundary. The delimiters parameter is an offset from the current delimiter,
expressed in an integer that represents a number of delimiters.

If this parameter is not specified, then a value of 0 is assumed. A value of 0 indicates the
record boundary occurs on the current delimiter.

A negative value of -n indicates that the record boundary occurred -n delimiters before the
current delimiter.

A positive value of n indicates that the record boundary occurs +n delimiters after the current
delimiter.

Note

Specifying a positive value not only sets the DataMapper record boundary but it also advances the
current delimiter to the specified delimiter. That's where the processing resumes. This allows you to
skip some pages/records when you know they do not need to be examined. Negative (or 0) values
simply set the boundary without changing the current location.

Example

This script sets a boundary when the text TOTAL is found on the current page in a PDF file.
The number of delimiters is set to 1, so the boundary is set on the next delimiter, which is the
start of the next page.

if (boundaries.find("TOTAL", region.createRegion
(10,10,215,279)) .found) {
boundaries.set (1) ;

}

Assume you want to set record boundaries whenever the text "TOTAL" appears in a specific
region of the page of a PDF file, but the PDF file has already been padded with blank pages for
duplexing purposes. The boundary should therefore be placed at the end of the page where the
match is found if that match occurs on an even page, or at the end of the next blank page, if the
match occurs on an odd page. Recall that for PDF files, the natural delimiter is a PDF page.
The JavaScript code would look something like the following:

var myRegion = region.createRegion (150,220,200,240);

if (boundaries.find ("TOTAL", myRegion) .found) {
/* a match was found. Check if we are on a odd or even page and
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set the Boundary accordingly */
if ((boundaries.currentDelim % 2) !=0 ) {
/* Total is on odd page, let's set the document Boundary or
delimiter further, thereby skipping the next blank page */
boundaries.set (1) ;
} else {
/* Total is on an even page, set the document Boundary to

current delimiter */
boundaries.set () ;

}

}

setVariable()

This method sets a variable in the boundaries to the specified value, automatically creating the
variable if it doesn't exist yet.

Note

Boundary variables are carried over from one iteration of the Boundaries script to the next, while
native JavaScript variables are not.

setVariable(varName, varValue)

Sets variable varName to value varValue.

varName
String name of the variable of which the value is to be set.

varValue
Object; value to which the variable has to be set.

Example

This script examines a specific region and stores its contents in a variable in the boundaries.

var addressRegion = region.createRegion (10, 30, 100, 50);
var addresslLines = boundaries.get (addressRegion);
boundaries.setVariable ("previousLines",addressLines) ;
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data

Returns a data object encapsulating properties and methods pertaining to the original data
stream.

Properties
The following table lists the properties of the data object.
Property Description Return type

filename The path of the input file. Returns the fully qualified file name of
the temporary work file being processed.

properties | Contains properties declared in Returns an array of properties defined in
the preprocessor step (see the Preprocessor step with the data
Preprocessor Step Properties for | scope (j.e. statically set at the start of the
details). job).
Methods

The following table lists the methods of the data object.

Description Script type
"Examples" | Extracts the text value from a Extract, Condition, Repeat, All
on rectangular region. and Action steps
page 271
"extractMeta | Extracts the value of a metadata Extract, Condition, Repeat, All
()" on field. and Action steps
page 277
"fieldExists Method that returns true if the Boundaries All
()" on specified metadata field, column
page 277 or node exists. Preprocessor, Extract,

Condition, Repeat, Action,
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Method Description Script type

and Postprocessor steps

"Examples" | Finds the first occurrence of a Boundaries All
on string starting from the current
page 279 position. Preprocessor, Extract,

Condition, Repeat, Action,
and Postprocessor steps

"Examples" | Finds the first match for a regular Extract, Condition, Repeat, Text,
on expression pattern starting from Multiple Conditions and PDF
page 282 the current position. Action steps

extract()

Extracts the text value from selected data: a node path, column, or rectangular region,
depending on the type of data source.
This method always returns a String.

extract(left, right, vertical Offset, regionHeight, separator)

Extracts a value from a position in a text file. Coordinates are expressed as characters
(horizontally) or lines (vertically).

left

Number that represents the distance, measured in characters, from the left edge of the page to
the left edge of the rectangular region. The leftmost character is character 1.

right
Number that represents the distance, measured in characters, from the left edge of the page to

the right edge of the rectangular region.

verticalOffset
Number that represents the current vertical position, measured in lines.

regionHeight
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Number that represents the total height of the region, measured in lines.

Setting the regionHeight to 0 instructs the DataMapper to extract all lines starting from the
given position until the end of the record.

Specifying an extraction height that is longer than the number of remaining lines results in a
"step out of bound" error message.

separator
String inserted between all lines returned from the region. If you don't want anything to be
inserted between the lines, specify an empty string ("").

Tip
« "<br/>"is a very handy string to use as a separator. When the extracted data is

inserted in a Designer template, "<br/>" will be interpreted as a line break, because
<br/>is a line break in HTML and Designer templates are actually HTML files.

« Setting the regionHeight to 0 makes it possible to extract a variable number of lines
at the end of a record.

Examples

Example 1:

The script command data.extract (1,22,8,1,"<br />"); means that the left position of the
extracted information is located at character 1, the right position at character 22, the offset
position is 8 (since the line number is 9) and the regionHeightis 1 (to select only 1 line). Finally,
the "<br/>" string is used for concatenation.
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=] *Untitled [Section 1] [&7] *test-data-tat-multiple-lines (TXT) 52 =8

Text viewer Font | Courier New v| # #1852 |Zoom(%) 00 HP Le

CU19035457 ~
2013-11-21
2013-12-21

INVS683833
REFP6542753

=] E Sebastian Berry] il}g
10|5aint Laurent Leag
11|28, Birch Awvenue

1z

€

Step Properties’ 1 Messages
Extract Step @
» Description
+ Extraction Definition
Data Table: | record
Append values to current record
~ Field Definition
Field List: Field1 v @B L4

Add Unique ID to extraction field

Mode: Javascript

| data.extract(1,22,8,1,"<br />");

Expression:

Type: HTML String v

~ Data format

Mo format

Example 2:

The script command data.extract(1,22,9,6,"<br />"); means that the left position of the
extracted information is located at 1, the right position at 22, the offset position is 9 (since the
first line number is 10) and the regionHeight is 6 (6 lines are selected). Finally, the "<br/>" string
is used for concatenation.
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=] *Untitled [Section 1] [E] *test-data-bt-multiple-lines (TKT) &2 =8

Text viewer Font | Courier New v| # &5 |Zoom(%) 0 BHLe Pe

S Mr Sebastian Berryhill -
10|Saint Laurent I.angeZ

11|28, Birch Awvenue
1z
7 |faint Laurent, MB
4|Ch

5 [29375-5022

6

!

12 |Product Description UnitPrice Ordered B.0O. Shipped Total v
£ >

Step Properties| 1 Messages =0
Extract Step @
» Description
~ Extraction Definition
Data Table: | record v
Append values to current record
+ Field Definition
Field List: Field1 v| B E4
Add Unique |D to extraction field
Mode: Javascript v

| data.extract(1,22,9,6,"<br />"};

Expression:

Type: HTML String v

~ Data format

Mo format

extract(xPath)

Extracts the text value of the specified node in an XML file.
xPath

String that can be relative to the current location or absolute from the start of the record.

Example

The script command data.extract('./CUSTOMER/FirstName'); means that the extraction is
made on the FirstName node under Customer.
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=] “Untitled [Section 1] s *Name (XML} £3 =g

XML viewer & 5 [Zoomx) 100 £ 2 £ @

a4 <> PLANETPRESS DATA FILE () ~
4 <> CUSTOMER
@ FULLNAME (Percy Ludwick)
<> ID (CU53615163)
<» Gender (Mr)
<> LastMame (Ludwick)
<> Address] (822, Confluence Court)
<> Address2 (Suite 7443)
¢ City (Rockwood)
<> State (ON)
<> Country (CA)
<> ZipCode (X1R 5E4)
¢» Title (Service Representative)
¢> Company (Rackwood Engine Systems)
<» Phone2 ((5333) 380-6476, #233)
¢> Email (pludwick@oldrupa.com)
¢ Language (EN)
<» MD5 (C9B28FBAB3ITEGBAFE19C2C3EB0FDEBDE)
4 <» INVOICES ()
4 <> INVOICE ()
@ LINE_ITEMS (24)
<3 Number (INV6103023) v

Step Properties 1 Messages =8
Extract Step o r

» Description
+ Extraction Definition

Data Table: | record v

Append values to current record

~ Field Definition

Field List Firsthame +BEe

[[] Add Unique ID te extraction field

Based on: Javascript v

1 data.extract ('./CUSTOMER/FirstName'); La
Expression: o
Type: String v

+ Data format

Mo format

extract(columnName, rowOffset)

Extracts the text value from the specified column and row.

columnName
String that represents the column name.

rowOffset

Number that represents the row index (zero-based), relative to the current position. To extract
the current row, specify 0 as the rowOffset. Use moveTo () to move the pointer in the source
data file (see "Example" on page 290).

Example

The script command data.extract('lD’,0); means that the extraction is made on the ID column in
the first row.
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= | *Untitled [Section 1] T *Mame (CSV) &2 =8

Tabular viewer

D Date DueDate InvMurmber Rep Gender FirstMName
CU01522592 2012-04-1 2012-05-11 INV1011789 REP3028212 Mrs Cathleen
< >
Step Properties| 1 Messages =0
Extract Step @
» Description

~ Extraction Definition
Data Table: | record ]
Append values te current record
= Field Definition
Field List: D v B e
[[] Add Unique ID to extraction field

Mode: Javascript v
| data.extract ("ID',0): La
Expression: TF
Type: String ']
~ Data format
Mo format

extract(left, right, verticalOffset, lineHeight, separator)

Extracts the text value from a rectangular region in a PDF file. All coordinates are expressed in
millimeters.

left

Double that represents the distance from the left edge of the page to the left edge of the
rectangular region.

right
Double that represents the distance from the left edge of the page to the right edge of the

rectangular region.

verticalOffset
Double that represents the distance from the current vertical position.
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lineHeight
Double that represents the total height of the region.

separator
String inserted between all lines returned from the region. If you don't want anything to be
inserted between the lines, specify an empty string ("").

Tip

"<br/>" is a very handy string to use as a separator. When the extracted data is inserted in a
Designer template, it will be interpreted as a line break, because <br/> is a line break in HTML and
Designer templates are actually HTML files.

Example

The script command data.extract(4.572,51.815998,37.761333,3.7253342,"<br />"); means
that the left position of the extracted information is located at 4.572mm, the right position at
51.815998mm, the vertical offset is 37.761333mm and the line heightis 3.7253342mm. Finally,

the "<br/>" string is used for concatenation.
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=] *Untitled [Section 1] &1 *Mame (PDF) 2 =0
PDF viewer & 5 3 |Zoom) 100 L L @

A

iMr Romeo,Leininq@g
Locomotive Engineer, Parkhill Law Corporation
17, Victoria Court

Bldg 20
Parkhill, ON
CA
G3H 4E2 ¥
< >
Step Properties| 1 Messages =0
Extract Step @
» Description

~ Extraction Definition
Data Table: | record .
Append values to current record
~ Field Definition
Field List: Field3 v B e

Add Unigue ID to extraction field

Mode: Javascript v

| data.extract(4.572,51.815998,37.761333,3.7253342, "<br />"); L
Expression: e
Type: HTML String v

~ Data format

No format

extractMeta()

Method that extracts the value of a metadata field on a certain level in a PDF/VT. This method
always return a String.

extractMeta(levelName String, propertyName String)

levelName
String, specifying the PDF/VT's level. Case-sensitive.

propertyName
String, specifying the metadata field.

fieldExists()

Method of the data object that returns true if a certain metadata field, column or node exists.
(See "data" on page 269.)
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fieldExists(levelName, propertyName)

This method returns true if the given metadata field exists at the given level in a PDF file.

levelName
String that specifies the metadata field.

propertyName
String that specifies the level.

fieldExists(fieldName)

This method returns true if the specified column exists in the current record in a CSV file.

fieldName
String that represents a field name (column) in a CSV file.

fieldExists(xPath)

This method returns true if the specified node exists in the current record in an XML file.

xPath
String that specifies a node.

find()

Method of the data object that finds the first occurrence of a string starting from the current
position.

find(stringToFind, leftConstraint, rightConstraint)

Finds the first occurrence of a string starting from the current position. The search can be
constrained to a series of characters (in a text file) or to a vertical strip (in a PDF file) located
between the given constraints.

The method returns nul1 if the string cannot be found. Otherwise it returns a RectValueText (if
the data source is a text file) or RectValuePDF (if the data source is a PDF file) object. This
object contains the absolute Left, Top, Right and Bottom coordinates of the smallest possible
rectangle that completely encloses the first occurrence of the string. The coordinates are
expressed in a number of characters if the data source is a text file, or in millimetres if the data
source is a PDF file.
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Partial matches are not allowed. The entire string must be found between the two constraint
parameters.

The data.find () function only works on the current page. If the record contains several pages,
you must create a loop that will perform a jump from one page to anotherto do a find () on
each page.

Note

Calling this method does not move the current position to the location where the string
was found. This allows you to use the method as a look-ahead function without disrupting
the rest of the data mapping workflow.

stringToFind
String to find.

leftConstraint

Number indicating the left limit from which the search is performed. This is expressed in
characters for a text file, or in millimetres for a PDF file.

rightConstraint
Number indicating the right limit to which the search is performed. This is expressed in

characters for a text file, or in millimetres for a PDF file.

Examples

To look for the word "text" on an entire Letter page (8 1/2 x 11 inch), the syntax is:

data.find("text", 0, 216);

The numbers 0 and 216 are in millimeters and indicate the left and right limits (constraints)
within which the search should be performed. In this example, these values represent the entire
width of a page. Note that the smaller the area is, the faster the search is. So if you know that
the word "text" is within 3 inches from the left edge of the page, provide the following:

data.find ("text", 0, 76.2); //76.2mm = 3*25.4 mm

The return value of the function is:
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Left=26,76, Top=149.77, Right=40,700001, Bottom=154.840302

These values represent the size of the rectangle that encloses the string in full, in millimeters
relative to the upper left corner of the current page.

findRegExp()

Finds the first occurrence of a string that matches the given regular expression pattern, starting
from the current position.

findRegExp (regexpToFind, flags, leftConstraint, rightConstraint): rectValueText)

Finds the first match for a given regular expression pattern starting from the current position.
Regular expression flags (i,s,L,m,u,U,d) are specified in the flags parameter. The search can
be constrained to a vertical column of characters located between the left and right constraint,
each expressed in characters (in a text file) or millimeters (in a PDF file).

Partial matches are not allowed. The entire match for the regular expression pattern must be
found between the two constraints.

The method returns nu11 if the regular expression produces no match. Otherwise it returns a
RectValueText object, containing the Left, Top, Right and Bottom coordinates - expressed in
characters (in a text file) or millimeters (in a PDF file), relative to the upper left corner of the
current page - of the smallest possible rectangle that completely encloses the first match for the
regular expression.

Note

Calling this method does not move the current position to the location where the match occurred.
This allows you to use the method as a look-ahead function without disrupting the rest of the data
mapping workflow.

regexpToFind
Regular expression pattern to find.
flags

i. Enables case-insensitive matching. By default, case-insensitive matching assumes that
only characters in the US-ASCII charset are being matched. Unicode-aware case-insensitive
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matching can be enabled by specifying the UNICODE_CASE flag (u) in conjunction with this
flag.

s: Enables dotall mode. In dotall mode, the expression . matches any character, including a
line terminator. By default this expression does not match line terminators.

L: Enables literal parsing of the pattern. When this flag is specified, then the input string that
specifies the pattern is treated as a sequence of literal characters. Metacharacters or escape
sequences in the input sequence will be given no special meaning. The CASE
INSENSITIVE (i) and UNICODE _CASE (u)flags retain their impact on matching when used
in conjunction with this flag. The other flags become superfluous.

m. Enables multiline mode. In multiline mode, the expressions * and $ match just after or just
before, respectively, a line terminator or the end of the input sequence. By default, these
expressions only match at the beginning and the end of the entire input sequence.

u: Enables Unicode-aware case folding. When this flag is specified, then case-insensitive
matching, when enabled by the CASE_INSENSITIVE flag (i), is done in a manner consistent
with the Unicode Standard. By default, case-insensitive matching assumes that only
characters in the US-ASCII charset are being matched.

U: Enables the Unicode version of Predefined character classes and POSIX character
classes. When this flag is specified, then the (US-ASCII only) Predefined character classes
and POSIX character classes are in conformance with Unicode Technical Standard #18:
Unicode Regular Expression Annex C: Compatibility Properties.

d: Enables Unix lines mode. In this mode, only the "\n'line terminator is recognized in the
behaviorof ., », and $.

leftConstraint

Number indicating the left limit from which the search is performed. This is expressed in
characters for a text file, or in millimeters for a PDF file.

rightConstraint

Number indicating the right limit to which the search is performed. This is expressed in
characters for a text file, or in millimeters for a PDF file.
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Examples
data.findRegExp (/\d{3}-[A-Z]{3}/,"gi",50,100);

or

data.findRegExp ("\\d{3}-[A-Z]{3}","gi",50,100);}}

Both expressions would match the following strings: 001-ABC, 678-xYz.

Note how in the second version, where the regular expression is specified as a string, some
characters have to be escaped with an additional backslash, which is standard in JavaScript.

db

Object that allows to connect to a database.

Methods

The following table describes the methods of the db object.

Method Description Available in

connect | Method that returns a new Boundaries all
Q database connection object.
Preprocessor, Extract, Condition,
Repeat, Action, and Postprocessor
steps

connect()

Method that returns a new database connection object.

connect(url, user, password)

This method returns a new database connection object after connecting to the given URL and
authenticating the connection with the provided user and password information.

url
String that represents the url to connect to.
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user
String that represents the user name for authentication.

password
String that represents the password for authentication.

logger

Global object that allows logging messages such as error, warning or informational messages.

Methods

The following table describes the methods of the logger object.

Method Parameters Description

error() message: string Logs an error message

info() message: string Logs an informational message

warn() message: string Logs a warning message
record

The current record in the main data set.

Properties
Property Return Type
fields The field values that belong to this record. You can access a specific field
value using either a numeric index or the field name,
index The one-based index of this record, or zero if no data is available.
tables The details table that belong to this record. You can access a specific table
using a numeric index or the table name.
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Example

See this How-to for an example of how the current record index, and/or the total number of
records in the record set, can be displayed in a document: How to get the record index and
count.

region
The region object defines a sub-section of the input data. Its properties vary according to the

type of data.

This object is available when triggering document boundaries On script; see "Setting
boundaries using JavaScript" on page 257.

Methods

The following table describes the methods of the region object. This object is available in
Boundaries scripts, with all file types.

Method Description Return Type

found Field that contains a boolean value Boolean
indicating if the last call to
boundaries.find () was successful.
Since the find () method always
returns a region, regardless of search
results, it is necessary to examine the
value of found to determine the actual
result of the operation.

range Read-only object containing the Physical location of the region:
physical coordinates of the region. x1 (left), y1 (top), x2 (right), y2
(bottom), expressed in
characters for a text file or in
millimeters for a PDF file.

Fora CSV file, itis the name of
the column that defines the
region.

createRegion | Creates a region by setting the A region that has the specified
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Method Description Return Type

0] physical coordinates of the region coordinates.
object.

createRegion()

This method sets the physical coordinates of the region object. The region is available when
setting document boundaries using a script (see "region" on the previous page).

PDF and Text: createRegion(x1, y1, x2, y2)

Creates a region from the data, using the specified left (x1), top (y1), right (x2) and bottom (y2)
parameters, expressed in characters for a text file or in millimeters for a PDF file.

x1
Double that represents the left edge of the region.

y1
Double that represents the top edge of the region.

x2
Double that represents the right edge of the region.

y2
Double that represents the bottom edge of the region.

Example

The following script attempts to match ((n,m)) or ((n)) against any of the strings in the
specified region and if it does, a document boundary is set.

var myRegion = region.createRegion(170,25,210,35);
var regionStrings=boundaries.get (myRegion) ;
if (regionStrings) {
for (var 1i=0;i<regionStrings.length; i++) {
if (regionStrings[i].match(/ (\({2}n,*m*\){2})/gi)) {
boundaries.set () ;
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}

(The match() function expects a regular expression; see w3schools.)

CSV or database: createRegion(columnName)

Creates a region from the data in a CSV file, using the specified columnName parameter.

columnName
String containing the name of the column where the region is to be created.

Example

This script checks the first value in a certain column. If it is not the same value as in the
previous record(s), a document boundary is set.

if (! (boundaries.Eof || boundaries.Bof)) {
var recordValue = boundaries.get (region.createRegion ('ID')) [0];
if (! (recordValue==boundaries.getVariable('lastValue'))) {

boundaries.setVariable ('lastValue', recordValue) ;
boundaries.set (0) ;

}

sourceRecord
Returns a sourceRecord object containing properties specific to the current source record

being processed.

Properties

sourceRecord.properties.property;

Return Type

properties Returns an array of properties defined in the Preprocessor step with
the Record Scope (i.e. dynamically reset with each new record).
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Example

The property, used by the object Source Record, must first be declared in a Preprocessor
step:

Step Properties| 1 Messages =0
Preprocessor @

» Description

» Fixed automation properties

+ Properties

Name Scope Type Default Value
Propertyl Each record ¥ String
Entire data
Autemation variable
~ Preprocessor
MName Type Q

1. Enter the property Name.
2. Select Each record from the Scope drop-down list.

3. Select a Type for the Property.

steps

Returns a steps object encapsulating properties and methods pertaining to the current
DataMapper process.

This object is available in an Extract, Condition, Repeat or Multiple Conditions step script.
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Methods and properties

The following table lists the methods and properties of the steps object. These are available in
Extract, Condition, Repeat, and Action steps, depending on the file type.

Method Description

currentPosition Returns the current position of the pointer in the data. All
Depending on the type of data being processed, the return
value may be a string (e.g. XPath value in XML), an integer
(e.g. line numbers in text ot tabular data), or a measure in
millimeters(e.g. PDF data).

currentLoopCounter | An integer value representing the current iteration of the All
containing loop. When loops are nested, you have access to
the iteration for the current loop but not to any of the parent

loops.
currentPage Returns an integer value representing the current page Text,
where the current position is located, inside the current PDF
record.
currentPageHeight The height of the current page in millimeters. PDF
currentPageWidth The width of the current page in millimeters. PDF
moveTo() Moves the pointer in the source data file to another position. | All
moveToNext() Moves the position of the pointer in the source data file to All

the next line, row or node. The behavior and arguments are
different for each emulation type: text, PDF, tabular (CSV),
or XML.

totalPages An integer value representing the total number of pages Text,
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Method Description

inside the current record. PDF
Example
if(steps.currentPage > curPage) {
steps.moveTo (0, steps.currentPosition+14); /* Moves the current

position to 14 lines below the current position of the pointer in
the data */

curPage++;
} else if(curline.startsWith ("LOAD FACTOR")) { /* Extracts data to
the curlLine variable until the string "LOAD FACTOR" is encountered
*/

break;
} else {

lineArray.push (curLine); /* Adds the current line value
(extraction) to the array */

}

moveTo()

Moves the position of the pointer in the source data file. This is a method of the steps object
(see "steps" on page 287).

moveTo(scope, verticalPosition)

Moves the current position in a text file to verticalpPosition where the meaning of
verticalPosition changes according to the value specified for scope.

scope
Number that may be set to:

e 0 oOr steps.MOVELINES
e 1 0r steps.MOVEDELIMITERS

e 2:nextline with content

verticalPosition
Number. What it represents depends on the value specified for scope.
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With the scope set to 0 or steps.MOVELINES, verticalPosition represents the index of the line
to move to from the top of the record.

With the scope setto 1 or steps.MOVEDELIMITERS, verticalPosition represents the index of
the delimiter (as defined in the Input Data settings) to move to from the top of the record.

With the scope setto 2, verticalPosition is not used. The position is moved to the nextline
after the current position that contains any text.

Example

The following line of code moves the current position in a text file 14 lines down from the
current vertical position (steps.currentPosition) of the pointerin the data, as long as itis on
the same page.

if (steps.currentPage > curPage) {
steps.moveTo (0, steps.currentPosition+14);
curPage++;

}

moveTo(scope, vertical Offset)

Moves the current position in a PDF file to verticaloffset where the meaning of
verticalOffset changes according to the value specified for scope.

scope
Number that may be set to:

e OoOrsteps.MOVEMEASURE
e 1orsteps.MOVEPAGE

verticalOffset
Double. What it represents depends on the value specified for scope.

With the scope setto 0 or steps.MOVEMEASURE, verticalOffset represents the number of

millimeters to move the current position, relative to the top of the record (NOT the top of the
current page).
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With the scope setto 1 or steps.MOVEPAGES, verticalOffsetrepresents the index of the target
page, relative to the top of the record.

moveTo(xPath)

Moves the current position in a XML file to the first instance of the given node, relative to the top
of the record.

xPath
String that defines a node in the XML file.

Tip
The XML elements drop-down (on the Settings pane, under Input Data) lists xPaths defining
nodes in the current XML file.

moveTo(row)

Moves the current position in a CSV file to the given row number.

row
Number that represents the index of the row, relative to the top of the record.

moveToNext()

Moves the position of the pointer in the source data file to the next line, row or node. The
behavior and arguments are different for each emulation type: text, PDF, tabular (CSV), or XML.

This is a method of the steps object (see "steps" on page 287).

moveToNext(scope)

Moves the current position in a text file or XML file to the next instance of scope. What scope
represents depends on the emulation type: text or XML.

Text

scope
Number that may be set to:
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e Oorsteps.MOVELINES: the current position is set to the next line.

e« 10rsteps.MOVEDELIMITERS: the current position is set to the next delimiter (as
defined in the Input Data settings).

« 2 (nextline with content): the current position is set to the next line that contains any text.

Example

The following line of code moves the current position to the next line that contains any text.

steps.moveToNext (2) ;

XML

scope
Number that may be set to:

e« Oorsteps.MOVENODE: the current position is set to the next parent node in the XML
hierarchy.

e 10rsteps.MOVESIBLING: the current position is set to the next sibling node in the
XML hierarchy.

moveToNext(left, right)

Moves the current position in a PDF file to the next line that contains any text, the search for text
being contained within the left and right parameters, expressed in millimeters.

left
Double that represents the left edge (in millimeters) of the text to find.

right
Double that represents the right edge (in millimeters) of the text to find.

moveToNext()

Moves the current position in a CSV file to the next row, relative to the current position.

Functions

copyfFile()
Function that copies a file to the target file path, replacing itif it already exists.
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copyFile(source, target)

source
String that specifies the source file path and name.

target
String that specifies the target file path and name.

Example

This script copies the file test.txt from c:\Content into the c:\out folder.

copyFile ("c:\Content\test.txt","c:\out\")
createTmpFile()

Function that creates a file with a unique name in the temporary work folder and returns a file
object. This file stores data temporarily in memory or in a buffer. It is used to prevent multiple
input/output access to a physical file when writing. In the end, the contents are transferred to a
physical file for which only a single input/output access will occur.

Example

In the following script, the contents of the data sample file are copied in uppercase to a
temporary file.

try{
// Open a reader
var reader = openTextReader (data.filename);
// Create a temporary file
var tmpFile = createTmpFile ()
// Open a writer on the temporary file
var writer = openTextWriter (tmpFile.getPath())
try{
var line = null; // Current line

/* read line by line and readLine will return null at the «
the file */

while( (line = reader.readLine()) != null ) {
// Edit the line
line = line.toUpperCase()

// Write the result in the temporary file
writer.write (line) ;
// add a new line
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writer.newlLine () ;

}

finally{
// Close the writer of the temporary file
writer.close () ;

}

finally{
// Close the reader
reader.close () ;

}

deleteFile(data.filename) ;
tmpFile.move (data.filename);

createHTTPRequest()

Function that creates a new ScriptableHTTPRequest object, in order to issue REST/AJAX calls
to external servers.

This feature allows the data mapping process to complement its extraction process with
external data, including data that could be provided by an HTTP process in Workflow, for
instance a process that retrieves certain values from Workflow’s Data Repository. Another
possible use is to have a Postprocessor that writes the results of the extraction process to a file
and immediately uploads that file to a Workflow process.

The returned ScriptableHTTPRequest has a selection of the properties and methods of the
standard JavaScript XMLHTTPRequest object (see htips://developer.mozilla.org/en-
US/docs/Web/API/XMLHttpRequest). Supported properties and methods are listed below.

Note

It is not possible to use the async mode, which can be set via the open () function of the
ScriptableHTTPR